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Introduction

The mTropolis Developer Guide is your best starting
point for learning how to use the mTropolis™
authoring system. The Developer Guide provides
detailed coverage of mTropolis concepts, tutorials,
and examples — everything you'll need to build a
foundation of knowledge to apply mTropolis

quickly and effectively.

This Introduction provides information on
installing and starting mTropolis, followed by a
“roadmap” of resources that you can use to learn
more about mTropolis in ways that suit your indi-
vidual learning style. If you're new to mTropolis,
please read this section thoroughly before proceed-
ing. The time you spend here learning what resources
are available could greatly accelerate and streamline

your mTropolis learning experience.



Welcome!

Welcome to mTropolis. mTropolis is a visual,
object-oriented authoring system for creating
networked, interactive, multimedia applica-
tions. Designed for the demanding require-
ments of consumer CD-ROM developers,
mTropolis is now available for mainstream
multimedia authoring. mTropolis combines a
rich set of features and effects, a time-saving
visual interface, and a behavior-oriented pro-
gramming system to enable rapid development
of high-performance multimedia projects.
Whether you're creating presentations, inter-
active product brochures, entertainment or
educational CD-ROMs, computer-based train-
ing, or some other category of new media
application, mTropolis will accelerate your
development process and ease collaboration
with other development team members. Pro-
jects created in mTropolis may be distributed
on CD-ROM, DVD, or the Internet, and will
run on Microsoft Windows, Mac OS, Netscape
Navigator, and Internet Explorer platforms.

Installing mTropolis

To install the mTropolis authoring environ-
ment, player, and supporting components on
your Macintosh system, mount the mTropolis
CD-ROM and follow the instructions in the
"Read Me First!" file at the top level of the disc.

To install the mTropolis player, mPire™ plug-

in, and other components on your Windows
system, mount the mTropolis CD-ROM and

follow the instructions in the "README.WRI"
file at the top level of the disc.

Please read the "Release Notes 2.0" file installed
with mTropolis for late-breaking information
about this release.

Learning mTropolis m

Starting mTropolis

To start mTropolis, double-click the mTropolis
icon. The first time mTropolis is launched,
you will be asked for your name, organiza-
tion, and registration number. Please enter
this information to personalize and enable
your copy of mTropolis.

At regular intervals, mTropolis will check to
see if another copy of the software with the
same registration number is running else-
where on the network. If another copy with
the same registration number is detected, an
alert will appear and mTropolis will quit. To
avoid this inconvenience, please ensure that
your copy of mTropolis is installed and run
on only one machine at any time, as specified
in your mTropolis End User License Agreement.

The default installation of mTropolis includes
the mTropolis Info interactive title, which
will appear every time you start mTropolis.
To disable mTropolis Info, simply remove
this file from the Startup subfolder of your
mPlugins folder.

Learning mTropolis

Since we all learn in different ways, and since
different types of information are best pre-
sented in different forms, mTropolis includes
instructional and reference information in a
variety of formats:

Print Documentation

If you learn best by reading, refer to the fol-
lowing components of mTropolis documenta-
tion. These four manuals are provided on-line
in PDF format for viewing with the Adobe
Acrobat Reader:

mTropolis Developer Guide_§ X



W Introduction

e The mTropolis Developer Guide (this manual)
covers both general object-oriented and
mTropolis-specific concepts — including the
mTropolis interface, elements, modifiers,
behaviors, and messaging. The Developer Guide
also provides step-by-step instructions for the
hands-on tutorials, and brief coverage of some
of the source examples mentioned below.

e The mTropolis Reference Guide provides
detailed coverage of the mTropolis author-
ing environment — including all menu
items, windows, palettes, and other tools —
as well as full documentation of all features
available for use in your authored projects.

® The mTropolis Quick Reference summarizes all
of the features — modifiers, system messages
and commands, object attributes, Miniscript
syntax, and Miniscript functions — available
for use in your authored projects. The Quick
Reference also summarizes all of the mouse/
keyboard shortcuts in mTropolis (except for
menu shortcuts, which simply appear in the
mTropolis menus).

e The mFactory Object Model (MOM) Reference
Guide is the starting point for C program-
mers who wish to extend mTropolis by
creating new modifiers, tools, or services
using the MOM SDK. The MOM SDK is not
installed by default; you must choose it via
a Custom Install or copy the SDK files from
the “Goodies” folder, in the “mTropolis v2.0”
folder on the CD-ROM.

Interactive Documentation

If traditional documentation is too dry for
you, turn to the following resources to view
and manipulate a wide range of interactive,
multimedia examples:

*The “Authoring Demonstrations” section
of the Learning mTropolis project presents

X ;_mTropolis Developer Guide

screen-captured, narrated videos of the
mTropolis authoring environment in action.

* The “Modifier Examples” section of the Learn-
ing mTropolis project provides one or more
interactive examples, including explanatory
text, for each of the mTropolis modifiers.

e The “Multimedia Basics” section of the
Learning mTropolis project contains a range
of interactive examples showing common
authoring tasks — navigation, cursor control,
string manipulation, etc.

¢ The “Authoring Examples” section of the
Learning mTropolis project demonstrates sev-
eral finished, real-world examples — ranging
from an interactive product catalog to an
electric-motor assembly simulation — of
mTropolis in action.

e The mPack Guide title, accessible from the
“Tools” menu if mPacks tools have been
installed, provides interactive documenta-
tion and examples for all of the compo-
nents contained in the standard mTropolis
v2.0 mPack libraries.

For more information on mPacks tools, refer
to Chapter 9. For more information on the
Learning mTropolis project, refer to Chapter
10. Note that the Learning mTropolis project
is not installed by default; you must choose
it via a Custom Install or copy it from the
“Documentation & Examples” folder, in the
“mTropolis v2.0” folder on the CD-ROM.

Hands-On Tutorials

If you learn best by rolling up your sleeves
and creating something from the ground up,
refer to the following hands-on tutorials:

e The QuickStart Tutorial (see Chapter 6) will
rapidly acquaint you with the basics of
working in mTropolis.



¢ The In-Depth Tutorial (see Chapter 7) provides
more extensive coverage of all of the key
concepts of mTropolis authoring.

e The Network Chat Tutorial (see Chapter 8)
assumes familiarity with basic mTropolis
authoring concepts and focuses on the
new network messaging capabilities of
mTropolis v2.0.

Source Examples

mTropolis v2.0 includes a large array of author-
ing examples provided in source form. If you
learn best by dissecting and studying working
examples, refer to the following resources:

e The Learning mTropolis project (see Chapter
10) is provided in source form, so you may
explore and deconstruct any of the author-
ing behind the Modifier Examples, Multi-
media Basics, or Authoring Examples.

e The mPacks (see Chapter 9) are intended for
easy re-use in your projects, but also serve
as excellent source examples of reusable
authored components.

*The “Wizard Authoring Example” (see Chap-
ter 11) is a great resource for learning how
to author mTropolis wizards—projects that
automate the creation of other projects.

*The “mServer Console” and “mChat” pro-
jects, provided in the “mPire Net Messag-
ing” subfolder of your “Goodies” folder, are
advanced examples of how to build multi-
user, networked applications in mTropolis
using network messaging.

e The MOM SDK contains a wide range of
C-code source examples for various types
of custom modifiers.

Learning mTropolis m
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mTropolis Interface

This chapter provides an overview of the mTropolis

authoring system’s graphical interface.



Layout Window

When you launch mTropolis, a Layout
window appears containing scroll bars and
pop-up menus for quick navigation around

a work in progress. This window represents
an untitled project. A project is the concep-
tual framework in which your work on a
multimedia title takes place. You can work
on multiple projects simultaneously. Each
project has its own Layout window like the
one described above.

mTropolis Interface M

Object Manipulation

Every action in mTropolis, except very spe-
cialized, global operations (such as creating

a stand-alone title version of your project),
can be accomplished with direct manipula-
tion of objects. For example, the internal
operations of mTropolis objects can be con-
figured by double-clicking them. Portions of
a mTropolis project can be rearranged or even
moved to a different project by dragging and
dropping. The menus in mTropolis provide
access to specialized operations such as
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The Layout window with Tool and Modifier palettes
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B mTropolis Interface

opening files or linking media assets, as well
as many of the operations that are also avail-
able through direct manipulation.

mTropolis has been designed with careful
attention to end user interface consistency. If
an object on the screen can be clicked, it can
be dragged and dropped somewhere meaning-
ful and will provide helpful feedback about its
role in its new home. Any object on the screen
can be double-clicked, and it will, at the very
least, display a dialog box that conveys useful
information about its internal workings. Gen-
erally, this dialog box can be used to reconfig-
ure or customize an object as well.

This consistency means that you can experi-
ment with mTropolis, incrementally applying
the knowledge you gain to new tasks. You
can concentrate on learning techniques, not
interface details, and the resulting short learn-
ing curve puts more power into your hands
more quickly.

Tool and Modifier Palettes

mTropolis provides a variety of palettes to keep
development resources readily at hand. The
modifier palettes included with mTropolis
provide modifier objects that you can drag and
drop in the process of building a title. When a
modifier is dropped on an element, the ele-
ment inherits the properties of the modifier.

14 é_mTropolis Developer Guide
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Modifiers can be dragged and dropped onto elements

The Tool palette offers the tools most fre-
quently used in building and manipulating
the constituent pieces of a mTropolis title.

It includes a Selection tool, a Graphic tool, a
Text tool, a Crop tool, and a Parent/child tool.

Other palettes provide similar productivity in
managing more sophisticated aspects of the
mTropolis development process. For example,
the Asset palette provides a view of all of the
media assets used throughout your project.
Even if a media asset has already been used in
your project, it can simply be dragged off the
Asset palette to be used again in whatever sec-
tion of the project you are working on. Also,
the Asset palette is automatically updated
whenever you link new media to your project.

More information on the various mTropolis
palettes can be found in Chapter 11 of the
mTropolis Reference Guide, “Palettes.”



mTropolis Editing Views

mTropolis offers three primary views of your
work, each of which allows you to edit and
manage your project in different ways.

The layout view allows you to directly manipu-
late the graphical aspects of your title in WYSI-
WYG fashion — arranging objects, altering their
appearance, and doing basic programming by
dragging and dropping modifiers. The layout
view is described in detail in Chapter 9 of the
mTropolis Reference Guide, “Layout Window.”

Structure View

The structure view presents an expandable/
collapsible outline that shows the hierarchy
of components within your project. This view
shows which objects are contained within
others and allows you to rearrange the hierar-
chy by dragging and dropping. The structure
view is described in detail in Chapter 8 of the
mTropolis Reference Guide, “Structure Window.”
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Layers View

The layers view shows all of the graphical
pieces of your project in their spatial order —
what is behind or in front of what else — and
allows you to rapidly rearrange this order by
dragging and dropping. The layers view is a
simple matrix, with each row representing a
successive layer in the drawing order for a
single subsection of the project. The first
column represents the shared scene and the
elements it contains. Each additional column
represents an individual scene and the ele-
ments that it contains. The layers view is
described in detail in Chapter 10 of the
mTropolis Reference Guide, “Layers Window.”
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B mTropolis Interface

Libraries

Libraries offer the powerful ability to manage
large projects, enabling collaboration and
promoting reuse of project work. mTropolis
libraries can contain any mixture of objects,
including media assets, modifiers, or entire
structures in which objects and media are
embedded. Multiple libraries can be open
while you are working on a project, and you
can freely drag and drop objects to and from
libraries. Libraries are described in detail in
the “New, Open, and Save for mTropolis
Libraries” section of Chapter 1 of the mTropolis
Reference Guide. A suite of useful libraries,
called “mPacks,” that contain useful bits of
mTropolis programming have been included
with mTropolis.

Eoom Library :i

il
Fadio.mToon -

wWhizzy Bear.mToon

Eg Bottle pict

Food/Drink Behavior

"f:.'l “Wwhizzy Behavior

"'E.'I Fick FMe Up!

@] 4]

A mirapolis Library
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Debugging Support

mTropolis offers thorough debugging support.
The primary mTropolis debugging utility

is called the Message Log window. Because
mTropolis is an object-oriented system, the
flow of a mTropolis project is determined by
messages exchanged in conversation between
objects. The Message Log provides a complete,
contextual history of every message, includ-
ing those that are end user-generated, that
was exchanged between specified objects.
The Message Log is described in detail in the
“Message Log Window” section of Chapter 7
of the mTropolis Reference Guide.
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Object-Oriented
Design

The mTropolis development environment is object-
oriented. That is, you use mTropolis to create a multi-
media title out of a set of cooperating software objects.
Using objects to create a title is like building a race

™

car from Lego™ blocks; you can build something very
sophisticated from simple parts that snap together in
a clear and understandable fashion, without labori-
ously scripting every potential action, step by step,

or using a complicated programming language.

mTropolis does not impose any particular develop-
ment metaphor on its users. Artists and programmers
can create, manipulate, and evolve any combination
of media and logic without being constrained by a
specific, linear paradigm such as creating frames of a
movie. This freedom permits groups of artists and
programmers to collaborate without procedural bot-
tlenecks. Once the title is developed, its constituent
objects can interact under the control of any combina-
tion of time, internal decisions, or external, end user-
generated events. This characteristic of mTropolis
titles allows them to more closely model the real
world, with many events of different types driving

the experience in truly novel directions.



Objects and Messaging: a Definition

The mTropolis design approach requires
some background information because it’s
an entirely new way of working with the
content of a multimedia project.

Software objects

Software objects are a way of structuring
computer software to work more like the
real world. In the real world, a hammer and
a clock are objects. Most everyone knows
how to use them, and almost no one mis-
takes them for each other. Software objects
are the software counterparts of real-world
objects. They model the real-world objects
and the interactions between those objects
inside the computer.

In the real world, it is clear what you can do
with a hammer. For example, you can pick it
up or swing it. It is also clear what you can
use a hammer to do. For example, you can
use it to drive a nail into a wall. What you
can do to or with a real-world object could
be called its capabilities. A hammer is capable
of being swung, and it is capable of driving a
nail into a wall.

Real-world objects also have attributes.
Attributes are intrinsic features of a real-world
object, like its height, weight, or color. An
interesting example is a clock, which could
be described as having the attribute of time.

A software object models a real-world object by
duplicating as many of the real-world object’s
capabilities and attributes as appropriate. For
example, a software object modeling a clock
might present an image of a clock (with color,

Object-Oriented Design M

height, and weight attributes), as well as have
code to keep the time (a clock’s time attribute).

An important point about software objects is
that they can represent capabilities or attrib-
utes that are abstracted from a complete real-
world object. For example, a software object
might keep track of time, but not have the
other visual attributes of a clock. Such an
object would be a timer software object. By
combining objects that implement abstrac-
tions with objects that model more tangible
attributes, you can create very sophisticated
real-world (and more importantly, unreal
but still coherent) models. For example, you
could combine many timer software objects
with other, more visual objects to create a
multi-faced clock object. Now, consider that
you could add an object with the abstract
capability of movement to create a flying,
multi-faced clock.

In the real world, objects interact directly.
You grab a hammer, or glance at a clock. In
the virtual world modeled by the computer,
software objects interact through messages.
Messages are the mechanism by which soft-
ware objects make use of one another’s capa-
bilities or discover the state of one another’s
attributes. For example, a software object
representing a person would send a message
to a hammer software object in order to pick
it up. A timer object will divulge the state of
its time property when it receives a message
telling it to do so. A message sent between two
objects is like a very fast, structured e-mail
message: it contains information about the
sender, the receiver, and what the receiver is
supposed to do.
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B Object-Oriented Design

Although software objects have the same ben-
efits of simplicity and easy interconnection as
do Lego blocks, they have other advantages.
Because they are simply pieces of software
stored in a computer’s memory, they can be
arbitrarily created, destroyed, duplicated,
renamed, reconfigured, or otherwise altered.

Design Example: Objects versus Procedures
An analogy may help to make the design
issue more apparent. Imagine a program
designer who wants to model the activities
of taxi cabs in a city. Using a procedural pro-
gramming tool that requires scripting, the
designer creates a map of the city and then
must define, in advance, all the possible paths
that the taxis will be allowed to follow as well
as all the conditions under which the taxi
stops, starts, breaks down, runs a red light,
runs out of gas, takes on passengers, and so
on. Without programming that challenges
even the most seasoned professional, it is not
possible for the taxis to behave in truly novel,
interactive ways.

Using a procedural model, the more dynamic
the simulation, the more difficult and time-
consuming the program coding becomes.
Programs that use the procedural (scripting)
method act like a taxi dispatcher who has to
tell all the cabs exactly where to go, when to
stop for gas and what to do as the simulation
unfolds. To illustrate, if there is a request for
a cab from a hotel in the city, the dispatcher
has to query all the cabs to see if there is one
that is available, then must calculate which
available cab is the nearest to the hotel. If the
cab is just about to run out of gas, it must be
flagged as unavailable.

24 ;_mTropolis Developer Guide

In object-oriented programming languages,
the designer lays out the city and creates taxi
objects. The taxi objects are embedded with
the instructions about where to go and what
to do. They have their passenger status, loca-
tion, and gas gauges built into them. In this
model, if a passenger calls for a taxi, the taxis
with full tanks and no passengers listen for
the message, then measure their distance
from the hotel, the taxi closest to the hotel
picks up the fare.

Although it is certainly possible to model the
complex interactions of natural processes in
procedural languages, the more complex the
interactions in the program, the more complex
and inflexible the structure of the program
becomes. Given that complex interactions are
the heart of truly compelling new media titles,
procedural languages are merely roadblocks
to your productivity. The bottom line is that
in object-oriented models, objects take care
of themselves, leading to greater realism..

There are other significant productivity
advantages to object-oriented approaches.

Design Changes

Although the message-passing that occurs in
object-oriented programs can be complex,
object-oriented design is much more flexible
and responsive to design changes.

For example, if a design change is introduced
to the taxi simulation, it has a much greater
impact on a procedurally constructed program
than an object-oriented one. If a decision is
made to set the city in the 18th century rather
than the 20th century, the simulation devel-
oped with an object-oriented tool would not



have to be radically changed. The image prop-
erty of the taxi could be changed to a horse.
Tweak the gas gauge to be a hay gauge, set a
different value for horsepower (literally!) and
cars are replaced by horses.

Reusability

The ability to take existing intellectual or
creative effort and arbitrarily reapply it to
some new need is a major productivity bene-
fit of object-oriented systems.

For example, if the designer of the taxi
simulation decides to include trucks in the
simulation, the behavior of the taxi can
be duplicated, slightly altered to suit that
of a truck, and added to the simulation.

Inheritance

The rapid creation of sophisticated entities
from simple constituent objects is another
substantial productivity benefit of object-
oriented systems. Complex real-world systems
can be modeled much more easily than with
other approachs.

When discussing this concept previously, the
analogy of snapping together simple Lego
blocks into a more sophisticated entity (such
as a race car) was employed. The race car
inherits the capability of the motor block to
spin a drive-shaft, and it inherits the strength
properties of each block. Similarly, a clock
object in an object-oriented world can inherit
its time-keeping capability from an abstract
timer object. One of the major benefits of
inheritance is that if the inherited object
changes, its heirs acquire that object’s capa-
bilities or properties. For example, if the
abstract timer object is changed to have

Object-Oriented Design M

millisecond precision, the clock object now
can keep time to the nearest millisecond.

Encapsulation

Advanced object-oriented systems such as
mTropolis provide more transparent reusabil-
ity than that described above. This trans-
parency is derived from objects that act as
totally autonomous components, truly like
Lego blocks. Standard object-oriented systems
(such as C++) do not provide such “plug and
play” objects; some knowledge of their inner
workings is always required to use them.

Autonomous components depend on a fea-
ture of object-oriented systems called encap-
sulation. Objects publish what capabilities
they will employ on behalf of other objects,
receive messages invoking those capabilities,
and send back the results. Thus, they need
not ever have knowledge of each others’ inter-
nal specifics. Those internals — both the data
that an object operates upon and the code
that does the operations — can be encapsu-
lated, or hidden away. Encapsulation elimi-
nates dependencies between objects that
would prevent rapid enhancement of indi-
vidual objects, and allows objects to act as
truly independent components.

Components can be reused in any context,
without the user having to understand any-
thing about their internals. For example, a
crow component used on the bleak Scottish
heath of a murder mystery title can be placed
in a children’s title. It will still caw and flap
about its confines without any modification,
tweaking, or other effort on the part of the user.
Thus, artists can use extremely powerful com-
ponents without any programming knowledge.
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Extending the mTropolis environment

There is one important distinction between
mTropolis and lower-level development envi-
ronments such as C++. In mTropolis, the
author combines and connects components
in conversation, to create sophisticated enti-
ties that themselves are building blocks for
titles. However, mTropolis does not allow the
direct modification of component internals at
the author level as do C++ or SmallTalk.

The good news is that mTropolis provides a
comprehensive set of programming interfaces
(APIs) called the mFactory Object Model
(MOM). MOM allows programmers to extend
mTropolis with new components, or to mod-
ify or over-ride existing components. (See the
online documentation for MOM for additional
information.)

In addition, special mTropolis projects, called
tools, can be created using mTropolis. Tools
are projects that run in the mTropolis editing
environment and examine or manipulate
other projects. Tools are an easy way to
extend the capabilities of mTropolis. A num-
ber of tools, including the Object Watcher
and Memory Watcher, are automatically
installed with mTropolis. These tools can be
accessed from the Tools menu. For more
information on tools see Chapter 6, “Tools
Menu”, in the mTropolis Reference Guide and
Chapter 11, “Wizard Authoring Example”, in
the manual.
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In this chapter, the mTropolis implementation of
object-oriented design philosophy is presented,
along with other basic information required to

understand mTropolis.



Overview: mTropolis Objects at Work

Working with software objects to create sophis-
ticated, dynamic, interactive models of real or
imaginary environments is theoretically very
easy. There are only two required tasks:

e Create and combine visual and abstract
software objects.

e Control the interaction of the objects with
simple messages.

mTropolis was created to turn this theory into
practice. The people at Quark believe that
the sophisticated, “live” models at the heart
of a great multimedia title — anything from
a haunted house to a human body to a race-
track simulator — can be crafted without
frustration and tedium.

mTropolis provides a complete collection
of tools and modifiers for creating software
objects and a messaging system for connect-
ing those objects. This system allows the
author to focus on visually laying out the
project and defining the messages that will
bind the project’s components together
without having to reinvent the wheel every
time a simple operation, such as loading
and running an animation, occurs.

All of your creative work with mTropolis
components can be done visually, without
intricate and time-consuming scripting. Com-
ponents can be combined via dragging and
dropping. Binding components together in

a conversation is a point-and-click process.

If you want a roomful of clocks on a com-
puter screen, you can cut and paste the clock
component repeatedly with no more difficulty
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than using a word processor. Each of those
clocks will tell time without any more work
on your part. Creating a new component in
mTropolis is as simple as creating a new circle
or square in a drawing program.

A stand-alone title is composed of the same
objects you work with in the mTropolis
authoring system, along with the instructions
you gave them on how to interact. The main
difference between a mTropolis project in
the editing environment and a stand-alone
title made from that project is that the stand-
alone title doesn’t have dialog boxes or other
interfaces that would let someone change its
fundamental behavior.

Elements and Modifiers: Building
Media Objects

The fundamental building blocks in mTropolis
are called elements and modifiers. Elements
are essentially containers for media and have
built-in code for maintaining their basic state
(position, size, layer, etc.). Modifiers are pro-
gramming components that can be added to
elements to endow them with new capabilities
such as collision detection. Both elements and
modifiers can be configured via dialog boxes.

Combining modifiers with elements, configur-
ing their operation, and creating conversations
between these modified elements are at the
heart of the authoring process in mTropolis.
Once created, media elements can be freely
shared and reused just like any other mTropolis
component.

mTropolis projects can be executed and
debugged inside the mTropolis development
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environment. To do so, the author switches
from the default editing mode (in which
components are manipulated and config-
ured) to a run-time mode in which the live
components carry out their tasks at full
performance. The title actually runs inside
mTropolis. See “Run — Switching Between
Edit and Run-time Modes” in Chapter 1 of
the mTropolis Reference Guide.

Elements: Creating media objects

When the author creates a new element, it
does not contain any media. The first step in
evolving an element toward its final role in
a title is to link it to external media. External
media types supported by mTropolis include
simple bitmaps, animations, and time-based
media such as digital video and audio files.

In the editing environment, elements dis-
play thumbnail images of the external media
files to which they are linked. For example,
the first frame of a digital video is shown
within the boundaries of the element. When
the author switches from editing mode to
run-time mode, the digital video plays on
the screen within the element boundaries.

A new graphic element, and a graphic element linked to a
QuickTime movie
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The author can configure the operation of the
element through its Element Info dialog box.
This dialog box can be displayed by double-
clicking the element.
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The Element Info dialog box associated with a video element

The Element Info dialog box options set the
media’s initial state: hidden or visible, paused
or unpaused, looped, and so on.

The element’s configuration does not directly
alter the external media file. Instead, it alters
the appearance and behavior of the media
at run-time, such as its representation on the
screen or its volume level. The media file
linked to the element remains unchanged.

Three types of elements can be created in the
mTropolis editor:

¢ Graphic elements, which can be linked to
still bitmaps, animations, or digital video.

e Sound elements, which can be linked to
digital audio files.

¢ Text elements, which can contain text entered
in the editing environment or be entered by
end-users at run-time.



Modifiers: Customizing media objects

Element components can inherit capabilities
from modifiers. In the mTropolis editing envi-
ronment, this process is simple and direct: An
element acquires new capabilities or proper-
ties when modifiers are dragged and dropped
on them.

bl

Al Ol L ey 2
AR -

“Whizzy Bear.mToon (1)

Dragging a modifier from a palette and dropping it on a
graphic element

When an element inherits new capabilities
or properties from modifiers its media is not
permanently altered. For example, an ele-
ment containing an image of a yellow bear
can contain a modifier with a special ink
effect that causes the bear to appear blue.
The appearance of the element is changed,
but the external media linked to the element
remains unchanged.

Like elements, modifiers can be configured
through a dialog box. This dialog box can be
displayed by double-clicking the modifier. Each
modifier’s dialog box is specific to its particular
capabilities or properties. The dialog box for
configuring a Graphic modifier controls the
particular properties that an element would
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inherit from this modifier — in this case, the
appearance of its media. This dialog box also
contains the message pop-up menus used to
configure the modifier’s messaging operation.
These functions are discussed in more detail in
Chapter 5, “Messaging.”

) | Graphic Modifier i
[Graphic Madifier |

Apply Ywhen: Rermove When:
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|Backgrl:-und Transparel E EI
Shape :
” =1 [R5l [+

|Rectangle

The Graphic Modifier configuration dialog box

An element combined with one or more mod-
ifiers can be thought of as a unique author-
defined mTropolis component linked to a
specific media file.

mTropolis comes with a very rich set of modi-
fiers that can be combined with elements to
build titles with sophisticated features. For
example, one modifier provides vector motion
control over elements to which it is added.
A class of modifiers called variables endows
elements with persistent or transient proper-
ties, such as the score of a game or the loca-
tion of a hidden door. Individual modifiers
are described in Chapter 12, “Modifier Refer-
ence” of the mTropolis Reference Guide.

The ability to easily control author-defined
components is extremely valuable. The author
no longer needs to think about the state of the
media as the title evolves. Instead, the author
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works with concrete objects that literally know
how to behave. The tedious work of maintain-
ing an object’s state or checking on its opera-

tion is eliminated.

Again, we want to emphasize that these author-
defined components can be freely reused — cut
and pasted, duplicated, stored and reapplied —

anywhere within a mTropolis project or even in
entirely new projects.

Messaging and User Interaction

Messaging is the glue that binds an object-
oriented system together. As a full-fledged
object-oriented development environment,
mTropolis is no different. As you craft your
title using mTropolis components, you pro-
gram them to interact using messages. This
section provides an overview of how messag-
ing works in the mTropolis environment.

The conversational model

The model that best describes the interaction
in an object-oriented system like mTropolis is
a conversation. In a conversation, the partici-
pants interact dynamically, changing their
responses according to feedback from others.
More critically, in object-oriented systems the
end user can be an active participant in the
conversation. Conversely, the same interaction
in a procedural design requires that all the pos-
sible responses be predetermined, including
those of the end user.

The procedural or scripting model is much
like a cocktail party where every single
utterance is known in advance to every par-
ticipant. Just as this party would be boring
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for you as a participant, new media con-
sumers find titles with this predictability to
be equally unappealing. Consider the taxi
example from Chapter 2. A taxi simulation
in which all routes were predetermined
would quickly bore even a 2-year-old child.

The real world (or any compelling, simulated
world) is internally consistent but also unpre-
dictable. The conversational model creates con-
sistency because the format of the conversation
(like choosing a language and topic at a party)
is determined. The conversational model also
accommodates unpredictability because the
content and course of the conversation is not
predetermined. Thus, the conversational model
truly reflects the real world: every conversation,
whether it’s about particle physics or politics,
rests on some form of structured exchange
between parties, the content of which is not
known in advance.

This faithfulness to real-world systems (or
really, any system that is internally consis-
tent) means that you can model them more
naturally and much more quickly.

Messaging basics

A conversation between mTropolis compo-
nents consists of an exchange of messages,
which are like small, very fast, structured
e-mail messages. Messages tell a component
who is talking to it and what that other entity
wants done.

As we have discussed, elements and modifiers
have certain capabilities. These capabilities
can be configured by double-clicking a
component’s on-screen representation to
display its configuration dialog box. Sending



a message to a mTropolis component is an
alternate, dynamic vehicle for invoking
these capabilities during run-time. For exam-
ple, a Graphic modifier component can be
configured to lighten its element’s media when
it receives a message called “The light is on.”

i Graphic Modifier
[Cighting Effect |
Apply WwWhen: Rernove When :
[The Light iz on | =] [The Liaht i= Off =]
Specifications
Ink: :
fCopy =l @
Shape:
|Rectangle ||E| |[}— M H

A Graphic Modifier dialog box for switching a light on and off

Messages are signals or requests. These signals
are acted on by components configured to
respond to them. If a component receives a
message for which it is not configured to
respond, it merely relays the message to the
components that it contains. For example,
an element might contain a Graphic modi-
fier. When the element receives a “The light
is off” message, it passes the message to the
Graphic modifier. Remember, as far as the
sender of the message is concerned, the
element is a perfectly appropriate recipient
because it inherits the capabilities of the
Graphic modifier.

Messages can be generated by the end user
during run-time (end user mouse actions
such as mouse clicks generate messages), by
the mTropolis environment (mTropolis sends
a Scene Started message to components at
the start of each scene), and by components
themselves (the Collision Messenger sends a
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message when it detects a collision between
elements). Regardless of the source of a mes-
sage, any component can be configured to
respond to it. Special modifier components,
called messenger modifiers, can be used to
generate abstract messages (a “The power is
off” message) to control the flow of events
in a title.

mTropolis provides very powerful but uncom-
plicated utilities for controlling the scope and
tlow of message conversations. For example,
a message can be sent to every component in
a certain portion of a project, or just to a sin-
gle component. One extremely useful feature
of mTropolis is that authors can define mes-
sages with customized names. These author
messages can be detected or sent just like any
built-in message.

Benefits of the messaging system

One of the major benefits of the mTropolis mes-
saging system is that it makes reusability a snap.
As an author combines elements and modifiers
into sophisticated author-defined components,
he is also defining the messages that those
components use to communicate.

Consider an author-defined balloon element
that contains a balloon image, a collision
detection modifier, and a motion modifier.
The motion modifier causes the balloon ele-
ment to drift around the screen and the colli-
sion detection modifier detects any collisions
with sharp objects.

The motion modifier might be activated on
receipt of a message called “There is wind.”
The collision detection modifier might report
a collision with an “I'm popped!” message.
To effectively reuse the balloon component
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in any new title, someone unfamiliar with
the balloon component would only have to
understand these two messages.

For example, an author could duplicate the
balloon component ten times and place the
copies in a jet fighter title for comic relief.
When a fighter (itself a sophisticated author-
defined component) launched, it might gen-
erate a “There is wind” message to simulate
jet-wash. On receiving the message, the
balloons would begin to drift. If any of the
balloons encountered the sharp radar probe
on another fighter, the balloon in question
would generate an “I'm popped!” message.
The author could have this message signal a
sound component to play an explosion or to
trigger an animation of the balloon deflating.

Another important benefit of mTropolis’ mes-
saging is that end user interaction with a title
can be extremely rich and dynamic. Compo-
nents that not only know how to interact
with each other, but also with the end user,
can be dynamically introduced under title
control or end user control. Consider a game
like SimCity in which the end user is con-
stantly introducing different objects, each
with its own rich behaviors. In mTropolis,
the author would simply create components
with the desired behaviors. At run-time, the
end user could introduce as many of those
components as the game permitted, and they
would dynamically interact with each other
and with the end user without any additional
programming.

The object-oriented nature of mTropolis allows
titles to be designed, implemented and ana-
lyzed at the same time, saving enormous
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development time. Although a complex,
event-driven system could be modeled in a
procedural or command-based authoring
tool, the mTropolis messaging system makes
interactions much easier and faster to proto-
type and test.

Structure in mTropolis: A Hierarchy

As titles become increasingly sophisticated, the
complexity of their internals also increases.
mTropolis provides a unique facility for man-
aging complexity in even the largest, most
involved titles. This facility is the mTropolis
containment hierarchy, the same hierarchy that
you can view and rearrange in the mTropolis
structure view. This section explains the con-
tainment hierarchy and how it helps increase
your productivity.

[[] === (ity Project: Structure =—=H B
o E City Project -
b E Downtown Section
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[ EI Street background
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3 E Taxi
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[ E Engine
- E Fuel Tank

ﬁ Fuel Lewvel

ﬁ Tank Capacity

Update Fuel Gauge [
(] ]z

A sample structure view



The mTropolis containment hierarchy
Containers are mTropolis components that
can literally contain other objects within them,
just as a paper bag can contain anything inside
it from other paper bags to a sandwich. An
element is an example of such a component,
because it can contain modifiers.

When a container object holds another object
within it, the container object is called a parent
and the held object is called a child. Think
of a mother kangaroo containing her child
within her pouch. If the child component in
turn contains another component, the child
component is considered the parent of the
object it holds. For example, a container ship
can be the parent of the shipping containers
it holds, which in turn are parents to the boxes
that they hold, which in turn are parents to
the Energizer Bunnies in the boxes.

This chain of parents and children is called
a container hierarchy. We use the word hier-
archy to mean one branch of a tree, such as
only the maternal branch of parents and chil-
dren in a family tree. In a container hierarchy,
just like a family tree, it is possible for a par-
ent to have more than one child. In mTropolis,
children of the same parent container are called
siblings. One of the best ways to represent one
branch of a tree is an outline — which is why
the structure view is presented as an outline.
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Another important aspect of containers is that
they are endowed with all of the capabilities of
all of the components in their container hierar-
chy. In other words, containment is equivalent
to inheritance. Consider a truck component
that contains an engine component that con-
tains an oil reservoir component. The oil reser-
voir component has the capability to be filled.
Because the truck component is the ultimate
parent in the container hierarchy, it can receive
a “Fill me with oil” message on behalf of the oil
reservoir component. As far as a component
external to the truck component’s container
hierarchy is concerned, the truck component
has the capability to be filled with oil.

Now that you understand what a container
is, you should also understand that a modi-
fier is not a container. Modifiers are placed in
containers, where they do work on behalf of
the container, such as sending messages to
and receiving messages from other modifiers
(generally inside other containers). Whatever
capabilities a container may have are derived
from the various modifiers placed in its con-
tainer hierarchy.

If you think back to our author-defined bal-
loon component example, the balloon ele-
ment contained various modifiers, such as a
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motion modifier. The capability of the bal-
loon component to float around the screen
depended on its containership of the motion
modifier, which provided that capability.

Structural containers can be used by the title
developer to group the various contents of a

title into organized parts, like the chapters of
a book or the acts in a play. Some structural
containers, such as scenes and elements, can
also contain media, (such as, pictures, sounds,

or animations).

The mTropolis project itself is a structural
container that contains section, subsection,
scene, and element containers. And, of course,
all containers can contain modifiers. This
hierarchy, beginning with the project, is the
complete container hierarchy of a project
that you access through the structure view.

Behaviors

A behavior modifier is a special container that
can hold other modifiers inside it. Behaviors
can be used to group collections of modifiers
that work in close concert into “supermodi-
fiers” that provide more sophisticated opera-
tions than single modifiers — hence the term
behavior. Behaviors, like other modifiers, inter-
pret messages. The primary use of messaging a
behavior is to collectively enable or disable the
group of modifiers contained within it.

This feature of behaviors is intended to help
authors manage complexity by gathering coop-
erating modifiers into a single location. Power-
ful behaviors can be dragged and dropped as
needed, either from libraries or from different
sections of a project. In general, behaviors
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promote clean reuse of logic and enable
programmers to deliver sophisticated title
operations to artists in drag-and-drop packages.

Another special feature of behaviors is that
they can contain other behaviors within
them, and those child behaviors can be

parents of other behaviors, to an arbitrary
depth. This feature permits the creation of
an extremely sophisticated behavior at the
top of a container hierarchy of behaviors.

Consider the behavior of a variety of house-
hold pests: They avoid light. But cockroaches
also run from light only under certain con-
ditions. A light avoidance behavior could be
contained within a cockroach behavior, selec-
tively switched on under certain conditions, to
quickly, simply, and easily model a cockroach.

It is important to remember that this behavior
containment hierarchy is a part of the project
containment hierarchy that can be inspected
and altered through the structure view.

Messaging and the containment hierarchy

The containment hierarchy fulfills an impor-
tant function, in addition to providing a frame-
work to organize the inclusion of components
within one another. Each successively higher
level of the container hierarchy represents a
higher level of abstraction in the project, an
arrangement that actually helps you direct the
flow of messages even in complex projects.

Consider a project for a children’s edutainment
title on physics.
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A message sent to the Physics Lab section cascades and
relays from component to component

The physics tutorials in this title could show
what happens when constants are changed.
If the child clicks an antigravity switch in a
room of the title, gravity should switch off. In
a language like C++, you would have to send
a message directly to the gravity component,
which means you must remember exactly
where the component is. In mTropolis, you
have much more flexibility in messaging,
thanks to the containment hierarchy.

The containment hierarchy enables message
broadcasting. An author message called “Turn
off gravity” can be sent to an entire section of
the project. mTropolis automatically cascades
and relays the message from the section level
on down through the entire containment hier-
archy. Any component contained anywhere
in the hierarchy capable of responding to the
“Turn off gravity” message would respond.
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The advantage of broadcasting is that you can
cause global changes without laboriously spec-
ifying each and every component that needs
to act on a message. In the example above,
where gravity modifiers are scattered through-
out the containment hierarchy, they would
turn themselves off without any further work
on your part. On the other hand, you may
not want to cause global changes. Fortunately,
the containment hierarchy enables more pre-
cise targeting of messages.

Broadcasting is simply the most general case of
what is called message targeting in mTropolis.
You can target a message at any level of the
containment hierarchy from a single, indivisi-
ble modifier at the very bottom to some con-
strained portion of the containment hierarchy.
In the preceding example, you could target
the “Turn off gravity” message to only a sin-
gle scene of the project. The message would be
sent only to the scene, then cascade to the ele-
ments and modifiers in that scene.

Basic rules of the mTropolis containment
hierarchy

Remember the following basic rules of the
mTropolis containment hierarchy:

e Containment is equivalent to inheritance;
as far as any entity outside of a container is
concerned, the container has all of the capa-
bilities of whatever it contains.

¢ All mTropolis components are containers
except modifiers.

¢ All containers can contain modifiers and
behaviors.

¢ All containers can contain other containers.

¢ Only scenes and elements can contain
elements.
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¢ All mTropolis objects can be the target of a
message, but a modifier (or the system/end
user) must be the originator of the message
and another modifier will actually process the
message and do the work. The only excep-
tion is that elements can directly receive
command messages to change their basic
appearance. For example, an element con-
taining a QuickTime movie can be directly
commanded to play the movie.
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mTropolis
Components

This chapter discusses mTropolis components,
how they work, and their role in the mTropolis

containment hierarchy.



The Element Component: Putting It
in Context

The fundamental building block of a title is
an element. An element can be linked to an
external media file to display still images or
play time-based media. Elements have built-
in code for maintaining their basic state (for
example, the element’s position) and con-
trolling the appearance of media they con-
tain (that is, which frame of an animation is
currently displayed).

This section gives an overview to help place
the other mTropolis components in context.
We'll discuss elements in more depth later in
this chapter.

Elements and external media

The author creates elements and links media
to them. The appearance of an element changes
to indicate the media to which it is linked. For
example, if an element is linked to a QuickTime
movie, a thumbnail from the first frame of the
QuickTime movie is shown within the ele-
ment’s boundaries. Elements can be resized
and positioned in the layout view.

| Minou.mov |

Graphic elements linked to a QuickTime movie, mToon, and
PICT file
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There are three basic types of media elements
in the mTropolis environment:

Graphic elements

Graphic elements can be linked to images (such
as PICTs), digital video (including QuickTime
movies and QuickTime VR panoramas), and
animations (in the mToon proprietary anima-
tion format).

Sound elements
Sound elements can be linked to sound files
(such as AIFF format sound files).

Text elements

Text elements cannot be linked to external text
files. However, text can be entered into text ele-
ments and formatted within mTropolis. Text
elements can also be made editable so that end
users can modify their contents in run-time.

Elements and the Containment Hierarchy

Elements are always contained by other
components, either other elements or scene
components. When a new project is opened,
mTropolis provides a project component
(Untitled-1), a section component (Untitled
Section), a subsection component (Untitled
Subsection), a shared scene component (Unti-
tled Shared Scene), and a scene component
(Untitled Scene). These components are
described in more detail below.

Project components

A project component is a structural container

that holds an entire title within it. The immedi-
ate children of a project are sections. A project
can only contain sections and modifiers. Pro-

jects cannot contain other projects.
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Section components

A section component is a structural container
that can be used by the title developer to
gather different chunks of a title into groups
that logically belong together. For example, a
title developer for a travel CD-ROM might put
everything to do with Africa under a single
section. A section is most closely analogous to
an act in a play or a chapter within a book.
Sections are parents to subsections. A section
can only contain subsections and modifiers.
Sections cannot contain other sections.

O == untitled-4: Structure = @ B

= I untitled-4 =
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- (g untitled Subsection

[ E Untitled Shared Scene
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Structure view of a new mTropolis project

Subsection components

A subsection component is a structural con-
tainer that can be used by the title developer
to divide the content of a section more finely,
literally like a subsection in a book. For exam-
ple, the title developer for a travel CD-ROM
might put everything to do with the country of
Kenya in a subsection, the parent of which
would be the Africa section. Subsections are
parents to shared scenes and scenes. Subsec-
tions can contain a single shared scene, multi-
ple scenes, and modifiers. Subsections cannot
contain other subsections.
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Shared scene components

The shared scene component is a structural
container that is a sibling of scene contain-
ers. It is used to contain elements common
to all scenes in a subsection. Elements in a
shared scene are visible or audible in any
scene in the same subsection. A background
music track, for example, might be placed in
the shared scene. Background images or but-
tons common across scenes in a subsection
can also be placed in the shared scene. In our
African travel project, a shared scene might
maintain the appearance of the plains across
different Kenyan scenes, as well as providing
common background music.

Shared scenes can only contain elements and
modifiers. Shared scenes cannot contain scenes
or other shared scenes. Also, only one shared
scene is ever present in a subsection. Shared
scenes can also have graphical media assets
linked directly to them.

The shared scene itself is always drawn behind
the current scene, but elements on the shared
scene can be layered above elements on the
current scene.

Scene components

A scene component is a structural container
that is very much like the scene in a play. As
a scene in a play contains all the props and
actors required to convey some discrete piece
of action to an audience, a scene in a mTropolis
title contains all the components to do the
same for an end user. Scenes are the highest
level structural components that are visible to
end users — every element that an end user can
see or manipulate is contained within a scene.



A scene presents a microcosm (for example, an
African watering hole, or a room in a haunted

house) that contains child components for all

of the props and actors in that microcosm.

Scenes can only contain elements and modi-
fiers. Scenes cannot contain other scenes.
Note, however, that there is no limit to the
number of scenes that can be present in a
subsection. Like shared scenes, scenes can
have graphical media assets linked directly
to them. Scenes are, in fact, just a special type
of graphical element.

Element components

An element component is the workhorse of
mTropolis. Elements can be linked to media
such as pictures, sounds, animations, and
video. Elements can also contain modifiers
(which help to bring the raw media they
contain to life) or other child elements.

Consider a scene representing an African plain.
The title author would use visual elements
containing pictures of dry grass and trees to
create a compelling image of the plain.

Now consider that the author wants a vulture
to fly around the plain. An element simply
containing a picture of a vulture, or even
containing various frames to animate the
vulture’s wings, will not accomplish the
objective of making the vulture fly. The vul-
ture element needs to contain a motion modi-
fier component. When the author drops that
component on the vulture element it would
be endowed with the motion capabilities of
that motion modifier. The vulture could be
set to follow a preprogrammed path or to
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move about randomly as it iterated through
its wing animation.

Now consider that the tree elements of the
plain could contain collision detection modi-
fiers. The tree elements could then detect when
the vulture elements collided with them.

Elements can also be the parents of other
elements. Why would an element contain
another element? Consider the vulture
described above. The wings of the vulture
might have been created separately from the
vulture’s body, so the author might receive
the vulture as three separate elements cre-
ated by the art department. The vulture’s
body needs to carry the wings along the
same path that it travels. The simple solu-
tion is to attach the wings to the body by
containing the two wing elements inside the
body element. The final, compound vulture
element will move along the path as a unit.

How Graphic Components Are Drawn

Only shared scenes, scenes, and elements are
actually drawn on the screen by mTropolis.
This section contains some basic information
on how these components are drawn.

Elements contained by a scene are drawn by
default on top of the scene. Scenes are drawn
by default on top of the shared scene that
services them.

Elements are automatically assigned a layer
when they are added to a scene. The layer of
new elements increases as they are added to
the scene. Each layer contains only a single
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element. The layer order can be changed
dynamically during run-time. Note that layer
order is independent of the parent/child rela-
tionships of elements in a scene. Layer orders
are described in more detail in Chapter 10 of
the mTropolis Reference Guide.

By default, mTropolis builds the scene off-
screen in memory before it is presented to
the viewer. The viewer does not see each ele-
ment added to the scene but views the result
of layering one element on top of another.

In this “2.5D"” approach, elements always
appear above elements of a lower layer
and below elements of a higher layer when
they are redrawn. Because they are clipped,
this approach creates the illusion of a 3D
perspective.

The effect of graphic layers

mTropolis provides the option of displaying
elements direct to screen, turning an ele-
ment’s draw order off. This feature is useful
when you want an element to always draw
on top of everything else on screen.
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Modifiers

Modifiers are special mTropolis components
that modify the properties of other compo-
nents in a project. Some modifiers are built
into mTropolis, but new ones can be plugged
in seamlessly so they behave just like the
built-in modifiers.

Modifiers are used by dragging them from one
of the modifier palettes and dropping them on
the object that they are to modify. Each modi-
fier on the modifier palettes has unique capabil-
ities or properties. When a modifier is dropped
onto a component, the component assumes
these capabilities or properties.

For example, a Gradient modifier has the ability
to alter the visual characteristics of graphic ele-
ments. When dropped onto a graphic element,
the Gradient modifier’s capabilities are added to
the information that makes up that object.

My Elernent (3 2

The Gradient modifier, placed on a graphic element

While some modifiers have the ability to
change the visible characteristics of the
elements on which they are placed, other
modifiers change invisible characteristics, or
properties, of the element that contains them.
For example, when a Point Variable modifier
that contains the value (640, 480) is placed
on an element, the physical representation
of the element does not change, but its
content, the value (640, 480), becomes an
intrinsic part of the element that contains it.



All modifiers can be configured (their capa-
bilities can be customized) by changing the
settings in their dialog boxes. In addition,
most modifiers can be configured to apply
their effects at specific times through a process
called messaging.

A message in mTropolis can be as simple as
a mouse click, or as complex as an author-
defined message that is generated only after
specific conditions in the run-time environ-
ment have been met. Some messages are
generated by mTropolis during run-time and
automatically sent to specific components
throughout the project, and others can be
sent to components from special modifiers
called messengers.

Complete information on mTropolis modifiers
can be found in Chapter 12 of the mTropolis
Reference Guide.

Behavior modifiers

A special type of modifier is worth mention-
ing here. A behavior is a special component
in the mTropolis environment. It can be used
to encapsulate (or contain) groups of modi-
fiers and other behaviors.

Behaviors can be used to hierarchically group
collections of modifiers that work in close
concert. Each collection can be enabled or
disabled with messages, creating “supermodi-
fiers” that provide more complex operations
than single modifiers alone.One of the most
powerful features of behaviors is that they
can be switchable. That is, they can be
turned on or off with messages. When a
behavior is switched off, all of the modifiers
it encloses are disabled. When a behavior is
switched on, individual behaviors or modi-
fiers within a behavior can then be activated
by incoming messages. This feature allows the
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author to create and control components with
very sophisticated capabilities.

A complete description of the behavior modi-
fier can be found in the “Behavior” section in
Chapter 12 of the mTropolis Reference Guide.

Aliases

One powerful mTropolis feature is the ability
to make a special copy of any modifier (includ-
ing behavior modifiers), called an alias. Creat-
ing an alias makes a master copy of a modifier
and places it on mTropolis’ Alias Palette. Modi-
fiers on the Alias Palette can be dragged and
dropped onto any element in a project. All
copies of an alias placed this way or copied
and pasted from another element share the
same settings and can be updated by editing
any instance of that modifier.

This feature is useful in complex projects where
a modifier may be employed in an identical
fashion in many different sections of the pro-
ject. For example, in an adventure game, a
Graphic modifier might apply the same effect
to images that represent stone walls through-
out the game. During the authoring process,
changing the settings of identical modifiers
can be time-consuming. Using aliases of the
Graphic modifier in our example would per-
mit the author to make a change to any copy
or any of its aliases, and that change would
instantly occur in all copies of the modifier.

Aliases can be very powerful when used with
behavior modifiers. Dropping a new modifier
into an aliased behavior causes all instances
of that behavior to be updated.

For complete information on creating and
managing aliases, see the “Alias Palette” section
in Chapter 11 of the mTropolis Reference Guide.
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Messaging

This chapter focuses on the messaging relationships
between components. Chapter 4, “mTropolis Com-
ponents” outlined the role that components play in

the mTropolis authoring environment.



Activating Elements and Modifiers

As we discussed previously, messages are sent
and received by modifiers at various levels of
the project hierarchy. Modifiers can also receive
messages from the mTropolis run-time environ-
ment itself, such as scene change events or end
user mouse events.

Elements themselves do not send messages,
but they can receive certain special messages
(called commands) directly from modifiers.
Behaviors, while they do not send messages
either, can be switched on or off by messages.

Messages are essentially signals that tell ele-
ments and modifiers to engage in some oper-
ation. Consider the Graphic modifier placed
on some arbitrary element, as depicted in the
Graphic Modifier dialog box below.

In this example, the Graphic modifier listens
for a Mouse Down message. When that mes-
sage is sent to it, it applies its graphic effect.
When it receives the Mouse Up message, it
returns the element to its default color.

i Graphic Modifier
[ aphic Modifier |

Apply wWhen: Rernove When:
IMu:-use Davwen | E IMu:-use Up | E
Specifications

Ink: :

|'3°pu. |[=] E
or =1 R e [R]

IRectang]e

A Graphic Modifier dialog box configured to activate on
Mouse Down and deactivate on Mouse Up messages

An important point about messages is that
they are always available to the author,

Messaging

regardless of whether they are associated
with some specific environmental event. In
the example above, the Mouse Down mes-
sage could have been sent to the Graphic
modifier from the mTropolis environment
in response to an end user mouse click.
However, it could also have been sent by a
messenger modifier configured to send a
Mouse Down message in response to some
condition. The ability to simulate external
events under program control is particularly
useful for debugging and testing.

Timer Messenger

E ITimer IMezzenger |

Execute 'when: Terminate When:

|Mouse Up | E INone | E

—  Delay For
o0-00.00 | [ Loop timer

—  HMHessage
Message /Command: ‘w'ith:

|None | E INone | E

Drestination :

—(

Message Options
IE Irmmediate E Caszcade E Relay |
=

A typical Messenger dialog box

Messenger Modifiers: Building Logic

Messenger modifiers (often referred to sim-
ply as messengers) are dedicated to sending
and receiving messages. Messengers are the
components that implement the abstract
logic of a mTropolis title. For example, a
Timer Messenger listens for a message and
delays for a selected period of time. Then it
sends another message out.
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Messaging

The Timer Messenger dialog box shown
above and deconstructed below, illustrates
the full power of messaging in mTropolis.
Through their dialog boxes, messengers can
be configured to send specific messages to
specific destinations with any data that the
author wants to send and receive. Messaging is
a powerful, but simple process. The “four Ws”
of messaging — when, what, where, and
with — are described below.

When

The Timer Messenger, like most modifiers, has
two “when” pop-up menus. When the modi-
fier receives the message selected by the Exe-
cute When pop-up menu, the modifier will
activate as it has been configured to do. When
the modifier receives the message selected in
the Terminate When pop-up menu, it will
return to an inactive state.

E Tirner Messenger

Execute “When: Terminate 'when:

| (=] frene (=

Delay For |

IMouse Up

D Loop tirmer

What

The Message/Command pop-up menu is
used to select the specific message to be sent
when the messenger is activated.
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Message
Message /Cormmand “With:
INone | E INone | E
Destination :
=l
Where

The Destination pop-up menu is used to select
where the selected message will be sent.

Message /Cornmnand : Wwith:

INone | E INone | E
Destination :
=l

With

Optionally, data can be sent with a message.
The With pop-up menu is used to select a
variable or constant value to send.

Each of the pop-up menus will be described
in turn.

| DLoop tirner |

Message.-"C’ommand : With :

|None | E |None | E
Destination :

=

When and what message pop-ups

The When and What pop-up menus deal
with the same entity — messages — so we'll
describe them together.

Together, the When pop-up menus control
the conditions under which the messenger
(or any modifier for that matter) will operate.



The first When pop-up menu selects the
message that will activate the messenger. It
can be any arbitrary message, either author-
defined or built-in, just as with any other
modifier. The second When pop-up menu
selects the message that will return the mes-
senger to an inactive state, just as with any
other modifier.

The What pop-up menu is distinct from the
When pop-up menu in that it determines the
output of the messenger. The message selected
by the What pop-up menu will be sent when
the messenger activates. This message can be
any message available in the mTropolis envi-
ronment, either author-defined or predefined.
And, as mentioned above, this message could
be a simulated environment message, such as
a Mouse Down.

See “The When Pop-Up Menu” and “The
Message/Command Pop-Up Menu” sections
in Chapter 13 of the mTropolis Reference Guide
for complete information on these menus.

Where destination pop-up

The Where pop-up menu selects the destina-
tion, or target, of a messenger’s output message.
The ultimate target must be another modifier,
element, or behavior. However, these compo-
nents can be anywhere within a project’s con-
tainment hierarchy. In the case of a modifier
or behavior, they could be nested within a
behavior as well.

Container hierarchy and messages

As explained above, the destination for a
messenger’s output message can be either a
specific component, an arbitrary level of the
project, or a behavior containment hierarchy.
By default, mTropolis automatically handles
cascading the message down through the con-
tainment hierarchy to the elements, modifiers,

Messaging ™

or behaviors that might be listening for the
message that was sent (though these defaults
can be changed). Remember, we explained the
power of the containment hierarchy for con-
trolling the flow of messages in Chapter 3.
Message destinations are described in detail in
the “Destination Option Descriptions” section
in Chapter 13 of the mTropolis Reference Guide.

Some examples of possible message destina-
tions in the container hierarchy are:

¢ The messenger modifier sends a message to
the element that contains the messenger. This
destination is called the element destination.

The element destination

e The messenger sends a message to another
modifier contained by the same element (a
sibling of the messenger). This destination is
called a messenger’s sibling destination.

Sound Effect Modifier

A messenger’s sibling destination

e The messenger sends a message to another
element (to a sibling of its parent). This pop-
up menu is the element’s sibling destination.

[E] sibting Elerment

E Elernent

B Hessenger 1

An element’s sibling destination
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The illustration below depicts a messenger
sending a message (the black line) to an arbi-
trary level in the containment hierarchy and
how that message cascades down (the gray
lines) to all of the eventual recipients.

Section

:'*--ﬂ Subsection

ﬁ;E Shared Scene

Messenger 1

A message moving down the containment hierarchy

In the preceding illustration, the messenger
contained by Element 2 sends a message to
the Section component. The Section is the
container (and parent) to the Subsection,
which is in turn the container and parent to
the Shared Scene and Scene, which is the
container and parent to Elements 1 and 2.
When the messenger targets its message at
the section, that message cascades down to
every component in the section’s portion of
the project hierarchy.

There are two points to make about this use
of the containment hierarchy for messaging.
First, the message sent by the messenger goes
directly to the section and does not travel up
the containment hierarchy. Second, the mes-
sage, as it cascades down the containment
hierarchy, is only acted on by modifiers that
have specified in their When pop-up menus
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that they wish to be activated by the message
in question. All other components ignore
the message.

Relative message targeting

A very powerful feature of messaging in con-
junction with the containment hierarchy is
relative message targeting. You have seen
that you can specify some abstract level of
the containment hierarchy as a target, and
mTropolis will handle all of the details of cas-
cading the message to the possible recipients.

Relative message targeting enables you to tar-
get other components by their relation to a
modifier, rather than their specific names or
positions in the containment hierarchy. For
example, you could specify that you want a
message sent to a modifier’s parent in the
containment hierarchy, or its parent’s parent,
all the way up the hierarchy. Similarly, you
could send a message to its parent’s sibling.

The building blocks for describing relative
message destinations are shown in Chapter
14 of the mTropolis Reference Guide.

Behavior containment hierarchy and messages
As we mentioned in our discussion of behav-
iors in Chapter 4, behaviors can contain mod-
ifiers and can also be nested inside of other
behaviors. This behavior containment hierar-
chy is a part of the project containment hier-
archy, displayed and alterable through the
structure view. The following illustrates the
relationships between behaviors, modifiers,
and an element.



Behavior 1 is contained by the element. Behav-
ior 2 is contained by Behavior 1. The messen-
ger contained in Behavior 2 can directly target
its siblings, the modifiers contained by Behav-
ior 1. In order for the modifier contained by
Behavior 2 to send a message to a modifier on
the element (Messenger 1), however, it must
target the element.

A message Is broadcast to an element containing both a
behavior and another element

The next example illustrates how a message is
broadcast to an element that contains both a
behavior and another element.

Element 2 is contained by Element 1. A mes-
sage broadcast to Element 1 cascades succes-
sively down the containment hierarchy.

Behavior on an element and the modifiers it contains

Messaging ™

Behavior window

The next page shows a behavior on an ele-
ment, and the configuration dialog box for
the behavior showing the modifiers it contains.

Notice that the behavior dialog box shows
the execution order of modifiers (the (1), (2),
(3), (4), and (5) indicators next to the icons)
and the particular messages that activate
them (“Music is On” and “Music is Off”).
mTropolis processes messages in the order
they are received, and looks for the first
modifier that will respond to the message
currently being processed.

The “Dancing Bear Behavior” provides a con-
crete demonstration of how behaviors can
cleanly group cooperating modifiers into a
high-level behavioral component. The behav-
ior in this example contains the modifiers
that enable the Whizzy Bear mToon™ to play
different animations depending upon what
style of music is being played. However, once
created, this behavior can be dragged onto
other mToon elements throughout a project.
In this way, behaviors promote easy reusability.
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Behaviors, like modifiers, can be activated and
deactivated through the receipt of messages.
When checked, the Switchable check box in
the behavior window enables a behavior to be
controlled in this fashion. The Enable when
pop-up menu specifies the message that will
enable the behavior and the Disable when
pop-up menu specifies the message that will
disable the behavior. When a behavior is
deactivated, all of the modifiers within that
behavior are effectively deaf to any messages
that arrive. It will not allow messages to cas-
cade down to its children.

The ability of behaviors to switch between
Enable and Disable is especially powerful
when behaviors are nested within other
behaviors. As we discussed previously, behav-
iors can be nested so that they fire activation
and deactivation messages downward in a
sophisticated cascade. This gating of nested
behaviors can be used to model very complex
logic in a manageable and reusable manner.

[0 =-———— Dance Fever: Dancing Bear Behavior =———FEHH
IDancing Bear Behavior | D Swritchable
Enable when: Dizable when:
IParent Enablzd | W,é II‘-Ic-ne
i
Fusic is On —
Flay =
Music is Off
A Fauze
whizzy Bear.mToon (1]
-
B *
- Dance to Funk Eill (=)
(2 Music is OFf -» Reset to First Cel
- Dance to Disco +
E (1) Il (4
Dance to Techno Muzic iz OFf -> Stop Dancing
- |
A [l [

A behavior modifier dialog box

58 %_mTropolis Developer Guide



With menu: Sending data

The With pop-up menu allows a messenger to
pass data along with output by a messenger.
For example, information about the current
element’s screen position, where the end user
clicked the screen, or current values of vari-
ables could be sent along with the message.

A messenger can send no data (the default selec-
tion), a constant value (entered in the With
pop-up menu in appropriate syntax), the value
that it received from the message that activated
it (the incoming data), or the contents of any
variable modifier accessible to the messenger.

For example, you might want to send the
value stored in a variable called “Light inten-
sity” with a message called “Light is on.”

See “The With Pop-Up Menu” section in
Chapter 13 of the mTropolis Reference Guide
for complete information on this menu.

Types of Messages

Messages in mTropolis can be divided into
three types. The first two types, author mes-
sages (messages created by the author of a
project) and environment messages (built-in
messages sent by mTropolis), act as signals or
conveyors of information. For example, the
Mouse Up message signals the recipient that
someone clicked the mouse.

The third type of message is called a com-
mand. Sending a command constitutes a
demand that the recipient object perform
some action, and it cannot be ignored.
Command messages are primarily used to
control elements. For example, when an

Messaging ™

element receives the Play command, its
media immediately starts to play.

This section describes the various types of mes-
sages available for use in mTropolis. More infor-
mation on these messages can be found in the
“Environment Messages,” “Author Messages,”
and “Commands” sections of Chapter 13 of
the mTropolis Reference Guide.

Author messages and environment messages
While command messages are imperatives
that elements cannot ignore, signal messages
inform modifiers that an event has occurred.
If the modifier is listening for that information,
it acts on it.

Author messages

Author messages are defined by the author
by entering the text of a new author message
into the When pop-up menu of a modifier.
mTropolis asks if you wish to create a new
author message.

Author messages are never sent by the
mTropolis environment; they are only sent
by messenger modifiers, under the author’s
control. However, any modifier, through its
When pop-up menu, can be controlled by
any author message.

Environment messages
Environment messages appear as options in the
message menus. Examples include:

e Mouse Down: The mouse button was pressed
while the cursor was over an element.

e At First Cel: The first cel in an animation
contained by an element has been reached.
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e Motion Started: An element has started
moving.

e Scene Ended: The scene has ended.

While mTropolis itself sends environment
messages to modifiers that are listening for
them, mTropolis does not have a monopoly
on the use of environment messages. As we
mentioned previously in this chapter, the
author can send environment messages from
a messenger at will. For example, an author
wishing to test some end user interaction
logic could emulate a mouse event by simply
sending a Mouse Down message from a par-
ticular messenger.

Commands: Control signals

Commands appear in the What pop-up
menus as italicized text to distinguish them
from other messages.

Commands are different from author/
environment messages in the following
two respects:

e Commands act directly on elements. Ele-
ments do not have to be configured to hear
commands, and they respond to them imme-
diately, without interpretation. For example,
there are commands that tell a digital video to
play or hide, or a still image to show or hide.

Since commands act directly on elements,
they do not affect modifiers. The author
cannot, for example, command a modifier
to Play or Pause. However, modifiers can
receive and interpret commands, or pass
them on to elements if directed to do so.

e Commands are like any other message in that
they can be targeted to a specific element, to
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a specific level of the containment hierarchy,
or to relatively positioned elements. However,
commands are never cascaded to children of the
destination element.

Here are some examples of commands:

e Play: Play the animation or digital video
from the first cel in its range.

e Stop: Stop the animation or digital video
and hide it.

¢ Close Project: Quit the title.

Messenger

m |Messenger |

Execute When:

ra—(

Message Specifications

Message /Cornmand : ‘with:

[marne ||+ Nene E

Crestination : Author Meszages b

IE]ement Mouse »

Show
Text Hide
Flay Control » Selec?
Mation B Deselect
Transition » Togale Selectd
Object B Sorelio
Farent P SorelDown
Scene B Serellieft
Shared Scene B Sorell Righ?
IFra e M ot itodia
Responzes /Ertors M| Flusk predis
; EPreioll Medis

Get Attribute 4 : .
Set attribute p ok Load Pleshs

Commands in the Message/Command menu’s
Element section

See Chapter 13 of the mTropolis Reference
Guide, “Modifier Pop-Up Menus and Message
Reference,” for a complete list of commands.
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QuickStart
Tutorial — A Simple
Slideshow

In this tutorial, we'll create a simple slideshow — four images

that the end user can flip through like a book.



Getting Started

This project takes advantage of mTropolis
structural hierarchy. The scenes in a subsec-
tion of a mTropolis project can be thought
of as a stack of cards or the pages in a book.
Here, we'll create four scenes that each con-
tain one image. Using the scene change modi-
fier, we cause the scenes to change based on
the end user’s mouse actions. The result is a
presentation that end users can browse at
their own pace.

What you'll need

mTropolis must be installed on your machine.
Installation instructions can be found in the
“Read Me First!” file on the mTropolis CD-ROM.

The tutorial files are installed by default when
mTropolis is installed. Media files used in this
tutorial can be found in the Tutorials folder of
the mTropolis installation. If the tutorial files
have not been installed, run the installer from
the mTropolis CD-ROM, or drag the Tutorials
folder from the CD to your hard disk.

This project uses 8-bit media. For best perfor-
mance, make sure your monitor is set to dis-
play 256 colors.

QuickStart Tutorial — A Simple Slideshow ™

Getting started
1 Launch mTropolis by double-clicking the
mTropolis icon. mTropolis appears with a
new, untitled Layout window.

2 Click inside the Layout window to choose
the Untitled Scene.

O=——untitled-lilaywit ————[IH
~ [[_Unkited Subsection _w]|_untitied Soene ~e] =]

Untitled Ssetien

N

Untitled Seene @
< ¥

ST

Choose the Untitled Scene by clicking inside the Layout
window

3 Choose Link Media — File from the File
menu. A dialog box appears.

4 In the file dialog box, choose the file Slide
Show 1.pict (Tutorials > Quickstart >
Slideshow PICTS). Click Link to link the
picture to the scene.

G Slideshow PICTs | % Scipio
Preview = =
& arrowleft.pict =
@ arrowright.pict
. |T® Stide Show 1.pict
3 & Slide Show 2.pict
. | stide Show 3.pict
Slide Show 4.pict
o Lo )
A4 Show Preview

Click Link to link the selected picture to the scene
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5 The Layout window updates to show the
new media linked to the scene, and the
name of the scene changes to match the
name of the media.

[= Untitled-1: Layout =]

The new media is shown in the updated Layout window

Create the Next Scene

We’ve imported the media for our first scene.
Now we need to create the second scene and
link a picture to it.

1 Create a new scene by choosing New Scene
from the Layout window’s scene pop-up
menu. This is the third pop-up menu but-
ton from the left, found at the top of the
Layout window. Currently, this button
reads Slide Show 1.pict.

O

Choose New Scene from the Layout window scene
pop-up menu
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2 The Layout window changes to show the
new, Untitled Scene. The scene is already
selected for us so we can link media to it.

3 Choose Link Media - File from the File
menu. A dialog box appears.

4 In the file dialog box, choose the file Slide
Show 2.pict from the Slideshow PICTs
folder, found inside the QuickStart folder.
Click Link to link the picture to the scene.

& Slideshow PICTs | =

& arrowlertpict

T8 arrowright.pict
& Slide Show 1.pict Desktop
~ |T® Stide Show 2pict
~ |® Stide Show 3.pict
Slide Show 4.pict

=

[ Show Preview

= Scipio

Preview

[

e B

Eject

Choose Slide Show 2.pict from the Slideshow PICTs
folder, located in the QuickStart folder

5 The Layout window updates to show the
new media linked to the scene.

The updated Layout window reflects the new media
linked to the scene



Create the Last Two Scenes

We created the second scene of our project
using the Layout window’s scene pop-up
menu. We'll use a different method to create
the last two scenes.

1 Choose Structure Window from the View
menu to display the mTropolis Structure
window.

2 The Structure window for the project
appears. This window displays a hierar-
chical view of the project. Components
of the project are shown as named icons.
Open/close triangles to the left of those
icons allow you to reveal or conceal dif-
ferent levels of the project hierarchy.

O == My Slideshow: Structure = EI B
< I Untitled 1~

I [ untitted Section
L3

ST

4] ID

3 Click the triangle next to Untitled Sec-
tion to reveal the Untitled Subsection.

4 Click the triangle next to Untitled
Subsection to reveal the scenes we are
working on.

QuickStart Tutorial — A Simple Slideshow ™

5 Click the icon for the Untitled Subsection
to select that subsection. The Structure win-
dow should look like the one shown below.

O == My Slideshow: Structure = 1B

o I ™ Stideshow =

= [P untitted Section

- p tig
S E Untitled Shared Scene

E5 stide Show 1 pist
5 svide Show 2 pist

Jm L

6 Choose New - Scene from the Object
menu to create a new, untitled scene.
A new scene appears in the Structure
window as shown below.

SIEN

1

[0 == My Slideshow: Structure = 1B

= G My Stideshow

= [P untitted Section

- [[g Untitted Subsection

[ [ Untitted Shared Soene
Slide Show 1.pict
5 stide show 2 pict

<[] ]~

7 The new Untitled Scene is selected and
ready to have media linked to it. Choose
Link Media - File from the File menu.
A file selection dialog box appears.
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8 In the file dialog box, choose the file Slide
Show 3.pict from the Slideshow PICTs
folder, found inside the QuickStart folder.

Click Link to link the picture to the scene.

Preview G Slideshow PICTS | % = Scipio
& arrowleft.pict [=]
TR arrowright.pict
1 | stide show 1.pict
- & Slide Show 2.pict
& Slide Show 3.pict
- slide Show 4.pict
)
[ Show Preview

Choose Slide Show 3.pict from the Slideshow PICTs
folder and link it to the scene

9 Notice that both the Structure and Layout
windows update to reflect the new scene
as shown in the picture below.
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Now we're ready to create the fourth and last
scene in our project.

1 Choose New - Scene from the Object
menu once again. Another new scene
appears in the Structure window. Your
Structure window should look like the
one shown below.

O == My slideshow: Structure =0 B

-

= Y My Stideshow =
w [ Untitted Sestion

- [[g Untitled Subsection

B [E] untitled Shared Scene

£ stide show 1 pict
£ stide Show 2 pict
Slide Show 3 pict

= -

KN} D
2 Choose Link Media - File from the File
menu. A file selection dialog box appears.

3 In the file dialog box, choose the file Slide
Show 4.pict from the Slideshow PICTs
folder, found inside the QuickStart folder.
Click Link to link the picture to the scene.

- = -
& arrowleftpict [=|
s ﬂ arrowright.pict
e, SR TR slide Show 1.pict
! % ¥ |1& stide Show 2.pict
T [TR Stide Show 3pict
- ) Slide Show -.pict
=) Cptme J

[ Show Preview

Choose Slide Show 4.pict from the Slideshow PICTs
folder and link it to the scene



4 Again, both the Structure and Layout win-
dows update to reflect the new scene as
shown below.

My Slideshow: Layout

Gy it susection
[E] Untitied Shared Scene
2 stide show 11t

] stie o 2900t
it

The Structure and Layout windows update to reflect the
new scene

Save Your Project

Before we continue, you should save your
work up to this point.

1 Select Save from the File menu.

2 A file selection dialog box appears. Choose
a location and name for your project, then
click the Save button.

G My Projects | I

= Scipio
Eject

[ Save “

ID

Save File As:

[My Slide Show

Using the file selection dialog box, choose a location for
your project, name it, and click Save

QuickStart Tutorial — A Simple Slideshow W

Run Your Project

So far, we’ve worked in the mTropolis edit
mode. To see the project as end users would
see it after it has been saved as a built title,
we can switch to run-time mode.

1 Press 3 -T to switch from edit mode to
run-time mode.

2 The mTropolis interface disappears and
the first scene of the project is displayed.

3 Move the cursor around the screen. Click
anywhere you like. You'll see that nothing
happens. But there’s nothing wrong with
your project. All of the scenes are in there,
but the end user has no way to access
them. We need to add some modifiers to
our project to create interactivity.

4 Press 36-T again to return to edit mode. The
mTropolis editing environment reappears.

Add an Element to the Shared Scene

Now we'll create controls that can be used to
navigate through the scenes of our project.
Eventually, we’ll have a forward and a back-
ward button that end users can click to change
the picture on the screen.

We want these buttons to be visible in every
scene of the project. By placing them on the
shared scene, they will always be visible.

What's a Shared Scene?

When looking at the Structure window, you
may have noticed that our subsection con-
tains a component named Untitled Shared
Scene in addition to the four scenes linked to
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the slide show images. This component is a
special type of scene. Any media placed on

the shared scene will be visible in every other
scene in the subsection.

Navigate to the Untitled Shared Scene
Use the Layout window’s scene pop-up
menu to navigate to the shared scene.

1 Choose Untitled Shared Scene from the
scene pop-up menu.

Slide Show 1 pict
=———— | Stide Show 2piet
Slide Show T pict
Slide Show 4 pict

Mew Scene

Choose Untitled Shared Scene in the Layout window's
scene pop-up menu

2 The Layout window updates to show the
shared scene, which is currently just a
black background as shown below.

The Layout window updates to show the shared scene,
which is a black background
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Add a new graphic element

Now we’ll add a new graphic element to the
shared scene. This graphic will eventually be
programmed to act as our forward button for
controlling the slideshow.

1 If the Tool palette is not already visible,
select Tool Palette from the View menu.
The Tool palette appears.

2 Click the Graphic tool in the Tool palette
as shown below.

e (=)

3 Drag the cursor somewhere inside the Lay-
out window and click and drag to create a
new graphic element on the shared scene.
The size and position of the element are
not important.

b crannic

Create a new graphic element on the shared scene by
dragging the cursor anywhere in the Layout window
with the Graphic tool selected
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4 Choose Link Media - File from the File Precise placement of elements
menu. A file selection dialog box appears. Now we’ll use the Object Info palette to

5 In the file dialog box, choose the file precisely position the arrow.

arrowright.pict from the Slideshow PICTs
folder, found inside the QuickStart folder.
Click Link to link the picture to the
graphic element.

1 If the Object Info palette (shown below)
is not already visible, choose Object Info
Palette from the View menu. The Object
Info palette appears. This palette shows

. P sizing and position information for the
%ﬂrruwleﬁ.pict =] currently selected object.
arrowright.pict
i A _DESktDD . . .
) %:::ﬂi::g: et (peskeop 2 Click the arrowright.pict element to
! g Slide Show 2.pict [(Done_J select it.
Slide Show 4.pict [ﬁ
= Link ces .
TT— | 3 The element’s name, position, and size
ow Freview

information are displayed in the Object
Choose arrowright.pict from the Slideshow PICTs Info palette.

folder and link it to the graphic element .
4 In the Object Info palette’s X field, enter

6 The element updates and resizes to show 500. Press the Return key to confirm the
its new contents. The element’s name change. The arrowright.pict element moves
changes to arrowright.pict as shown below. to its new location.

5 In the Object Info palette’s Y field, enter
375. Press the Return key to confirm the
change. The arrowright.pict element moves
to its new location. It should now be in
the bottom right corner of the scene. The

The element can be dragged to any loca- Obiject Info palette should look like the

tion in the Layout window to position it one shown below.

within the scene. Elements can also be

positioned precisely using the Object

Info palette.

rowright pict [ w500 [ w:fis0 | wloooo] cea:[ |6

titled Shared Scene  ¥:[575 | W:[Tos | wwm[to0o0] Lawelt (3]

The Object Info palette updated with the new position
information for arrowright.pict
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Run the project Modify the Appearance of the Arrow
Switch to run-time mode to see the effects of Element

our latest addition.
The arrowright.pict element would look bet-

1 Press 38 -T to switch to run-time mode. The ter if its black background were transparent.
first scene appears with the arrow picture The Graphic modifier can be used to alter the
superimposed on it as shown below. appearance of the element.

1 If the Effects modifier palette (shown
below) is not already visible, choose
Modifier Palettes > Effects from
the View menu. The Effects modifier
palette appears.

H
5 |

ke

The arrow picture is superimposed on the first scene

u A
Rl B ES R e

2 Drag a Graphic modifier from the Effects

2 Press 36-T again to return to edit mode. ) )
modifier palette and drop it on the

There is no interactivity in our project yet, arrowright.pict element. The Graphic
and our arrow button could probably look modifier icon attaches itself to the upper
better. We’ll address these problems in the left corner of the element as shown below.

next few steps. i

The Graphic modifier icon

T
Graphic modifier attached to the arrowright.pict element
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3 Double-click the Graphic modifier icon on
the element. The Graphic Modifier’s con-
figuration dialog box appears. This dialog
box can be used to customize the Graphic
modifier.

4 Choose the name of the modifier (the top-
most text field in the modifier which reads
“Graphic Modifier”) and change it to
Background Matte.

5 In the Specifications section of the dialog
box, use the Ink pop-up menu to select
the Background Matte effect. This effect
will make the element’s background invisi-
ble and insensitive to end user mouse clicks.

6 The Graphic Modifier dialog box should
now look like the one shown below.

Graphic Modifie

i Background Matte

Apply Ywhen : Remove Yhen:

IParent Enabled | E INone | E

Specifications

Ink :
Eackaround Matte E !‘

Shape :

| Prerra— 2 N P

7 There is one final change to make. We
need to specify which background color is
transparent.

QuickStart Tutorial — A Simple Slideshow ™

There are two small color swatches next
to the Ink pop-up menu. Click and hold
the rightmost color swatch until a palette
appears (as shown in the next figure). Drag
the pointer to the black color square (the
rightmost color in the lowest row of the
palette) and release the mouse button.

Graphic Modifier :

i [Frackaround Matte

Apply hen: Remove then:

[Farent Enabled | [=] [ere 11

Shape:

Specifications
Ink:

Background Matte || 7|
Fectangle I

Choose the black color swatch from the palette in the
Ink pop-up menu of the Graphic Modifier dialog box

Alternatively, you can continue dragging
the pointer past the palette. When off of
the palette, the pointer changes to an eye-
dropper. Drag the eyedropper to the back-
ground of the arrowright.pict element and
release the mouse button. The black back-
ground color will be picked up by the eye-
dropper.

8 Close the Graphic Modifier dialog box by

clicking its close box.
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Observe the Effect Program the Arrow to Trigger a
1 Observe the effect of the modifier by Scene Change
switching to run-time mode (press 36-T).
The background of the arrow should now Now that our arrow button looks good, it’s
be transparent so the scene appears as time to program some interactivity. We want

the arrow to cause a scene change when it is

clicked by the end user. mTropolis provides a
modifier just for this purpose — the Change

Scene modifier.

shown below.

1 If the Logic modifier palette is not already

visible, choose Modifier Palettes > Logic
from the View menu. The Logic modifier
palette appears.

ke

Switch to run-time mode (38 -T) to observe the effect
of the modifier

2 Press 3 -T to return to edit mode.

ECENAERERERE

TEEEE

The Lagic modifier palette

2 Drag a Change Scene modifier from the
Logic modifier palette and drop it on the
arrowright.pict element.

The Change Scene madifier icon
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The Change Scene madifier icon and the Change Scene
modifier applied to the arrowright.pict element

3 Double-click the Change Scene modifier
icon on the arrowright.pict element to
display its configuration dialog box.

4 Change the modifier's name from Change
Scene modifier to Change to Next.

5 The default for the Execute When pop-up
menu is Mouse Up. That is, this modifier
will execute when an end user clicks the ele-
ment. We don't need to change this value.

6 We don’t need to make any changes to the
Specifications section of the dialog box,
either. By default, the modifier is config-
ured to change to the next scene in the
subsection.

7 The dialog box should now look like the
one shown below.

= Change Scene Modifier =

Execute When
=
— Specifications

@ Nexct scene in subsection

O Previous seene in subsection
) Specify Seene:

B
[ #dd to destination scene
[ add to return tist

D Wrap around

The Change Scene Modifier dialog box, properly
configured for the arrowright.pict element

QuickStart Tutorial — A Simple Slideshow ™

8 Click OK to dismiss the dialog box.

Run the project
With the addition of the Scene Change modi-
fier, we’ve enabled some simple interactivity.

1 Press #-T to switch to run-time mode.

2 Notice that the cursor changes when it is
over the arrow button, indicating that it
can be clicked.

3 Click the arrow button to change to the
next scene. Repeated clicks cause the scene
to change until the last scene is displayed.

4 Press 3-T to return to edit mode.

Now is a good time to save your project by
choosing Save or Save As from the File menu.

Add a Back Button

Our project lets end users flip forward through
the slideshow, but there’s no way for them to
go back to previously viewed images. Let’s add
a back button.

1 Click the arrowright.pict element to
select it.

2 Choose Duplicate from the Edit menu. A
copy of the element appears.

3 Use the Object Info palette to reposition
this element. Enter 0 in the X field of the
Obiject Info palette. Enter 375 in the Y
field. The element should move to the
lower left corner of the scene.

4 Choose Link Media — File from the File
menu. A file selection dialog box appears.

mTropolis Developer Guide_% 6.13



B QuickStart Tutorial — A Simple Slideshow

5 In the file dialog box, select the file 3 In the Specifications section, click the

arrowleft.pict from the Slideshow Previous scene in subsection button.
PICTs folder, found inside the Quick- The dialog box should look like the one
Start folder. Click Link to link the pic- shown below.

ture to the element.

= Change Scene Modifier =

>

previ & Slideshow PICTs | 2 scipio gcm :‘::n oo

review H
Farmowiertpic g rra—
TR arrowright.pict —— Specifications
g Slide Show 1.pict i) Mezct scene in subsection

- g Slide Show 2.pict @ Frevious scene in subsection
13 slide Show 3.pict O specify Soene:
slide Show 4.pict [ontitegsection (4]

cfff ST

[ Show Preview

Untitled Shared Scene

[ &dd to destination scene

Choose the arrowleft.pict from the Slideshow PICTs [ e o return Tist
folder. Click Link to link the picture to the element Dlwrap around

Now we need to adjust the programming of

the left arrow’s Change Scene modifier so that Thef(:hal;y: .S;;ene Mt;dgle‘r;ﬁa//og bOTX’ properly
it steps to the previous scene instead of the ConIgUrea for the arrowiett pict eiemen
next scene.

4 Click OK to close the dialog box.
1 Double-click the Change Scene modifier

icon on the arrowleft.pict element. The Run the project )

Change Scene Modifier dialog box Now end users can navigate both forward

appears and backward through the slideshow. Let’s
' try it out!

2 Change the modifier’s name from Change
to Next to Change to Previous. 1 Press 36 -T to switch to run-time mode.

2 Click the right arrow button to move for-
ward through the scenes.

3 Click the left arrow button to move back-
ward through the scenes.

4 Press 3 -T to return to edit mode.

6.14 %_mTropolis Developer Guide



Click the arrow buttons to navigate
backward through the slideshow

Add Scene Transition Effects

As a final enhancement to our slideshow,
we’ll add some scene transition effects. The
mTropolis Scene Transition modifiers can be
used to add special effects such as fades and

wipes to scene changes.

1 Use the scene pop-up menu or right
scene navigation arrow found at the top
of the Layout window to display the Slide

Show 1.pict scene.

2 Drag a Scene Transition modifier from the
Effects palette and drop it on the scene.
The modifier attaches itself to the top left

corner of the scene.

The Scene Transition modifier icon

j=y

QuickStart Tutorial — A Simple Slideshow W

3 Double-click the Scene Transition modifier
icon to display its configuration dialog box.

4 Change the modifier’s name from Scene
Transition Modifier to Dissolve.

5 Use the Transition pop-up menu to select
the Random Dissolve effect. The dialog
box should look like the one shown below.

=—— Scene Transition Modifier

Enable When Dizable When:
IScene Started | E INone | E

Specifications
Transition: Steps:

Fandm bisse (=] = 1(3)

Direction: Rate:

oo [3)

The Scene Transition Modifier dialog box, properly
configured for a dissolve effect

6 Click OK to dismiss the dialog box.

Copy the Scene Transition modifier to each scene
Now let’s use the structure view to copy

the Scene Transition modifier to the other
three scenes.

1 While the Scene Transition modifier is
still selected, choose Copy from the
Edit menu (38-2).

2 Choose Structure Window from the
View menu to display the structure view
of our project.
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3 In the Structure window, select the three
scenes to which we want to copy the Scene
Transition modifier. Hold the Shift key
while clicking the icons for Slide Show
2.pict, Slide Show 3.pict, and Slide Show
4.pict. All three scenes should be high-
lighted as shown below.

0 == My Slide Show: Structure = [ 5
= IR M stide show =
= [ untitled Section
- [[g Untitled Subsection
B E Untitled Shared Scene
[ EH stide Show 1 pist

= Jsvide
S T :
ENim} DEZ

Hold Shift while clicking the second, third, and fourth
scenes to select all three

4 Choose Paste from the Edit menu. A new
copy of the Scene Transition modifier will
be pasted on each selected scene.

Run the project

Now each scene fades in with a nice dissolve
effect instead of the abrupt change we saw
before.

1 Press 38-T to switch to run-time mode.

2 Click the buttons to move through the
images in the slideshow. Each scene dis-
solves into the next.

3 Press 3 -T to return to edit mode.

That's all there is to creating a simple slideshow
presentation with mTropolis! Don’t forget to
save your work.
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Troubleshooting

If you have difficulty completing this tutorial,
you might want to examine a finished version.
Choose Open from the File menu and select the
project file Completed Slideshow found in the
QuickStart folder. The Completed Slideshow
Layout and Structure window will appear.

The Advanced Slideshow

It takes only a little more effort to add sound,
motion, and more elaborate effects to the
slideshow. The Advanced Slideshow project,
found in the QuickStart folder, contains an
expanded version of the simple slideshow
tutorial. Open this project in mTropolis and
press 36-T to run it.

Notice that the arrow buttons move and make
a sound when they are clicked. Examining the
buttons in edit mode (they are located on the

Untitled Shared Scene) shows that they con-
tain sophisticated behaviors that control their
actions.

Examining this project may give you ideas
about enhancements you can make to your
own slideshow.



More Tutorials

The next chapter, “In-Depth Tutorial —
mPuzzle” contains another, more challenging
mTropolis tutorial. The mPuzzle tutorial may
take several hours to complete, but it demon-
strates many more mTropolis programming
concepts. It contains examples of creating
behaviors, using aliased modifiers, writing
Miniscript code, and using animation files.

Chapter 8, “Network Tutorial — Avatar Chat,”
is another challenging tutorial that shows
how to use mTropolis to create an application
that allows end users to send chat messages to
each other over a network.

QuickStart Tutorial — A Simple Slideshow W
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In-Depth Tutorial —
mPuzzle

This tutorial provides a more detailed introduction
to mTropolis. In this tutorial, you'll create a
multimedia puzzle. The process of authoring in
mTropolis is demonstrated step-by-step, beginning
with adding media to the first scene. This tutorial
shows how to integrate QuickTime movies, anima-

tions, and sound in a multiple scene project.



What You'll Need

You'll need the following things before starting
this tutorial.

e mTropolis must be installed on your machine.
Installation instructions are in the “Read Me
First!” file on the mTropolis CD-ROM.

e The tutorial files are installed by default
when mTropolis is installed. Tutorial files
are in the Tutorials folder of the mTropolis
installation. If the tutorial files have not
been installed, install by running the
installer from the mTropolis CD-ROM,
or drag the Tutorials folder from the CD
to your hard disk.

¢ This project uses 8-bit media. For best per-
formance, make sure your monitor is set to
display 256 colors.

Tutorial project description
Let’s begin by looking at the completed
puzzle project.

1 Open the completed tutorial project in
mTropolis by dragging the Completed Tuto-
rial icon, found in the In-Depth folder (con-
tained in the Tutorials folder), over the
mTropolis icon. If you have multiple ver-
sions of mTropolis installed (for example,
both the 68K and PPC versions), be sure to
choose the correct one for your machine.

2 The project is shown in edit mode, where
changes can be made to the project. To
view the project as an end user would see
it, press 36-T to switch to run-time mode.
The project will run from its first scene.

In-Depth Tutorial — mPuzzle ®

The first scene of the project shows a
QuickTime movie of the mFactory “M” logo
being drawn on a napkin. When the movie
finishes playing, a new scene appears.

The second scene shows pieces of a puzzle
spread randomly about the screen. The pieces
can be dragged around the screen. If a piece is
dropped near its correct position on the back-
drop, it snaps into place with an audible clang.
The pieces form a machine that looks like the
mPFactory logo. When all the pieces are in their
proper places, the “M” machine springs to life
as a series of animations on different parts of
the “M” begin to play.

When finished with the puzzle, click the man-
hole icon in the lower right corner of the screen
to jump to a credits scene. When the credits
finish, the project ends and mTropolis returns
to edit mode.

Solving the mPuzzle tutorial
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Start a New Project

When you are finished exploring the com-
pleted puzzle, close the finished tutorial pro-
ject by choosing Close from the mTropolis
File menu. If you are prompted to save any
changes, click the Don’t Save button. The
tutorial’s Layout window will disappear.

Now we'll recreate the puzzle project. Start a
new project by choosing New - Project from
the File menu. A new, empty project appears.
This project contains an empty section, subsec-
tion, and scene. The empty scene is displayed
in the layout view.

Create the First Scene

In the first part of this tutorial, we’ll begin by
adding media to the scene.

Adding the background image
Let’s add the background image for the logo
movie that plays when the project is first run.

1 Click the Untitled Scene (inside the large
white region in the Layout window) to
select it.

2 Choose Link Media — File from the File
menu. A standard dialog box appears as
shown below.

G PICTs % = Scipio
& mBackground.pict =
& mPiece 1.pict

- |T& Napkin.pict
Update -] tink ]

b4 Show Preview

Preview

» S

Choose the Napkin.pict image and click the Link button
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3 Choose the image named Napkin.pict
from the PICTs folder, found inside the
Media folder (located in the In-Depth
subfolder of the Tutorials folder) and
click the Link button.

4 An alert appears, warning that this 8-bit
image uses a custom color table and may
not appear as expected. Click OK to dis-
miss the dialog box. In the next step, we'll
link the image’s color table to the project
so our images will display properly.

5 The Napkin.pict image fills the scene.

Using a Custom Color Palette

The project we are creating was designed to run
on 256-color displays. The graphics for this pro-
ject were rendered using a custom color palette.
The color palette has been saved as a CLUT file
that we can import into our project.

1 Ensure that the Effects Modifier palette is
visible. To do this, choose the View menu
and look at the Modifier palette’s cascad-
ing menu item. If there is a check mark
next to Effects, that palette is already visi-
ble. If there is not a check mark, choose the
Effects menu item to display the palette.

2 Drag a Color Table modifier from this
palette and drop it on the scene (the back-
ground Napkin.pict element). The Color
Table modifier attaches itself to the upper
left corner of the scene.

The Color Table modifier icon



3 Double-click the Color Table modifier on
the scene to open its dialog box.

4 The highlighted text at the top of the
Modifier dialog box is the default name
of this modifier. Rename the modifier
mTutorial.clut . It’s a good authoring
habit to give your modifiers unique and
descriptive names.

5 From the Color Table pop-up menu, choose
the Link file option. A standard dialog box
appears. Choose the mTutorial.clut file
(Media folder - CLUTs folder).

6 Your Color Table Modifier dialog box
should now look like the one shown
below. Click the OK button to dismiss
the Color Table Modifier dialog box.

= Color Table Modifier =

E mTutorial.clut

Apply When:

[Scene Started E

Specifications
Color Table:

Err—

Color Table Modifier dialog box

7 To view the effect of a color table that has
been applied to a scene while in edit mode,
choose mTutorial.clut from the Preview
Color Table cascading menu option, found
in the View menu. The screen updates to
reflect the new color palette.

In-Depth Tutorial — mPuzzle ®

Add the logo movie
Now let’s put the logo QuickTime movie on

top of this background image. First we’ll create
an element to contain the QuickTime movie.

1 Select the Graphic Element tool (the
box-shaped tool) in the Tool palette.

e
l.fjfmi

The Graph/'c Element tool

2 Drag anywhere on the scene to create an

empty graphic element of any size.

3 Select the new element and choose Link
Media - File from the File menu. A
standard dialog box appears.

4 Choose the file named mSketch.MooV
in the MOOVs folder, found inside the
Media folder.

If the Application preferences (Edit > Pref-

erences > mTropolis) are still set to their
defaults, the element will resize automati-
cally to the size of the QuickTime movie.
However, if it doesn’t resize automatically,
choose the element and then Revert Size
from the Object menu.
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The Layout window should look similar to
the one shown below.

Layout window

Position the movie

Let’s position the QuickTime element
(mSketch.MooV) precisely using the Object
Info palette.

1 If the Object Info palette (shown below)
is not already visible, choose Object Info
Palette from the View menu. The Object
Info Palette appears. This palette shows
sizing and position information for the
currently selected object.

2 Select the mSketch.MooV element, and
enter 167 in the “X” field and 64 in the
“Y"” field. Use the Tab key to jump between
fields and the Enter key to confirm the
final data entry.

Object Info palette used to position mSketch.Moov
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Test the project

So far, we’ve worked on the project in edit mode.
We can switch to run-time mode to view the pro-
ject as an end user would see it. Press 36-T to
run the project. The screen should go black,
then the napkin picture should appear and the
QuickTime movie should play over the top of it.
To switch back to edit mode, press 36-T again.

=

Switch to run-time mode to play the QuickTime movie

Changing an element'’s properties

For the most part, the QuickTime movie ele-
ment behaves just as we want it to — it plays
through one time, then stops. The element can
be customized in a number of ways through its
Element Info dialog box. Next we'll use the
movie’s Element Info dialog box to adjust the
movie’s volume.

1 Double-click the mSketch.MooV element
to open its Element Info dialog box, or
display the dialog box by selecting the
mSketch.MooV element and then choos-
ing Element Info from the Object menu.



2 In the Flement Info dialog box, change
the value of the Volume setting to 80. Now
when the project is played, the volume of
the movie will be 80% of its maximum vol-
ume. The Element Info dialog box should
look similar to the one shown below.

Element Info

Bl [rsketeh Hoov

Source File Path
Secipio Keith's mFactory Docs :Tutorials:in-Depth:
Media MO0Ys :mSketch. Mool

— Initial State
D Hidden D Loop Yolurne :

D Pauzed D Back and forth @

— Dptions .\‘

DP]ag every frame FRale: Layer:

D Cache bitmap EI @ fps I:I @

E [rirect to screen D Convert text to bitmap

Configuring the movie's Element Info dialog box

3 Click OK to accept this change and
dismiss the Element Info dialog box.

4 Run the project again by pressing 36 -T.
Press 36-T again to return to edit mode.

Saving the project
Now would be a good time to save your work.

1 Choose Save from the File menu (38 -S).

2 Enter in-depth project in the Save File
As field and store the project as you would
any other file.

3 If at any point you want to restore the
project to a previously-saved version,
choose Open from the File menu to
load the saved file.

4 Notice that the title of your Layout win-
dow changes to reflect the new name of
your project.

In-Depth Tutorial — mPuzzle ®

Using a modifier to change the scene

When the movie is finished playing, we want
our project to continue to the next scene. The
Change Scene modifier can be used to add this
type of functionality to our project. We'll also
configure our introductory scene so that if the
end user clicks before the movie is done, the
scene will change.

1 Ensure that the Logic Modifier palette is
visible. To do this, choose View - Modifier
Palettes. If there is a check mark next to
Logic, that palette is already visible. If there
is not a check mark, choose the Logic menu
item to display the palette.

]
in
I |

I~ 1

The Lagic Modifier palette

2 Drag a Change Scene modifier from the
Logic Modifier palette and drop it on
the movie element. The modifier icon
attaches itself to the upper left corner of
the mSketch.Moov element.

The Change Scene modifier icon
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3 Double-click the modifier icon to display
its configuration dialog box.

4 Change the name of this modifier. Change
the text of the modifier’s name field (which
currently reads Change Scene Modifier) to
To Next Scene.

Note: When naming modifiers in your
own projects, use concise, descriptive
names that relate to the function of
the modifier.

Now use the Execute When pop-up menu
to specify the message that will activate
this modifier.

5 Open the Execute When pop-up menu and
choose Play Control - At Last Cel. Now
when the movie ends, a scene change will
occur. The Change Scene Modifier dialog
box should look like the one shown below.

= Change Scene Modifier

To Mext Scene

Excecute when:

it Last Cel =

— Specifications
@) Next scene in subsection
Q) Previous scene in subsection
O Specify Scene:

D Add to destination seens
[ add ta return tist
D Wiap around

A Change Scene Modifier dialog box configured to
execute on the At Last Cel message

The Specifications area of the Change
Scene Modifier dialog box is used to choose
the destination scene to which you want
to change. Since we want to change to the
next scene, and this is the default setting,
we won't change it.
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6 Accept the changes to the modifier by
clicking the OK button. The Change
Scene Modifier dialog box disappears.

Now let’s create a Change Scene modifier
that changes to the next scene if the end
user clicks the screen while the introduction
is still playing.

1 Select the Change Scene modifier on the
mSketch.MooV element and press 36-D to
duplicate it. A new Change Scene modifier
icon appears next to the previously-created
one. Drag the new copy from the movie
element and drop it on the scene (that is,
drop the modifier outside the bounds of the
mSketch.Moov element so that it attaches
to the Napkin.pict element).

2 Double-click the new Change Scene icon
to display its configuration dialog box.

3 From the Execute When pop-up menu,
choose Mouse - Mouse Up. Now this
modifier will activate when the end user
clicks the scene. Your new Change Scene
dialog box should look like the one shown
below.

= Change Scene Modifier =

To Mext Scene

Execute When:
=]
— Specifications

@ Mext scene in subsection

O Prewious scene in subsection
o] Specify Scene:

D #dd to destination scene
1 add to return tist
D Wwirap around

A Change Scene Modifier dialog box configured to
execute on Mouse Up



4 Click OK to accept the change. The dialog
box disappears.

The Layout window should now look simi-
lar to the one shown below. We are now
ready to create the next scene in the project.

mSketeh MeaY. )

Napkinpict © {+]

I 0P

The Layout window showing our first scene

Create a new scene

To create a new scene in the layout view, use the

third pop-up menu on the right at the top of the
window (where it now reads Napkin.pict). The

pop-up menu lists all scenes in the current sub-
section and a New Scene option that can be used
to create new scenes. New Scene always appears

as the last item in this pop-up menu.
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1 Choose New Scene from the Scene pop-up
menu as shown in the image below. A new,
empty scene (named Untitled Scene) is cre-
ated. The Layout window changes to dis-
play this new scene.

L led Section - Untitled Subsection vI

e
o §

Untitled Shared Soene
+ Napkin pict

Choose New Scene from the scene pop-up menu
Let’s link a background image to this new scene.

1 Click the Untitled Scene to choose it.

2 Choose the Link Media — File option
from the File menu. A standard dialog
box appears.

3 Choose the mBackground.pict file from
the PICTs folder within the Media folder.

G PICTs | % = Scipio
& mBackground.pict [~

& Napkin.pict

g BTN

Y
B4 Show Preview

Preview

Link the mBackground.pict image to the new scene

4 The custom color table alert appears again.
Click Don’t Warn Again to dismiss the
alert. It will not appear again while we’re
working on this project. Since we're already
viewing the correct color palette for this
image, the image will appear correctly.
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5 The mBackground.pict file fills the scene
as shown in the image below. Note also
that the name of our new scene changes
to mBackground.pict.

The new scene linked to the mBackground.pict image

Let’s see the effect of adding this scene.

1 Return to the previous scene by using the
Scene pop-up menu to choose Napkin.pict,
or click once on the left scene navigation
arrow at the top of the Layout window.

2 Now run the project (press 36-T) and view
the changes. Notice that when the movie
ends, or when you click the first scene, the
scene changes to the next scene. Press 36-T
again to return to edit mode.

3 The Layout window reappears, showing
the Napkin.pict scene.

Adding a scene transition

When the scene changes, it simply jumps
from the first scene to the next without any
sort of transition effect. Let’s create one.
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1 Drag a Scene Transition modifier from the
Effects modifier palette and drop it on the
Napkin.pict scene.

The Scene Transition modifier

2 Double-click the modifier to display its
configuration dialog box.

3 Change its name from Scene Transition
modifier to Random Dissolve

4 Choose Scene > Scene Ended from the
Enable When pop-up menu.

5 Choose Random Dissolve from the Tran-
sition pop-up menu.

6 Set the value of the Rate option to 30.
The dialog box should look like the one
shown below.

=—— Scene Transition Modifier

Enable “When : [Dizable %When:
|Scene Ended | E |None | E

Specifications
Transition : Steps:

andon bisse (=] = 1[3)

Direction: Rate:

Scene Transition Modifier dialog box

7 Click the OK button to close the Scene
Transition Modifier dialog box. The dia-
log box disappears.

Press 38-T to run the project. Notice that when
the scene changes, the first scene appears to dis-
solve into the next. Press 38 -T again to return
to edit mode.



Programming the Second Scene

Now let’s add the components that make up
the second scene.

In this scene, we will build a reasonably com-
plex puzzle using animated elements as the
puzzle pieces. The puzzle pieces will be drag-
gable by the end user and programmed to snap
into place if they are within a 15 pixel radius
of their destination coordinates. Once they are
in place, the pieces are no longer draggable.
When all of the puzzle pieces are in place, they
become animated.

Adding a puzzle piece to the scene

Navigate to the second scene by choosing
mBackground.pict from the Scene pop-up
menu (the third pop-up menu from the right
at the top of the Layout window) or click the
right scene navigation arrow (also found at
the top of the Layout window).

In this section, we’ll use the Asset Palette to
manipulate media that has been linked to
the project.

1 Choose Asset Palette from the View menu.

The Asset palette appears as shown below.
This palette shows thumbnail images of

all of the media assets currently linked to
the project.

E Show:| Al ‘I Wiew By:|_Large Thumbnail » | Sort By Link Order hd

-

Jmm
Jam
JuW

FICT [Color Table Quick Time
[Napkin.pict rmTutorial.clut rmSketch Maok

The Asset Palette

& 4]
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Previously, we had linked media directly to
graphic elements in the project. Now, how-
ever, we will import media without having an
element selected. The media will be linked to
the project, but won't appear in the Layout
window — they will only be added to the
Asset palette.

Link all the media files contained in a direc-
tory to the project.

2 Choose Link Media > Folder from the
File menu. A standard dialog box appears.
Choose the mTOONsS folder found within
the Media folder. Click the button at the
bottom of the folder selection dialog box
when the name mTOONSs appears in that
button as shown below.

Select Folder:
& Scipio

A as B
0§ auts
& moovs
CImTo0Ns ] | e
Qias

~ Open “
( “mTOONs” |

;

Linking an entire folder of media to the project

The Asset palette now contains thumbnails
for seven new assets. The media assets on the
Asset palette can be dragged from the palette
and dropped on our project. Let’s add one of
the puzzle pieces to the Layout window.
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3 Drag the mToon element named mPiece
2.mToon from the Asset palette and drop it
on the mBackground.pict scene. The Layout
window should look similar to the one
shown below.

Drag the mPieceZ.toon from the Asset palette and drop
it on the scene

Programming the first puzzle piece

Since all of our puzzle pieces need to behave
in a similar fashion, we will program one ele-
ment first and then create an alias of that pro-
gramming that we can copy to all the other
puzzle pieces.

Aliasing requires additional explanation. To
program the puzzle, we are going to create
a single behavior that can be used on all of
the puzzle pieces. We will alias this behavior
so that updates made to one copy are made
simultaneously to all of the copies on the
other puzzle pieces.
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Creating the puzzle piece behavior

Let’s begin programming the first puzzle
piece by adding modifiers to it. The first
type of modifier we’ll add is a Behavior.

1 Drag a Behavior modifier from the Logic
modifier palette and drop it onto the puz-
zle piece mPiece 2.mToon in the Layout
window. The Behavior modifier is a special
modifier that can contain other modifiers.

The Behavior modifier icon

2 Double-click the Behavior modifier to
display its configuration dialog box.

3 Change the name of the Behavior from
Behavior to Puzzle Piece. Do not close
the Behavior dialog box.

Making the puzzle piece transparent
Now let’s add the programming that will make
the piece transparent to the background.

1 Drag a Graphic modifier from the Effects
Modifier palette and drop it in the open
Behavior window.

2 Double-click the Graphic modifier to
open its configuration dialog box.

3 Change the Graphic modifier’s name
from Graphic modifier to Background
Matte . Its purpose is to apply a back-
ground matte effect to the element
with which it is associated.



4 Use the Ink pop-up menu to choose Back-
ground Matte. The dialog box should
look like the one shown below.

Graphic Modifier

i ackground Matte

apply “when : Remowve When:

IParent Enabled | E INone | E

Specifications

Inks
ackground Fatte E E

Shape:

eerrr—(k L

The Graphic Modifier configuration dialog box,
configured to apply the Background Matte ink

5 Close the Graphic Modifier dialog box (by
clicking its Close box) to accept the change.

The Behavior window should now look
like the one shown below.

0 =——=Mv mPuzile: Behavior =—— 01 B
Enable when: Disable when :
|Parent Enabled | w:j |None
a
Farent Enabled J =
i S}
Eackground Matte
-|
[T ]~

The Puzzle Piece Behavior configuration dialog box
containing the Background Matte Graphic modifier

Making the puzzle piece draggable

By adding another modifier to the behavior,
we can make the puzzle piece draggable by
the end user.

In-Depth Tutorial — mPuzzle ®

1 Drag a Drag Motion modifier from the
Effects Modifier palette and drop it on
the Puzzle Piece behavior window.

5 |

The Drag Motion modifier icon

Since we're using just one Drag Motion
modifier, we'll use its default name. No
special configuration of this modifier is
necessary at this point. Your Puzzle Piece
Behavior window should look like the
one shown below.

0 =———= My mPuzzle: Behavior EE
Enable when: Disable when:
IParent Enabled | Wié INone |
-
Parent Enabled l =
|~ I 5|
(22
Background Matte
Dr-ag Motion Modifier
-
4|l | ¥ ]z

Puzzle Piece behavior window

2 Close the Puzzle Piece behavior window
by clicking its Close box.

3 Use 38 -T to switch to run-time mode
and try dragging the puzzle piece around.
Note that the animation will be running,
but we'll pause it in the next few steps.
When finished, press 3-T again to return
to edit mode.

Changing other aspects of the Puzzle Piece
Behavior

Since these elements are reasonably small
animation files, and we want good playback
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performance, we will preload them into RAM.
This can be accomplished by sending the
puzzle piece a Preload Media command.

1 Re-open the Puzzle Piece behavior by
double-clicking its icon.

2 Drag a Messenger modifier from the Logic
Modifier palette and drop it in the Puzzle
Piece behavior window.

The Messenger madifier icon

3 Double-click the Messenger modifier icon
to display the configuration dialog box.

4 Change the name of the messenger from
Messenger to Preload.

5 Use the messenger’s Execute When pop-up
menu to choose Scene — Scene Started.

6 In the messenger’s Message Specifications
section, use the Message/Command pop-
up menu to choose the Element > Pre-
load Media command.

7 No changes need to be made to the With
and Destination menus. The dialog box
should look like the one shown below.

Messenger

<

Execute When:

Scene Started E

Message Specifications

Meszage /Command : “with:

|Pre]oad Media | |z| |None | |z|
Crestination :
=l

Configuring a Messenger modifier to preload the
element’s media
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8 Click OK to accept the changes. The
Messenger dialog box disappears.

By default, the puzzle piece animations play
when the scene starts. However, we want the
animations to pause until the puzzle is com-
plete. This can be done by sending a Pause
command to the puzzle piece.

1 Drag another Messenger modifier from
the Logic Modifier palette and drop it in
the Puzzle Piece behavior window.

2 Double-click the Messenger modifier icon
to display its configuration dialog box.

3 Change its name to Pause.

4 Use the messenger’s Execute When pop-
up menu to select the Parent > Parent
Enabled option.

5 Use the messenger’s Message/Command
pop-up menu to select the Play Control -
Pause option.

6 Leave the Destination of the message as
Element (this is the default destination).
The With pop-up menu should also remain
at the default. The dialog box should look
like the one shown below.

Messenger

Execute When:

Farent Enabled E

Message Specifications
Meszage /Command : “with:

|Pause | E [Hone | |Z|

Destination:

Er—

Configuring a Messenger modifier to pause the
element's media




7 Click OK to accept the changes and dismiss
the Messenger dialog box.

8 Your Puzzle Piece behavior window should
look like the one shown below.

[0 =————— My mPuzzle:Puzzle iece =———FEIB
Dlswiehasie
Enable when: Drizable when:
[Parrent Enabled |z e
-
Parent Enabled =
Seene Started —
Preload Media
Pauge
Ho I
ackground Matte
Drag Mation Modifier 3
e Ee
Preload Fause
-|
<[l D2

Puzzle Piece behavior window

9 Click the behavior’s Close box to dismiss
the Puzzle Piece behavior window.

n Note: The animation could also have

been paused by setting the element’s
paused attribute via the Element Info
dialog box. However, by using a mes-
senger to pause the animation and
placing that messenger in a behavior
that will be used on all the other puzzle
pieces, we have eliminated the need to
manually set the paused attribute for
each puzzle piece.

Adding the puzzle snap-in function

Let’s now program the snap-in functionality
of the puzzle piece. First, we need to store the
screen coordinates of the correct position of
the puzzle piece. We can use a Point Variable to
store this value. Since every puzzle piece will
use the same (aliased) behavior, but will each
have different final screen positions, the vari-
able that contains each piece’s x and y coordi-
nates must be placed outside the behavior.

In-Depth Tutorial — mPuzzle ®

Positioning variables this way allows variables
of the same name to contain different values.
The modifiers that access them from within
aliased behaviors will use the correct variable
for each element.

Let’s add a Point Variable modifier to the
mPiece 2.mToon puzzle piece.

1 Drag a Point Variable modifier from the
Logic Modifier palette and drop it on the
mPiece 2.toon puzzle element.

The Point Variable modifier icon

2 Double-click the Point Variable icon to
display its configuration dialog box.

3 Change the variable’s name from Point
Variable to piecePosition. Note there
are no spaces in that name!

4 Enter 167 into the modifier’s X field and
204 into the Y field. The dialog box should
look like the one shown below.

=— Point ¥ariable ==

Yalue

Wi i
fier (8 kos (3

Configuring the piecePosition Point Variable dialog box
for the mPieceZ.mToon element

5 Click OK to accept the changes and dismiss
the Point Variable dialog box.

Adding a Miniscript modifier to the behavior
The mTropolis Miniscript modifier is a spe-
cial modifier that can execute commands
written in a simple scripting language. This
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modifier allows you to create modifiers that
perform complex or customized tasks.

Here, we'll create a simple script that sets the
puzzle piece’s position to a random position
within the boundary of the screen.

1 Double-click the Puzzle Piece behavior
icon to open its window.

2 Drag a Miniscript modifier from the Logic
Modifier palette and drop it in the Puzzle
Piece Behavior window.

&l

The Miniscript modifier icon

3 Double-click the Miniscript modifier icon
to display its configuration dialog box.

4 Change the modifier’s name from Miniscript
Modifier to Random Position.

5 Use the Execute When pop-up menu to
choose Scene > Scene Started.

6 In the modifier’s Script text box, type the
following script:

-- Set the puzzle piece to a

-- random position:

-- set position to rnd(580),
rnd(420)
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Your Miniscript Modifier dialog box should
now look like the one shown below.

Miniscript Modifier

o
Execute When:

=

[ Seript
[-- Set the puzzle piece ta 2 -
|-~ random position

[z2t position to rnd(580), rrd(420)

Tl i

Writing the Random Position Miniscript modifier

The first three lines of our script are com-
ments — the two dashes that start each line
tell mTropolis to ignore any text that follows
on that line. Comments are not required for
the script to function properly, but make your
scripts easier to read and debug.

The last line is a Miniscript statement. It uses
the Miniscript function “rnd” to generate a
random number between 0 and the number in
parentheses for the x and y coordinates of the
element’s position. When activated, this script
will set the puzzle piece’s position to the ran-
dom values generated by the “rnd” function.

7 Click OK to accept these changes and dis-
miss the Miniscript Modifier dialog box.

Encapsulating the Modifiers into a Behavior

As good housekeeping, we'll encapsulate
some of the modifiers we have created into a
new behavior. Let’s group the modifiers that
set the initial characteristics of the puzzle
piece together.



1 Drag a new Behavior from the Logic
Modifier palette and drop it into the
open Puzzle Piece Behavior window.

The Behavior modifier icon

2 This time, instead of opening the behavior
to rename it, simply click the behavior’s
name shown below its icon, and enter the
new name, Initial Settings . Click
outside the name when you are through
editing the name.

3 Instead of opening the new behavior’s
dialog box, modifiers can be added to the
behavior simply by dragging and dropping
their icons on the new behavior’s icon. Drag
the following modifiers on the Initial Set-
tings behavior icon: the Graphic modifier
named Background Matte, the messenger
named Preload, the Miniscript named Ran-
dom Position, and the messenger named
Pause. The modifier icons seem to disappear
as they are moved into the new behavior.
The Puzzle Piece Behavior window should
now look like the one shown below.

[0 === My mPuzzle: Puzzle Piece =—"—=—H 8
Dlsvitentie
Enable when: Disable when :
[Farent Enabied i s Juone
-
Farent Enabled l —
E [4D]
Drag Motion Modifier
(2)
Initial Settings
-
] Dz

The Puzzle Piece Behavior window with Initial Settings
behavior added
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Configuring an If Messenger to test for the puzzle
piece position

Now let’s program an If Messenger to test for
the position of the puzzle piece. This modifier
will compare the position of the puzzle piece
to the value stored in the piecePosition Point
Variable whenever the end user drops the piece
at a new location. (We attached the variable to
the puzzle piece and assigned a value to the
variable earlier in this chapter.)

1 Drag an If Messenger from the Logic Mod-
ifier palette and drop it in the Puzzle Piece
Behavior window.

The If Messenger maodifier icon

2 Double-click the messenger’s icon to
display its configuration dialog box.

3 Change the name of the messenger
from If Messenger to Dropped in
Valid Position.

4 By default, this messenger is configured to
act on the Mouse Up message. This is what
we want, so we don't need to change the
Execute When pop-up menu.

5 In the If text field, replace the existing text
(“true”) with the following statement:
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position.x < (piecePosition.x + 15)
and \

position.x > (piecePosition.x - 15)
and \

position.y < (piecePosition.y + 15)
and\

position.y > (piecePosition.y - 15)

This statement evaluates to true when the
puzzle piece is released within 15 pixels of
the value stored in the piecePosition Point
Variable.

6 When these conditions are met, we want to
send a message to the element that it has
been released in the proper location. To do
this, we will create a custom message (an
author message). Highlight the content of
the Message/Command field (do not use
the pop-up button). Type Piece In Place
into the field. The dialog box should look
like the one shown below.

If Messenger

m ['ropped in Valid Position

Execute When:

=
If
position.s < (piecePasition.s + 15) and %
position.s > (piecePasition.s - 15) and
position.y < (piecePasition.y + 15) and %
position.y > (piecePasition.y -15)

D

{

qul C
— Message Specifications
Meszage /Command : “with:
|P1'ece in Place | |z| |None | |z|
Crestination :
=l

Configuring an If Messenger to detect when the element
is dropped in the correct location
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7 Click OK to save your changes to this
configuration dialog box. An alert appears,
asking if you want to create a new author
message. Click OK on this alert.

Programming the puzzle piece when it is in place
Now we are ready to program the actions of
the puzzle piece when it is dropped in place.
A behavior will be used to store the actions
that occur.

1 Drag a new Behavior modifier from the
Logic Modifier palette and drop it in the
Puzzle Piece Behavior window.

2 Click the name of the behavior that appears
below the icon and enter the new name,
Piece in Place . Click outside of the
name when you are done.

Next we'll configure the previously-created
Drag Motion modifier so that the puzzle piece
cannot be dragged once it is in place.

1 Drag the Drag Motion modifier icon from
its current position in the Puzzle Piece
window and drop it into the Piece in Place
Behavior.

2 Double-click the Piece in Place Behavior
icon to open its window.

3 In the Piece in Place window, double-click
the Drag Motion icon to display its config-
uration dialog box.



4 We want to disable this modifier when the
piece is put in its correct place. Use the Dis-
able When pop-up menu to choose Author
Messages > Piece in Place. The piece will
no longer be draggable after this message is
received. The dialog box should look like
the one shown below.

Drag Motion Modifier

|
Enable “When: Dizable 'when:
IParent Enabled | E IPiece in Place
Specifications
D Constrain to element's parent
— Margin of Constraint
Bottorn: Left:

Top: Fight :

EIBEJREIBE ]
Directional Constraint ——————

|E None O Horizantal O Wertical |

Configuring the Drag Motion Modifier dialog box to
disable on the Piece in Place message

o

5 Click OK to confirm your changes and dis-
miss the Drag Motion Modifier dialog box.

6 Move the Dropped in Valid Position If Mes-
senger you created previously from the Puz-
zle Piece Behavior into the Piece in Place
Behavior. Simply drag it from the Puzzle
Piece Behavior window and drop it in the
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Piece in Place Behavior window. Your Piece
in Place window should now look like the
one shown below.

[ =—— My mPuzzle: Piece in Place ——=FH B
Mswiahatie
Ensble when: Disable when
[Parent Enabied Ji2 [rone
-
Parent Enabled —
Piece in Place T =
Mouse Up .l
E (1 l
Drag Motion Modifier E(ZJ
Dropped in Yaid Fosition

S

K1

Piece in Place behavior

We now need to add a Miniscript modifier to
the Piece in Place behavior that moves the
piece to its final position when it is dropped
near, but not exactly on, the final position.

1 Drag a new Miniscript modifier from the
Logic palette and drop it into the Piece in
Place behavior.

2 Double-click the modifier to display its
configuration dialog box.

3 Name the new Miniscript modifier Piece
in Place.

4 Use the Execute When pop-up menu to
configure the modifier to activate when the
Piece in Place author message is received.
Choose the Author Messages > Piece in
Place option from the menu.
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5 In the Script text field, enter the following
script:

-- Snap piece into place:
set position to piecePosition
-- Change cel of toon:

set cel to 2

The dialog box should look like the one
shown below.

Miniscript Modifier

P rrr—

Execute When

Frece mpizee =]

i2ce into place: -
n to piecePosition

-~ Change cel of toon
setcelto 2

4]

A[ul [v

Writing the Piece in Place Miniscript

6 Click OK to close the Miniscript dialog
box. Your Piece in Place behavior should
look similar to the one shown below.

O =————MymPuzzie: Piece in Place =——HH
[switchare
Enable when: Disable when
[Farent Enatied Ji=g [uane
Py
Parent Enabled =
Piece in Place T —
Mouse Up J, l
B £l
Drag Motion Modifier (2
Dropped in Yalid Poasttion
il o)
Piece in Place o
-
<[] D]z

Piece in Place behavior
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The first line of the script moves the element
to its exact final position in the puzzle. The
second line changes the currently displayed
cel of the element so that it looks different
when it is in place in the puzzle.

7 Click the close boxes of both the Piece
in Place and Puzzle Piece behaviors to
dismiss their windows.

You may want to test your programming up
to this point. Press § -T to switch to run-
time mode. When the puzzle appears, drag
the puzzle piece and drop it near its correct
position (this piece belongs on the left-side
slanted line of the “M”). You should notice
it snap into place when you release it. When
it does, you will no longer be able to drag
the piece around. Press 36 -T to return to
edit mode.

Adding the snap sound

A sound effect would be nice feedback to
notify the end user that the puzzle piece is
in place.

1 Double-click the Puzzle Piece behavior
icon on the mPiece 2.mToon element to
open its window.

2 Double-click the Piece in Place behavior
icon (in the Puzzle Piece window) to open
its window. We’ll be adding new modifiers
to this behavior.

3 Drag a Sound Effect modifier from the
Effects Modifier palette and drop it into
the Piece In Place behavior window.

The Sound Effect modifier icon



4 Double-click the Sound modifier to display
its configuration dialog box.

5 Name the modifier Piece in Place Sound

6 Use the Execute When pop-up menu to
choose the message that triggers the sound.
Choose Author Messages > Piece in Place.

7 Use the dialog box’s Sound pop-up menu
to choose a sound to be played. Choose
Link File. A standard dialog box appears.
Choose the Sound file Piece in Place.aiff
located in the AIFFs folder located in the
Media folder.

8 Click the Preview button to preview the
sound. The dialog box should look like
the one shown below.

Sound Effect Modifier

m Fiece in Place Sound

Execute When Terminate 'when:

| E INone | E
Specifications

Sound :

[Picce nPlaceaitf ][] [ Preview |

Configuring the Piece in Place sound Sound Effect
Modifier dialog box

IPiece in Place

9 Click OK to accept your changes and dis-
miss the Sound Effect Modifier dialog box.

Disabling the Piece in Place Behavior

One of the most powerful capabilities of behav-
iors is that they can be made switchable. That
is, they can be turned on or off by messages,
just like any other modifier. When a behavior
is deactivated, all of the modifiers inside that
behavior are also deactivated.

In-Depth Tutorial — mPuzzle ®

In our project, it makes sense to deactivate
the Piece in Place Behavior once a piece is

actually in place. By switching this behavior
off, we can ensure that the project doesn't
keep checking for puzzle pieces that are

already in their proper places.

Let’s add one last modifier to the Piece in
Place behavior.

1 Drag a new Messenger modifier from the
Logic Modifier palette and drop it into
the Piece in Place behavior window.

2 Double-click the new messenger to display
its configuration dialog box.

3 Rename the messenger Disable Checks.

4 Use the dialog box’s Execute When pop-up
menu to choose the Author Messages >
Piece in Place message.

5 Highlight the text in the Message/
Command menu and type Disable
Checks. The dialog box should look
like the one shown below.

=————— Messenger
Execute When:
[
Message Specifications
Meszage ACormmand : “with :
IDisab'Ie Checks | E INone | E
Destination:
=l

Configuring the Disable Checks Messenger modifier
dialog box

6 Click OK. A dialog box appears, asking if
you want to create a new author message.
Click OK.
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7 In the Piece in Place behavior window, Keeping track of the puzzle pieces in place
mark the Switchable check box found Let’s program a behavior that keeps track of
next to the behavior name. the number of puzzle pieces in place, so that

when the sixth piece is dropped in place, the

8 Two previously inactive pop-up menus
p Y pop-up entire puzzle will come alive.

become accessible. Now the behavior has
Enable When and Disable When pop-up 1 Start by dragging a new Behavior modi-

menus that can l?e used to spec.lfy the ) fier from the Logic Modifier palette and
messages that activate and deactivate this dropping it in the Puzzle Piece behavior

behavior (and all of the modifiers con- window.
tained within it).

9 Verify that the behavior’s Enable When
message is Parent Enabled, then use the
Disable When pop-up menu to choose 3 Change the name of the behavior to
Author Messages > Disable Checks. Puzzle Status.

N.ow thg functionality of t.his l?ehavior 4 Drag an Integer Variable from the Logic
will be disabled when the piece is in place. Modifier palette and drop it in the Puzzle
Status behavior window.

2 Double-click the new behavior’s icon to
display its configuration dialog box.

Your Piece in Place behavior window

should now look something like the one ﬁ
shown below. We are finished modifying
the Piece in Place behavior, so close the The Integer Variable modifier icon

window by clicking its Close box.
5 Double-click the Integer Variable’s icon

O =————MymPuzzle:PieceinPlace ——OIH to display its configuration dialog box.
i Change the name of the variable to
PorentEatied | [=] [P Erecks ] pieceCount.  Leave its value field set to
Farent Enchled 5 0 (the default). This variable will be used
ety oon : to store the number of puzzle pieces that

G 0 are in place. The dialog box should look
v M'ﬂ‘; like the one shown below.
S = Integer Yariable ==
Ao o =
Frece in Place Sound 5(53 Yalue
il =i {—F |

The completed Piece in Place behavior window

Integer Variable

6 Click OK to dismiss the Variable’s
dialog box.
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7 Drag another Integer Variable into
the Puzzle Status behavior and name
it totalPieces.

8 Set the variable’s value to six. The dialog
box should look like the one shown below.

== Integer ¥ariable ==

12 || S

FValue S
—) |

Variable Value

9 Click OK to dismiss the Variable’s
dialog box.

We're going to use copies of these variables
in each of the puzzle piece elements, so now
we’ll make these variables into aliases.

1 Select both Variable icons in the Puzzle
Status behavior window (using Shift-click
or by simply dragging the pointer across
the variables to marquee them).

2 Choose Make Alias from the Object
menu. Aliasing these variables ensures
their values will be the same wherever
they occur in your project.

3 Click outside the variables to deselect
them. You will notice a visual change to
the icons.

Whenever the puzzle scene is first displayed,
we want to make sure that the pieceCount
variable is initialized to zero.

In-Depth Tutorial — mPuzzle ®

1 Drag a Set modifier from the Logic Modi-
fier palette and drop it in the Puzzle Status
behavior window.

The Set modifier icon

2 Double-click the Set modifier icon to
display its configuration dialog box.

3 Change the modifier’s name to Reset
pieceCount.

4 Use the dialog box’s Execute When pop-up
menu to choose Scene - Scene Started.

5 Use the modifier’s Set pop-up menu to
choose Behavior > pieceCount.

6 Highlight the modifier’s To field and enter
0 (zero). The dialog box should look like
the one shown below.

=—— Set Modifier

H Feset pieceCount

Execute When:

[Swene Started |Z|

Specifications
Set:
e — k1
Ta:
| EX— 1

Set Modifier dialog box

7 Click OK to confirm the changes and dis-
miss the dialog box. Now each time the
end user arrives at the puzzle scene, the
pieceCount variable is set to 0, meaning
that no pieces are currently in place.

Notifying the environment that the puzzle is
complete

Now we need to add functionality that updates
the pieceCount counter each time a puzzle
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piece is put in place. When the counter reaches
the total number of pieces, a message will be
sent to the environment that the end user has
finished the puzzle.

Before we add another modifier, let’s create a
new author message. This time, use the Author
Messages window to create the author message.

1 Choose Author Messages Window from
the View menu. The Author Messages
window appears.

2 Click the New Message button in the
Author Messages window. An untitled
message appears below the two previously-
defined messages shown in the window.

3 Click the untitled author message and
change its name to Puzzle Complete,
then press return. The Author Mes-
sages window should look like the one
shown below.

[0 == My mPuzzle: Author Messages =H B
Fiece in Flace =
Disable Checks
FPuzzle Complate

[~
1] Dz

The Author Messages window

4 Close the close box window by clicking its
Close button.

Now we’ll return our attention to the Puzzle
Status behavior.

5 Drag a new Miniscript modifier in the
Puzzle Status behavior window.
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6 Double-click the modifier’s icon to display
its configuration dialog box. Change its
name to Add To Counter  and configure
the Execute When field to execute on
Author Messages > Piece in Place.

7 Enter the following script in the Script
text field:

-- Increase the pieceCount:
set pieceCount to pieceCount + 1

-- Is the puzzle complete?

if pieceCount = totalPieces then
send "Puzzle Complete” to element's \
parent

end if

The set statement in the script increases
the count of puzzle pieces by one. The rest
of the script (the if statement) is a simple
conditional statement. When the number
of pieces in place equals the total pieces in
the puzzle, the Puzzle Complete author
message is sent to the element’s parent,
which is the scene. Your dialog box should
look like the one shown below.

=—————— Miniscript Modifier
[#dd to Counter
Execute When
=
— Script
[~ Increase the pieceCount -
lset pieceCount to pieceCount + 1 1
-~ Iz the puzzle complete?
|if pieceCount = totalPieces then
zend "Puzzle Complete” to element’s parent
lend if
A |»

Writing the Add to Counter miniscript



8 Click OK to dismiss the Miniscript
Modifier dialog box.

9 Your Puzzle Status behavior window
should look similar to the one shown
below. Close the Puzzle Status behavior
window by clicking its Close box.

[0 =— My mPuzzle: Puzzle Status =—EIB
Fuzzle Status D Switchable
Enable when: Disable when :
|Parent Enabled | w:é |None |
S Started =
cene Starte
Piece in Place ﬂ
! Ho
pieceCount Reset pieceCount '
(4]
Add to Counter
totalPieces —
-
[T P

The completed Puzzle Status behavior window

Animating the M machine

Now we’ll program the actions that are to
take place when all the puzzle pieces have
been put in place.

1 Add a new Behavior modifier to the Puzzle
Piece behavior.

The Behavior modifier icon

2 Double-click the Behavior icon to display
its configuration dialog box.
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3 Change the name of the behavior to
Puzzle Complete.

4 Check the Switchable check box at the
top of the Behavior window. The Enable
When and Disable When pop-up menus
become available.

5 Use the Enable When pop-up menu to
choose Author Messages -~ Puzzle Com-
plete. Use the Disable When pop-up menu
to choose Parent > Parent Enabled.

6 Add a Miniscript modifier to the Puzzle
Complete behavior window.

il

The Miniscript modifier icon

7 Double-click the Miniscript modifier to
display its configuration dialog box.

8 Change the Miniscript modifier’s name to
Set Animation Specs.

9 Use the Execute When pop-up menu
to choose the Parent - Parent Enabled
message.

10 Enter the following script in the Script
text field:

-- Set the range of cels to play:
set range to 2 thru 9

-- Set the rate of play:
set rate to 15
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Now when the animation plays, it will 14 Use the Message/Command pop-up menu
only play cels 2 through 9 at a rate of 15 to choose the Play Control > Play com-
frames per second. The dialog box should mand. When sent to the element, this
look like the one shown below. command will make its animation begin
— TR playing. The dialog box should look like
the one shown below.
FErrr—
— Soript =—— Messenger
[~ Set the range of c2lz ta play [+]
set range to 2 thru 9
;;‘E:a“:‘:o"": ofplay Excecute ‘when:
=]
Message Specifications
Mezzage /Cormmand : with :
IPlag | E INone | E
Destination :
=
L1 D Configuring the Play Animation Messenger modifier

Writing the Set Animation Specs miniscript dialog box

15 Click OK to close the Messenger dialog

11 Click the OK button to dismiss the box and confirm the changes.

Miniscript Modifier dialog box.

16 Your Puzzle Complete behavior should
now look like the one shown below. Close
the Puzzle Complete behavior window by
clicking its Close box.

12 Drag a Messenger modifier from the Logic
Modifier palette and drop it into the Puz-
zle Complete behavior window. This mes-
senger will be configured to activate the

animation. [0 =——— My mPuzzle: Behavior =——"=01H
Enable when: Drisable when:
IPuzz]e Complete | E IParent Enabled | E
The Messenger modifier icon =
Parent Enabled =
Flay =
13 Double-click the Messenger icon to display o
its configuration dialog box. Change the W +
A ) Set Animation Specs 5(2)
Messenger’s name to Play Animation o
. Flay Aniration |
and configure it to execute on the Parent | =
. 1 IIII' k|
- Parent Enabled message using the =
Execute When pop-up menu. The completed Puzzle Complete behavior window
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17 Your Puzzle Piece behavior should look 3 Select the Puzzle Piece behavior icon
like the one shown below. Close the Puzzle found on the mPiece 2.mToon element.
Piece behavior window by clicking its

4 Choose Make Alias from the Object menu.

Close box. . . L
Notice that the Puzzle Piece behavior is
[0 =———— My mPuzzle: Puzzle Fiece =——"H0H added to the Alias palette as shown below.
Enable when: Disable when: s [PEltAd
[Ferent Enatied &t [rore T sort By :
= E pieceCount =]
Farant Enabled — =
Disable Checks — = 78| Fuzzte Pisce
Fuzzle Complete
& o, ﬁ totalPieces
Initial Settings &9 (2) z
— el o
Pieos inPlase =% Bl i
Fuzzle Complete || . . . -
= The Puzzle Piece alias is added to the Alias palette
<«Jif Dz

5 Now distribute this modifier to the five

The completed Puzzle Piece Behavior
other puzzle pieces by dragging the aliased

If you haven’t saved your project in a while, Puzzle Piece behavior icon from the Alias
now is a good time to select Save or Save As palette and dropping it on each piece. As
(File menu). you drop the alias on each piece, notice how

each piece’s background becomes transpar-
ent. Each piece is inheriting the properties

Adding and programming the other puzzle pieces ) s
defined by the Puzzle Piece behavior.

We have just created a reusable software com-

ponent that we are going to apply to all of 6 Copy the Point Variable (named piecePosi-
the puzzle pieces. Let’s add them now. tion) from the mPiece 2.mToon element to
each of the other puzzle pieces. Don’t con-
1 If it is not already visible, select Asset palette fuse this variable with the two on the Alias
from the View menu. The Asset palette palette. Hold down the Option key and
appears. Also, select Al{as Palette from drag a copy of piecePosition from mPiece
the View menu. The Alias palette appears. 2.mToon to each piece. Using Option-drag
Note that the two aliases we created previ- makes a copy of the variable instead of
ously appear on the Alias palette. moving the original.

2 Drag the rest of the puzzle pieces
(mPiece 1.mToon, mPiece 3.mToon,
mPiece 4. mToon, mPiece 5.mToon, and
mPiece 6.mToon) from the Asset palette
into the Layout window.
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Your Layout window should now look
similar to the one shown below.

[= mPuzzle: Layout
Untitieds: = ed 5t ~ | mesigrondpit < el ]

Layout window with all puzzle pieces. Each piece con-
tains the Puzzle Piece aliased behavior and a copy of
the piecePosition variable

Now we have to configure the Point Variables
on each of the newly-added puzzle pieces with
the correct positions.

1 For each new puzzle piece, double-click the
piecePosition variable to display its config-
uration dialog box. Change the X and Y
values to the appropriate value shown in
the following table. The value of mPiece
2.mToon has already been set, but is shown
below for completeness.

Element Name X Y

mPiece 1.mToon 244 85
mPiece 2.mToon 167 204
mPiece 3.mToon 294 199
mPiece 4. mToon 167 241
mPiece 5.mToon 356 237
mPiece 6.mToon 257 166
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Changing the layer order of pieces

One final consideration for the integration
of these puzzle pieces is their layer order. Layer
order refers to the order in which elements in a
scene are drawn on the screen. Elements with
higher layer order numbers will draw on top of
elements with lower layer order numbers.

We can use the Object Info palette to set each
piece’s correct layer order.

1 If it is not already displayed, open the
Obiject Info palette by selecting Object
Info Palette from the View menu.

2 Select each puzzle piece, and enter its cor-
rect layer order number in the Layer field
of the Object Info palette as shown below.
The table below shows the correct layer
order number. When the pieces have been
assigned the layer orders shown in the fol-
lowing table, the completed “M” machine
will look its best.

Assett Name Layer

mPiece 4. mToon 1
mPiece 1.mToon
mPiece 2.mToon
mPiece 6.mToon
mPiece 3.mToon
mPiece 5. mToon

NNk Wi

o e . o e e ) o

Setting the layer order number of mPiece 4.mToon using
the Object Info palette

Background pict

3 Now press 3 -T to run the project. Each
piece should snap into place and make
the clang sound when dropped into its
proper position. When all the pieces
should become animated. Press 36 -T to
return to edit mode.



Naming Structural Elements

As with any mTropolis element, it is good
practice to give descriptive names to all of the
sections and subsections of a project. These
names will make the project much easier to
understand, especially for others.

Renaming Sections and Subsections

We're going to use the mTropolis structure
view to rename the Section and Subsection
used in this project.

1 Select Structure Window from the View
menu. The Structure window appears.

2 In the Structure window, click the text
label that reads Untitled Section. When
the field becomes editable, change the
name to mTutorial.

3 Each level of the hierarchy shown in the
structure view has an Open/Close trian-
gle to its left. If the triangle is pointing
to the right, there are more levels in the
hierarchy that can be revealed by clicking
the triangle. When clicked, the triangle
points downward and the next level of
the hierarchy is revealed. We want to
reveal the level below the mTutorial
section, so click the triangle next to it.
The Untitled Subsection level is revealed.

4 Click the text label that reads Untitled
Subsection. When the field becomes
editable, change the name to mPuzzle.

Note: The top-level project component
has the same name as the file your pro-
ject is saved in.

In-Depth Tutorial — mPuzzle ®

Your Structure window should look similar to
the one shown below.

O == My mPuzzle: Structure =0 B
- E My riPuzzle L=
i m mTutorial
i3 ﬂ mPuzzle

[~

Kim| Dz

The Structure window with renamed section and subsection
components

Adding Sound

One final touch will make our puzzle more
satisfying: a sound that plays when the puzzle
is complete. Previously, we used a Sound mod-
ifier to play the Piece in Place sound. However,
sound media can be mTropolis objects just like
graphical media.

Adding a sound element to the puzzle

In this section, we’ll add a sound element to
the puzzle. Sound elements can only be added
to a project in the structure view, as they have
no visual representation in the layout view.

1 In the Structure window, click the
open/close triangle next to the mPuzzle
subsection to reveal our project’s scenes.

2 Now click the open/close triangle next
to the scene named mBackground.pict.
Icons for the elements of that scene (our
puzzle pieces) appear in the list.
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3 To add a new sound object, choose the
mBackground.pict element and choose
New - Sound from the Object menu.

A sound element icon appears below the
mToon icons.

4 Make sure that the Sound icon is selected
and choose File > Link Media - File. A
standard dialog box appears. Choose the
file Puzzle Complete Loop.aiff found in
the AIFFs folder within the Media folder
and click the Link button as shown below.

G AIFFs | % Scipio
Preview _ &>
Piece In Place.aiff (=]
Puzzle Complete Loop.aiff
<[
o
Show Preview

Linking the Puzzle Complete Loop.aiff sound to the new
sound element

5 The name of the sound element icon
changes to reflect the name of the media.
Your Structure window should now look
like the one shown below.

O My mPuzzle: Structure =—= 1 &
= B My mPuzzie | =]
A= E mTutorial
(g mPuzzle
[ untitted Shared Sene
5 napkinpict
Eg rBackground pict
mPiece 2.mTaen
mPFiece 1.mToon
mPiece Z.mTaen
mPFiece 4.mToon
mPiece S.mTaen
mPFiece &.mToon

v wwww { vow 4

1

[l DP

The Structure window, showing the new sound element
linked to the Puzzle Complete Loop.aiff sound
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6 Double-click the sound icon to display
its Element Info dialog box. In the dialog
box’s Initial State section, select the Paused
and Loop options. The Element Info dialog
box should look like the one shown below.

Element Info

FPuzzle Comnplete Loop. aiff

Source File Path
Secipio (Keith's mFactory Docs Tutorials In-Depth :
Media: &lFFs Puzzle Complete Loop.aiff

— Initial State
D Hidden E Loop Yolurne :
E Pauzed D Back and forth @

— Dptions
DP]ag ewery frame Rate: Ealance
D Cache bitrnap EI @ fps EI

D Direct to screen D Convert text to bitmap

Configuring the sound element to be paused and looped

7 Click OK to confirm the changes and close
the dialog box.

Now we’ll program the sound to start playing
when the puzzle is completed.

1 Drag a Messenger modifier on the Puzzle
Complete Loop.aiff sound icon. The icon
will seem to disappear in the sound icon.
Click the sound icon’s open/close triangle
to reveal the next level of the structure
hierarchy — the sound element’s modi-
fiers. Now the Messenger icon is visible.

The Messenger madifier icon

2 Double-click the Messenger icon to display
its configuration dialog box.

3 Change the Messenger’s name to Play
when Puzzle Complete.



4 Use the Execute When pop-up menu
to choose Author Messages ~ Puzzle
Complete.

5 Use the Message/Command pop-up menu
to choose the command Play Control —
Play. Now when activated, this modifier
will cause the sound element to begin play-
ing. The dialog box should look like the
one shown below.

Messenger

Flay when Puzzle Cornplete

Execute When

Fuzzle Complete E

Message Specifications
Meszage /Command : “With:

IP'Iag | E INone | E

Destination:

Tr—k

Configuring the Play when Puzzle Complete Messenger
modifier dialog box

6 Click OK to confirm the changes and
dismiss the Messenger dialog box.

7 Press 6 -T to run the project and hear the
difference when the puzzle is completed.
Press §6-T to return to edit mode.

This is another good time to save your pro-
ject. Select Save or Save As from the File
menu to save your work.

The Credits Scene

After all this work, it’s time for some hard-
earned recognition. Making your own credits
screen is a good start. We are going to create
a simple credit roll in a new subsection of
the project.
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1 Create a new subsection by choosing the
New Subsection option from the Subsec-
tion pop-up menu on the Layout window.
This menu is the second menu from the
left at the top of the Layout window (its
label currently reads mPuzzle). A new Unti-
tled Subsection is created. The Layout win-
dow updates to show the subsection’s
Untitled Scene.

2 In the Structure window, note that a new
Untitled Subsection icon appeared at the
bottom of the window. Click the name
of the new subsection and change it to
Credits.

3 Click the subsection’s open/close triangle
to reveal its scenes.

4 Highlight the name of the Untitled Scene
and change it to My Credits.  Your struc-
ture view should look similar to the one
shown below.

|
= E My mPuzzle
= [ wTutoria
ﬂ mPuzzle
[ urtitted Shared Soene
Eg Mapkin.pict
B mesckaround pist
mPiece 2.mToon
mPieoe 1.mTaon
mPiece 3.mToon
mPieoe 4.mTaon
mPiece 3.mToon
mPieoe &.mTaon
m Puzzle Complete Loop.aiff

My mPuzzle: structure

iz]
Dlm

dvwvwvwwwdvw{

P& Flay when Puzzle Complete

ﬂ Credits

[ urtitted Shared Soene
[y Credits —

-
<[] Dz

= 4

The Structure window, showing the new Credits
subsection and My Credits scene
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Now let’s return our attention to the Layout
window and create some text for our credits.

1 Click the scene in the Layout window.

2 Select the Text tool from the Tool palette.

The cursor changes to an I-beam with a
small square next to it.

e d

nk__

el

Selecting the Text tool from the Tool palette

3 Create a Text element by dragging one
to the Layout window. Make the text ele-
ment fairly large, so you can enter a large
amount of self-congratulatory text. The
outline of the new text element appears
in the window.

4 Notice that when you move the cursor
over the Text element, the cursor changes
to a simple I-beam. Click inside the Text
element to put an insertion point in the
element. A flashing cursor appears.

5 Type the text that you want to appear in
the credits. For example:

This Tutorial Created by:
Happy M. User
mPFactory

1440 Chapin Ave. #200
Burlinggame, CA 94010
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6 When you are finished entering your text,
select all of the text by dragging over it with
the I-beam cursor. Now you can choose var-
ious text options from the Format menu.
Pick a Font, Size, Style, and Alignment
that appeals to you.

7 Return to the Tool palette and choose
the Selection tool (the arrow). The cursor
changes back to an arrow.

8 Double-click the new Text element to
display its Element Info dialog box.
Change the element’s name to Credits
Text. The dialog box should look like
the one shown below.

Element Info

A
Source File Path
— Initial State
D Hidden D Loop Yolurne :
D Pauzed D Back and forth EI @
— Dptions
DP]ag ewery frame Rate: Layer:
E Cache bitrap EI @ fps I:I
D Direct to screen D Convert text to bitmap

Changing the name of the Text element using the
Element Info dialog box

9 Click OK to confirm your change and
dismiss the Element Info dialog box.

We should now change the color of our text
so that it will show up against the default
black background.

1 Make sure that the Text element is selected.



2 Choose a new color for the text by click-
ing and holding the cursor over the fore-
ground color swatch in the Tool palette. A
palette appears and the cursor changes to
an eyedropper. Drag the eyedropper to a
color in the palette and release the mouse
button to choose a color as shown below.

Choosing a color

Notice that a Graphic modifier icon
appears on the text element. Selecting
colors from the Tool menu is equiva-
lent to configuring a Graphic modifier.

We should also make the background of the
Text element transparent.

1 Make sure that the Text element is selected
and choose Ink in the Tool palette. A pop-up
menu appears. Choose Background Trans-
parent as the ink option as shown below.

£ O

B> |

=
=
-
N
o
&

Background Transparent
Background Matte
Invizible

Ghast

Elend

Chamelzon Light

Ll

Charneleon Dark
Tranzpatrent
Reverse Copy
Rewverse Ghost
Rewverse Transparent

Ink pop-up menu in the Tool palette
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Now let’s modify the text element so that it
scrolls up and off the screen. To do this we will
use a Vector Motion modifier. This modifier
works in conjunction with the Vector Variable.

1 Drag a Vector Variable from the Logic Modi-
fier palette and drop it on the Text element.

The Vector Variable modifier icon

2 Double-click the Vector Variable icon to
display its configuration dialog box.

3 Change the variable’s name to Up. Type
90 in the Angle field and 0.8 in the
Magnitude field. The dialog box should
look like the one shown below.

==Vector Yariable ==

Yalue

Angle: Magnitude :

BoJ(#) k=3

Vector Variable dialog box

4 Click OK to confirm the changes and close
the dialog box.

5 Drag a Vector Motion modifier from the
Effects Modifier palette and drop it on
the Text element.

The Vector Motion modifier icon

6 Double-click the Vector Motion modifier
icon to display its configuration dialog box.

7 Change the modifier’s name to Move Up.
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8 Use the Execute When pop-up menu to
choose the Scene ~ Scene Started message.

9 Use the Vector pop-up menu to choose
the name of the Vector Variable associated
with this Vector Motion. Select the Credits
Text - Up option.

10 Click OK to dismiss the Vector Motion
dialog box.

Your Layout window should now look similar
to the one shown below.

= My mPuzzle: Layout BB
mTutoriat < ][_cresite <[t Credits ~*l=] i
WP4B  tutorial created by:
Happy M. User
mFactory

1440 Chapin Ave. #200
Burlingame, CA 94010

Cradite. e o)

ity Cradits ©
11T g

The My Credits scene as shown in the Layout window

Now press 3-Y to run the project from this
scene (¢6-T runs the project from the very
first scene). The Text element should rise from
its starting position to the top of the screen.
Press 8 -Y again to return to edit mode.
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The effect is interesting, but you might want
some action to take place once the text leaves
the screen. Let’s use a Boundary Detection
Messenger.

1 Drag a Boundary Detection Messenger from
the Logic Modifier palette and drop it onto
the Text element.

The Boundary Detection Messenger modifier icon

2 Double-click the Boundary Detection
modifier icon to display its configuration
dialog box.

3 Change the name of the modifier to
Detect Leaving Top.

4 In the Detect Boundaries of Element’s
Parent section, check only the Top check
box. The Bottom, Left, and Right options
should be unchecked.

5 In the Detect Element section, click the
Once Exited and On first detection
buttons.

6 In the Message Specifications section,
use the Message/Command pop-up
menu to choose the Project - Close
Project command.



7 Use the Destination pop-up menu to
choose Project as the destination for the
command. The dialog box should look
like the one shown below.

=— Boundary Detection Messenger

[
Enable “When: Disable Wwhen:
IParent Enabled | E INone
—  Detect Boundaries of Element’s Parent
< Top [eottom  [Left [ right
i Detect Element
) Exiting
@ Once exited

[

@ On first detection
O Wwhile detected

[ Message Specifications ——
Message /Cormmand : “with:

|C'Iose Fraject | |z| |None
Destination:

E—

Boundary Detection Messenger dialog box

8 Click OK to confirm the changes and dis-
miss the Boundary Detection Messenger
dialog box.

In the Layout window, you might want to
position the Text element slightly below the
bottom of the frame of the scene. When the
text scrolls up it will look like a credit roll
like you might see at the end of a movie.

Another nice thing to do is to give the end
user the ability to abort the play of the credits.

1 Drag a Messenger modifier from the Logic
Modifier palette and drop it on the My
Credits scene.

The Messenger modifier icon

2 Double-click the Messenger icon to display
its configuration dialog box.
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3 Change the name of the Messenger to
Close Title.

4 Leave the Execute When message set to
its default (Mouse Up). Use the Message/
Command pop-up menu to choose Pro-
ject > Close Project. Use the Destination
pop-up menu to choose Project. Now, if
an end user clicks on the title scene before
the credits have finished rolling, the pro-
ject just ends. The dialog box should look
like the one shown below.

=———— Messenger

lose Title

Execute Wwhen:

e —(

Message Specifications

Meszage /Cormmand : “'ith :

| (=] fene (=l
Destination:
o —

IC]ose Project

Messenger dialog box

5 Click OK to dismiss the dialog box.

Using the shared scene

You might have noticed that even though we
have created a fully-functional credits scene,
there’s no way for it to be activated from earlier
scenes in the project!

We'll create a button on the shared scene of
the mPuzzle subsection that activates the title
roll. Putting the button on the shared scene
will make it available to all scenes within a
subsection.

1 Use the controls at the top of the Layout
window to navigate to the shared scene of
the mPuzzle subsection. To do this, choose
mPuzzle from the Subsection pop-up menu
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(the second pop-up menu from the left that
currently reads Credits). Then choose Unti-
tled Shared Scene from the Scene pop-up
menu (the third pop-up menu from the left).

2 If the Asset palette is not visible, display
it by choosing Asset Palette from the
View menu.

3 Drag the Manhole Quit.mToon asset from
the Asset palette and drop it on the scene.
A new Graphic Element containing the
manhole mToon appears.

4 Reposition the element by dragging it to
the lower right area of the shared scene.
Your shared scene should look something
like the one shown below.

5] mPuzzle: EL]
s T T ied saret sere <[+ ]3]
)

~
L«

Positioning the Manhole Quit.mToon element in the
lower right of the shared scene

5 Double-click the Manhole Quit.mToon ele-
ment to open its Element Info dialog box.
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6 In the Initial State section of the dialog
box, ensure that the Paused check box is
checked. The dialog box should look like
the one shown below.

Element Info

anhole Quit.mToon

Source File Path
Secipio (Keith's mFactory Docs Tutorials In-Depth :
Media:mTOONs Manhole Quit.mTaon

Initial State

D Hidden E Loop

Cdpaused [ 1
Options

D Maintain rate Rate: Layer:

D Cache bitrap @ fps I:I

D Direct to screen D

Element Info dialog box

7 Click OK to confirm the change and close
the dialog box.

Let’s make the manhole’s background
transparent.

1 Drag a Graphic modifier from the Effects
Modifier palette and drop it on the Man-
hole Quit.mToon element.

The Graphic modifier icon

2 Double-click the Graphic modifier’s icon
to display its configuration dialog box.



3 Change the modifier’s name to Back -
ground Matte Ink. Use the Ink Effect
pop-up menu to choose Background
Matte. The dialog box should look like
the one shown below.

Graphic Modifier :

i Background Matte Ink

apply “when : Remowve When:
IParent Enabled | E INone | E
Specifications

Inks
Eackground Matte E E
Shape:

| rrrra— 2 N S

Graphic Modifier dialog box

4 Click the dialog box’s Close box to accept
the changes and dismiss the dialog box.

Using libraries

Let’s apply some functionality to the Man-
hole Quit.mToon button by adding a behav-
ior from a library. Libraries can be used to
store mTropolis components (for example,
sections, subsections, scenes, elements,
behaviors, and modifiers) in a file that is
separate from the project.

1 Choose Open from the File menu and
choose the file named Tutorial Library,
found in the In-Depth folder. The Tutor-
ial Library appears as its own palette as
shown below.

Tutorial Librar

il

4| Standard Button -

-

5]

The Tutorial Library palette
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2 Drag the behavior named Standard Button
from the Tutorial Library palette and drop
it on the Manhole Quit.mToon element.

This behavior emulates a button that changes
its appearance when it is clicked. The behavior
sends out three Author Messages: Highlight,
Un-Highlight, and Execute. To use this behav-
ior, add it to a graphic that you want to act as
a button, configure its two states (highlight/
un-highlight) and configure what it does
(execute).

In this case, we have an mToon with two
cels. One cel shows the highlighted button
state, the other shows the un-highlighted
state. To program the button to show the
correct cel at the correct time, we’ll use two
Messenger modifiers to change the cel dis-
play of the mToon.

1 Drag a Messenger from the Logic Modi-
fier palette and drop it on the Manhole
Quit.mToon element.

The Messenger modifier icon

2 Double-click the Messenger icon to display
its configuration dialog box.

3 Change the name of the Messenger to
Un-Highlight.

4 Use the Execute When pop-up menu to
choose Author Messages >~ Un-Highlight.
This author message was automatically cre-
ated when you added the Standard button
behavior to your project.
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5 Use the Message/Command pop-up
menu to choose the Set Attribute
Set cel command.

6 Choose the contents of the With pop-up
menu and enter 1 (one). When received
by the mToon, the Set cel command and
the With value 1 will cause the mToon to
display its first cel.

7 Leave the Destination pop-up menu set
on Element, its default.

8 The dialog box should look like the one
shown below.

Messenger

n-Highlight

Excecute when:

Un-Highlight =

Message Specifications

Meszage fCormmand : “with :

[aet cen [=l[ |[=]

Crestination :

—k

Configuring the Un-Highlight Messenger modifier
dialog box

9 Click OK to close the dialog box.

10 Now place another Messenger modifier
on the manhole element.

11 Double-click the new Messenger icon to
display its configuration dialog box.

12 Change the name of the Messenger to
Highlight.

13 Use the Execute When pop-up menu to
choose Author Messages > Highlight.
This Author Message was automatically
created when you added the Standard
button behavior to your project.
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14 Use the Message/Command pop-up
menu to choose the Set Attribute >
Set cel command.

15 Select the contents of the With pop-up
menu and enter 2. When received by
the mToon, the Set cel command and
the With value 2 will cause the mToon
to display its second cel.

16 Leave the Destination pop-up menu set
to Element, its default.

17 The dialog box should look like the one
shown below.

Messenger

Execute When:

=
Message Specifications
Mezzage /Cormmand : with :

[5et cen =]z =l

Lrestination :

Err—k

Configuring the Highlight Messenger modifier
dialog box

18 Click OK to close the dialog box.

Since messengers in the Standard button
behavior are already programmed to respond
to the end user’s mouse actions by sending
the appropriate message, now all we need to
do is configure the button’s action.

1 Drag a Change Scene modifier from the
Logic Modifier palette and drop it on the
Manhole Quit.mToon element.

The Change Scene modifier icon



2 Double-click the Change Scene modifier
to display its configuration dialog box.

3 Change the name of the modifier to To
Credits.

4 Use the Execute When pop-up menu to
choose the Author Messages - Execute
message.

5 In the Specifications section of the dia-
log box, click the Specify Scene button.
Three pop-up menus become active.
These menus can be used to choose the
section, subsection, and scene that you
will change. Choose the mTutorial sec-
tion, Credits subsection, and My Credits
scene. The dialog box should look like
the one shown below.

= Change Scene Modifier =

To Credits

Execute When

E—

— Specifications
O Next scene in subsection
) Previous scene in subsection
@ Specify Scene :

=l
=
=
D Add to destination scens
[ add to return Tist

D ‘Wrap araund

Configuring the Change Scene Modifier dialog box
to go to the My Credits scene

6 Click OK to accept the changes and close
the Change Scene Modifier dialog box.

In-Depth Tutorial — mPuzzle ®

Your Quit button is now ready to operate. Use
38 -T to run your project from the beginning.
Note that the Manhole button is always avail-
able. Clicking it sends you to the credits page.
When the credits are through rolling (or if you
click the scene), the project ends and mTropolis
returns to edit mode.

Don't forget to save your finished project one
last time before quitting mTropolis.

That’s it! Congratulations on your completion
of the mTropolis mPuzzle tutorial project!
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Network Tutorial —
Avatar Chat

This tutorial shows the creation of a network-
enabled mTropolis title. The project created in this
tutorial allows two end users on different comput-
ers to type messages to each other using “avatars”
(on-screen characters that represent the user). This
is the most complicated tutorial included with
mTropolis. Before attempting this tutorial, you should
have completed the QuickStart Tutorial — A Simple
Slideshow (found in Chapter 6) and the In-Depth
Tutorial— mPuzzle (found in Chapter 7), or have

previous experience with mTropolis programming.



What You'll Need

You'll need the following things before starting
this tutorial.

e mTropolis must be installed on your
machine. Installation instructions are in
the “Read Me First!” file on the mTropolis
CD-ROM.

e The tutorial files are installed by default
when mTropolis is installed. Tutorial files
are in the Tutorials folder of the mTropolis
installation. If the tutorial files have not
been installed, run the installer from the
mTropolis CD-ROM, or drag the Tutorials
folder from the CD to your hard disk.

e This project uses 8-bit media. For best
performance, make sure your monitor is
set to display 256 colors.

e To use and test the avatar chat project,
it’s helpful to have access to a second
computer on a local area network (using
TCP/IP) or via an Internet connection.
However, a second, networked computer
is not required to follow the tutorial and
create the network chat title.

Avatar Chat Project Description

Let’s begin by looking at the completed avatar
chat project. To use this project, you’ll need
two computers connected by a TCP/IP net-
work. It’s also helpful if both machines are
physically near each other, or if you have a
friend to help you by playing the title on the
second machine!

1 We'll assume that you've installed mTropolis
on one of the computers. The second com-
puter must also have the mTropolis player

Network Tutorial — Avatar Chat ®

installed. Use the mTropolis CD-ROM to
install the player on the second machine.
Because the avatar chat title is a cross-
platform title, it doesn’t matter if the second
computer is a Mac OS or Windows 95/NT
machine. Players can also be copied directly
from the mTropolis CD-ROM’s mTropolis
Players folder. Make sure to copy both
the player application and its associated
mPluglns folder as described in the
Deploying mTropolis Players file (also
found in the mTropolis Players folder).

2 Copy the NetChat.mfx file to the second
computer. This file is the built title ver-
sion of the avatar chat tutorial. For Mac
OS machines, this file can be found in
the Network Chat folder (contained in
the Tutorials folder) on the mTropolis
CD-ROM. For Windows machines, this
file can be found in the Doc folder on
the mTropolis CD-ROM.

3 Start the avatar chat title on each computer
by dragging the NetChat.mfx icon onto
the mTropolis Player or mtplay32.exe
icon (the icon that represents the mTropolis
player application). Alternatively, if you
installed the NetChat.mfx file in the same
folder as the mTropolis player application,
you can simply double-click the player icon
and the NetChat.mfx title will automati-
cally play.
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4 The NetChat title should start playing.
The first scene (see figure below) allows
you to select the avatar you will use to
chat with your friend. Click the image of
the bear to choose one of 8 different bears
(there are left- and right-facing bears in 4
colors). When your desired avatar is visi-
ble, click the green Continue! button.

Selecting an avatar in the first scene
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5 A new scene appears (see figure below).

This scene contains an editable text ele-
ment (the white area below the “Enter
your friend’s IP address:” prompt). Click
inside the text element and type the IP
address of the other machine. This address
must be a valid (and correct!) IP address
(for example, 206.86.76.62). After entering
the address, click the Continue! button.

Note that only one player needs to enter
the other player’s IP address. mTropolis
is able to obtain the other IP address
automatically.

Enter your friend's IP address:

206.86.76.62

Connect!
oy

Entering the IP address of your friend’s machine



6 If the IP address is entered correctly, both
machines play a “popping” sound and a
new scene appears (see figure below). If
the other player has not yet chosen an
avatar, an informational prompt appears
on both machines and the new scene
appears when the slower player selects an
avatar and clicks the Continue! button.

7 When the chat scene is displayed, you'll
see both of the chosen avatars (hopefully,
you've picked different avatars to avoid
confusion). You can move your own avatar
by dragging it around the screen. As you
move your avatar, it also moves around
on your friend’s screen. To chat, click
inside the chat bubble that is above your
avatar’s head. Type the message you want
to send, then click outside the chat bub-
ble. Messages typed by your friend appear
in the chat bubble above his/her avatar.

Discussing pressing social issues in NetChat

8 When you get tired of chatting with
your friend and jumping around on the

furniture, quit the NetChat title by pressing

3£-Q (on Mac OS) or Alt-F4 (on Windows).
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Start a New Project

Now we'll recreate the avatar chat project.
Launch the mTropolis editor. Start a new
project by choosing New - Project from
the File menu. A new, empty project appears.
This project contains an empty section, sub-
section, and scene. The empty scene is dis-
played in the layout view.

Add Project-level Modifiers

This project needs a number of modifiers at
the project level. To enable network messaging
functionality, the project needs a Net Messaging
Service modifier. In addition, we need a number
of variables that can be accessed from all scenes
in the project. By putting these variables at the
project level (the topmost structural level), they
become global — they can be accessed from
anywhere in the project.

Add the Net Messaging Service
Let’s start by adding the Net Messaging
Service to the project component.

1 Choose Structure Window from the
View menu (36-2). Only the structure
view can be used to add modifiers to the
project component itself. The structure
view shows the project component and
the one section component in the new
project.

2 If it is not already visible, display the
Network Modifier palette by choosing
Modifier Palettes >~ Network from the
View menu.
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3 Drag the Net Messaging Service modifier

from the Network palette and drop it on the
project component in the Structure window.

The Net Messaging Service modifier icon

The Structure window view should look
like the one shown below.

0 == untitled-2: Structure =0 B
= I Untitied-2 =
@ Met Messaging Service
[ [ untitted Section
1] |» |z

4 Double-click the Net Messaging Service
icon to open its configuration dialog box.

5 Change the service’s name from Net Mes-
saging Service to NetService (note that
there are no spaces in this new name). Later,
we'll refer to this modifier in a Miniscript
statement. Making its name a single word
now will make that script simpler.

6 By default, the Net Messaging Service is
always active. It enables on Project Started
and never disables. In our project, this is
the desired behavior, so there’s no need
to change the defaults. For network mes-
saging to work, the Net Messaging Service
must be present in the project and enabled.
Disabling the Net Messaging Service dis-
ables the network messaging capabilities
of a project.
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Your Net Messaging Service dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Met Messaging Service

@ INetServ‘ice |

Enable When: Drizsable When:

Project Started | E INone | E

Add Global Modifiers to the Project

We’ll need three global modifiers for this
project: a String Variable to store the net-
work address of the remote computer (the
computer being used by the friend we want
to chat with), and two Integer Variables to
store the mToon cel numbers associated
with the avatars selected by each end user.

1 If it is not already visible, display the Logic
Modifier palette by choosing Modifier
Palettes >~ Logic from the View menu.

2 Drag a String Variable from this palette
and drop it on the project component in
the Structure window.

The String Variable icon

3 Click the name of the String Variable in
the Structure Window. The name becomes
editable. Change its name from the default
String Variable modifier to FriendIP . This
variable will be used to hold the IP address
of the remote computer.
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4 Drag an Integer Variable from the Logic Add Set Modifiers to the Project
palette and drop it on the project compo- Now we’ll add two Set modifiers to the project.
nent in the Structure window. These modifiers will set the default values of
the MyAvatarCel and FriendAvatarCel variables
ﬁ when the project starts.

The Integer Variable icon 1 Drag a Set modifier from the Logic palette

5 Click the name of the Integer Variable in and drop it on the project component in
the Structure Window. The name becomes the Structure window.
editable. Change its name from the default
Integer Variable to MyAvatarCel . This H
variable will be used to hold the number The Set modifier icon

of the mToon cel selected as an avatar.

2 Double-click the modifier to display the
6 Drag another Integer Variable from the

: ] Set Modifier dialog box.
Logic palette and drop it on the project
component in the Structure window. 3 Change the modifier’s name to Initialize
My Cel .
ﬁ 4 Use the Execute When pop-up menu to
The Integer Variable icon select Project - Project Started.

7 Click the name of the Integer Variable in 5 In the Specifications section, use the
the structure window. The name becomes Set pop-up menu to choose the variable
editable. Change its name from the default MyAvatarCel from the cascading list of
Integer Variable to FriendAvatarCel . variables.

This variable will be used to hold the
number of the mToon cel selected as an
avatar by the end user of the remote net-
work project.

6 Highlight the text of the To pop-up menu
(it currently reads None) and type 1 (the
number “one”). Your Set Modifier dialog
box should look like the one shown below.

8 Your Structure window should now look

. =— 5set Modifier =—=
like the one shown below.
Bl [nitistize 1y cel |
[ == untitled-2: Structure = £ &5 Execute “hen:
- Urititled—2 = | Froject Started E
Spemﬁcatlons

@ MetService
BB FriendIP Mu AvatarCel E

R —
ﬁ Friend&watarCel E

b L untited Section [Cancel | m

7 Click OK to dismiss the Set Modifier
dialog box.

4]

A [l [»
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8 In the Structure window, click the
Initialize My Cel icon to ensure that
this modifier is selected.

9 Choose Duplicate from the Edit menu
(36-D). A copy of the modifier appears

below the original in the Structure Window.

10 Double-click the new modifier to open its
configuration dialog box.

11 Change the modifier’s name from Initialize
My Cel to Initialize Friend Cel

12 Use the Set pop-up menu to choose the vari-
able FriendAvatarCel from the cascading
list of variables. Your Set Modifier dialog
box should look like the one shown below.

Set Modifier
Bl [ritistize Friend cei

Execute wWhen:

Froject Started E

Speclﬁcahons —_—

—E
I:IE
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13 Click OK to dismiss the Set Modifier dialog
box. Your Structure window should look
like the one shown below.

0 == untitled-2: Structure = 0 B
= I untitied-2 =

@ MNetService

e FriendIFP

ﬁ My AwatarCel

ﬁ Friend&wvatarCel

H Initislize My Cel

H Initialize Friend Cel
b [ untitted Section

4 [l [z

Save the Project
Now would be a good time to save your work.

1 Choose Save from the File menu (3§-S).

2 Name and store the project as you would
any other file.

3 If, at any point, you want to restore the
project to a previously-saved version,
choose Open from the File menu to
load the saved file.

4 Notice that the name of the project com-
ponent, and the titles of the Layout and
Structure windows, change to reflect the
name of the project file.



Create the Avatar Selection Scene

There will be three scenes in our finished pro-
ject. In the first scene, the end user can select
the avatar that they will use to represent them-
selves in the chat space. Each avatar is actually
a single cel in an mToon.

Rename the Scene

Click the Layout window to bring it to the
front. The Layout window shows the first,
and only, scene in the project.

1 Double-click the scene inside the Layout
window to display its Element Info dia-
log box.

2 Change the name of the scene to Select
Avatar Scene . Your scene’s Element
Info dialog box should look like the
one shown below.

Element Info

E |591ect Ay atar Scene |

Source File Path

— Initial State

D Hidden D Lo Walurmne

D Fauzed D Back and forth D @
—  Options

DPlag ewvery frame Rate: Layer:

[ cache bitrnap D @ fps D @

D Direct to screen D Convert text to bitrmap

3 Click OK to dismiss the Element Info
dialog box.

Add the Avatar mToon Element
Now we’ll add the mToon element that lets the
end user select an avatar.
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1 Select the Graphic tool in the Tool palette
as shown below.

2 Click and drag the cursor somewhere near

the center of the scene to create a small
graphic element.

3 Choose Link Media - File (38-L) from

the File menu. A file selection dialog box
appears.

4 In the file dialog box, select the file Avatar

Bear.mToon from the mToons folder, found
inside the Media subfolder of the Network
Chat folder. Click Link to link the mToon
to the graphic element.

1 Avatar Bear.mToon &
__Desktnp

(CDone
Cam

Preview

[»

4]

G4 Show Preview
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5 The element updates to show the linked 2 Choose Background Matte from the
media as shown below. Tool palette’s Ink pop-up menu. A
Graphic modifier icon appears on the

Avatar Bear element.

> |
H|O

Fi-l

Ink

-
[}
=]

=

=

6 Double-click the element to display its

L,

Element Info dialog box. Click the Paused rriskle
check box. Your dialog box should look Elend ]
like the one shown below. E::mjjﬁ: '[‘)fr':
Transparent
Element Info ="""——x Reverse Copy
Reverse Ghost
IAvatar Bear.mToon | Reverse Transparent
Source File Path 3 Drag a Miniscript modifier from the
Scipio (Keith's mFactory Docs Tutarials :Netwark . 1 . h
Chat :Media:mToons :Awvatar Bear mToon LOglC pa ette and drop it on the Avatar

Bear.mtoon element.

— Initial State

[ridden B Loop Yolurne : E
E Paused D Back and forth D @

__Dptions The Miniscript modifier icon
D Maintain rate Rate: Layer:
[eache bitmsp 115 |@ﬂ’5 [ |@ 4 Double-click the Miniscript modifier
D Direct to screen D Conwvert text to bitrnap icon to dlsplay its Conﬁguration dlalog
box. Change the modifier’s name to
Change Cel

7 Click OK to dismiss the Element Info

) 5 We want this Miniscript to be executed on
dialog box.

Mouse Up, so we don't need to change the

Execute When pop-up menu.
Program the Avatar Bear Pop-up

Now let’s add some basic programming to the 6 Enter the following statement in the
Avatar Bear.mToon element to make it a click- Script field:

able selector. set cel to cel + 1

1 Click the Avatar Bear.mToon element to

This script causes the cel displayed by the
ensure that it is selected.

mToon to change each time the end user
clicks on the mToon.
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7 Your Miniscript modifier should look like
the one shown below. Click OK to dismiss
the Miniscript Modifier dialog box.

= MiniscriptModifier=————
hangs Cal
Execute When
Trrara—
| Seript
et cel to cel+1 -
o I

8 Drag a Messenger modifier from the
Logic palette and drop it on the Avatar
Bear element.

The Messenger modifier icon

9 Double-click the Messenger modifier
icon to display its configuration dialog
box. Change the modifier’s name to
Change Cel

10 Use the Message/Command pop-up
menu to select Get Attribute > Get cel.
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11 Use the With pop-up menu to select

MyAvatarCel from the cascading list of
variables off of the project name item.
Your Messenger Modifier dialog box
should look like the one shown below.

Messenger

et Current Cel |

Execute When:

[ocsete ][]

Hessage Specifications

Meszage /Command : with:
IBet el | E |Mg dvatarCel | E
Deztination :

[rement —— ][=]

12 This messenger retrieves the number of
the currently-displayed mToon cel each
time the end user clicks and stores it in
the MyAvatarCel global variable. Click
OK to dismiss the Messenger Modifier
dialog box.

Add a Text Prompt Next to the Avatar
Now let’s add a text prompt that tells the end
user what to do in this scene.

1 Select the Text tool from the Tool palette.
The cursor changes to an I-beam cursor.
Drag on the scene to create a wide text ele-
ment to the left of the Avatar Bear.mtoon
element.

D=

Aﬁ
il
k¥

ey

Selecting the Text tool in the Tool palette
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2 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text into
the element:

Click the image to select your
avatar:

3 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If your text element is not big enough to
display the full text of the prompt, simply
resize it by dragging its borders with the
Selection tool.

4 Click the text element to ensure that it is
selected. Use the Ink pop-up menu on the
Tool palette to choose Background Trans-
parent. A Graphic modifier appears on the
text element.

5 Click and drag on the Foreground Color
Swatch in the Tool Palette to display a
palette of foreground colors as shown
below. Choose a light foreground color
that appeals to you (we used a bright yel-
low in the original version of the NetChat
title). Note that in the Layout window, the
scene’s background appears white but dur-
ing run-time mode the shared scene (which
is black by default) shows through. Pick a
color that will show up well against black.

..k =
AlF
i

k¥
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6 The text changes color. Double-click the
text element to display its Element Info
dialog box. Change the element’s name to
Avatar Prompt . Your Element Info dia-
log box should look like the one shown
below. Click OK to dismiss the dialog box.

Element Info

_rﬂ |P.vatar Promnpt |

Source File Path

— Imitial State

D Hidden D Loop holurme :
A
|:| Faused |:| Back and forth El
—  DOptions
Flay ewvery frame Rate: Layer:

|[@)e E_1[3)

D Convert text to bitmap

7 Your text prompt and Avatar Bear.mToon
element should look similar to the ones
shown below. If you need to reposition
the elements, simply drag them to move
them around the scene.

[<] cache bitrap |
D Direct to screen

kK the image to
=eect your avatar:

Ay atar Prampt 12

8 Save your project again by pressing 36 -S.
Remember to save the project periodically
as you go through the tutorial!

Test the Project

Press 36 -T to run the project. You'll see the
text prompt and the avatar mToon. Click the
mToon to change its cel. Note that since the



mToon is configured to loop, after the eighth
avatar is displayed the first one is shown again.
To return to edit mode, press §6-T again.

Add the Continue Button

Now let’s add the button that allows the
end user to continue to the next scene when
he/she is through selecting an avatar.

1 Select the Text tool from the Tool palette.

2 Drag out a text element, toward the bottom
of the scene, to be used as our continue
button (make it about twice as wide as the
Avatar Bear.mToon).

3 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text into
the element:

Continue!

4 While the insertion point is still inside the
text element, drag over the Continue! text
to select it.

5 Use the Font, Size, and Alignment
options in the Format menu to choose
a type style that appeals to you. In the
original NetChat title, we used Helvetica,
18 points, Center aligned.

6 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If you want to resize the text element, sim-
ply drag its borders with the Selection tool.

7 Double-click the text element to display its
Element Info dialog.

8 Change the element’s name to Continue
Button . Also click the Convert Text to
Bitmap check box. We chose this option

Network Tutorial — Avatar Chat ®

so that end users of this title on other
machines will not have to have the font
used by this button installed. When built
into a title, this element will be converted
into a bitmapped picture that can be dis-
played by any machine.

9 Use the Foreground Color Swatch and
Background Color Swatch on the Tool
palette to choose a foreground and back-
ground color for this button. The fore-
ground color is the color of the text. The
background color is the color of the area
inside the element’s boundaries. In the orig-
inal NetChat title, we chose bright red on
green for this button. A Graphic modifier
appears on the continue button element.

10 Your Layout window should look some-
thing like the one shown below.

O hat: Layout

Untitled Sectin __w ||_Unfiled Subsection v ||_Select Avatar Scene v | @] ]

ol

T e Tinage 167 e,
ot your avatar:

Avatar Prompt

EECREEEEEE
BCTEEETECEEER

i

EI=IE]
EAEIE]

|
I
-]
(=]
Eo 1]
[E]e]
[=1=]
o

Select Avatar Scene. (o) |+
«Juil IO

Create New Scenes

Eventually, we’ll program the Continue Button
element so that it changes to the next scene
when clicked. First we need to create the next
scene. While we’re at it, we’ll also create the
third scene, which is where end users will be
able to chat.
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1 Choose New Scene from the Layout win-
dow’s Scene pop-up menu. This is the
pop-up menu that currently reads Select
Avatar Scene.

Untitled Shared Scene
” Untitled Subsection v"-v’ Select Avatar Scene Iﬂﬂ

2 A new scene is created and the Layout
window changes to show that new, unti-
tled scene.

3 Double-click the new scene to display its
Element Info dialog box. Change its name
to Connection Scene . Your dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Element Info

E IConnection Scene |

Source File Path

— Initial State

D Hidden D Laop alurie :
D Pauzed D Eack and forth El @
—  Options
Flay ewvery frame Rate: Layer:

D Cache bitmap I':' | @ fps I':' |
D Direct to screen D Convert text to bitrmap

4 The name of the scene changes, as
reflected in the Layout window’s
Scene pop-up menu.
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5 Now we’ll create the third and final scene.
Again, choose New Scene from the Layout
window’s Scene pop-up menu.

% Untitled Shared Scene
Select Avatar Scene
| Untitled Subsection v||v" Connection Scene Eﬂ

6 A new scene is created and the Layout
window changes to show that new,
untitled scene.

7 Click inside the Layout window to select
the new, untitled scene.

8 Choose Link Media — File from the File
menu. A file selection dialog box appears.

9 In the file dialog box, choose the file Party
Room.pict from the PICTs folder, found
inside the Media subfolder of the Network
Chat folder. Click Link to link the PICT
to the graphic element.

G PICTs | % Scipio
Preview = S
T8 Party Room.pict [~
N
o e ]
[4 Show Preview

10 The scene updates to show the new media
linked to the scene. The name of the scene
also changes.



11 Double-click the scene to display its Ele-
ment Info dialog box. Change its name
from Party Room.pict to Chat Scene . The
Element Info dialog box should look like
the one shown below. Click OK to dismiss
the Element Info dialog box.

Element Info

l:hat Scene |

Source File Path
Scipio (Keith's mFactory Docs :Tutorials Metwark
Chat :Media :PICTs :Party Room.pict

— Initial State
D Hidden D Loap “alurie
D Faused D Back and forth

—  DOptions
Flay ewery frame Rate: Layer:
D Cache bitrmap I':' | @ fps I':' |
D Direct to screen D Convert text to bitrnap

Program the Continue Button

Now that we’ve created all of our scenes, let’s
return to the Select Avatar Scene and finish
programming the Continue button.

1 Use the Scene pop-up menu or the previous
scene arrow at the top of the layout view to
navigate back to the Select Avatar Scene.

2 In the Select Avatar Scene, drag a behavior
modifier from the Logic palette and drop
it on the Continue Button element.

The Behavior modifier icon

3 Double-click the Behavior icon to display
the behavior window.
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4 Change the behavior’s name to Default
Button Behavior.

5 Click the behavior’s Switchable check
box. The Enable When and Disable
When pop-up menus become active.
The default enable message, Parent
Enabled, is fine and does not need to
be changed. However, we do need to
change the disable message.

6 Use the Disable When pop-up menu to
choose Author Messages ~ New Author
Message. The New Author Message dialog
box appears. Type Connect in the dialog
box’s Name field. Your New Author Mes-
sage dialog box should look like the one
shown below. Click OK to dismiss the New
Author Message dialog box.

New Author Message

Marne :

|Connect

[ Cancel ]I[ Ok ]I

7 The Disable When pop-up menu changes
to read Connect.

8 Drag a Change Scene modifier from the
Logic palette and drop it into the Default
Button behavior window.

4|

The Change Scene madifier icon
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9 Double-click the Change Scene modifier
icon to display its configuration dialog
box. Change the modifier's name to Go to
Connection Scene . In the Specifications
section, click the Specify Scene button and
choose Connection Scene from the Scene
pop-up menu (the last pop-up menu in
this dialog box). Your dialog box should
look like the one shown below. Click OK
to dismiss the Change Scene Modifier
dialog box.

= Change Scene Modifier =

|Gn to Connection Scene |
Execute when:

Prowsewe [

—  Specifications
Mext seene in subsection

) Previous scene in subsection
(] Specify Scene:

Untitled Section [=]
Untitled Subsection || x|
(=]

D Add to destination scene
[] 4dd to return Tist
D “wrap around
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10 Your Default Button Behavior window
should now look like the one shown below.
That’s all the programming this behavior
requires, so close the Default Button Behav-
ior window by clicking its Close box.

[0 == MyChat: Default Button Behavior = HI B
[Default Button Behawior [<] switchable
Enable when : Drizable when:
|Parent Enabled | E |Connect | E
-
Mouse Up =
(1
Go to Connection Scene
-|
Ay | » |z

More Button Programming

The Default Button Behavior programs the
Continue Button to act as a change scene
button. When the end user clicks the button,
the Change Scene modifier inside the behav-
ior is triggered and the scene changes to the
Connection Scene.

However, this is not always what we want the
button to do. Remember that two end users
will be running two different copies of this
program at the same time. They will each be
presented with a scene that allows them to
choose an avatar. After choosing an avatar,
they see the Connection Scene where one of
them will enter the other end user’s IP address.

If one of the end users is faster than the other
and chooses an avatar, goes to the Connection
Scene, enters an IP address, and clicks the
Connect! button while the other end user is
still pondering his or her avatar choices, there’s
no point in having the slower end user see the
Connection Scene.



As you'll see when we program the Connec-
tion Scene, that scene’s Connect button sends
an author message called “Connect” to the
remote project. It sends the mToon cel selected
by the end user of that project as “with” data.
If the receiving project is still on the Select
Avatar scene, it will respond with a message
called “Please Wait” that instructs the connect-
ing project to wait while the slower end user
chooses their avatar. When the slower end user
has chosen his/her avatar (the end user has
clicked the Continue button), the receiving
project sends out a “Send Avatar” message
that tells the connecting project that it is all
right to proceed to the Chat Scene.

The rest of the programming we add to the
Select Avatar Scene handles this case.

1 Drag another Behavior modifier from the
Logic palette and drop it on the Continue
Button element.

The Behavior modifier icon

2 Double-click the Behavior icon to display
the behavior window.

3 Change the Behavior’s name to Complete
Connection

4 Click the behavior’s Switchable check
box. The Enable When and Disable
When pop-up menus become active.

5 Use the behavior’s Enable When pop-
up menu to choose Author Messages >
Connect. The Disable When default
of None is fine and doesn’t need to be
changed.
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6 If it is not already visible, display the
Network Modifier palette by choosing
Modifier Palettes >~ Network from the
View menu.

7 Drag a Net Messenger modifier from the
Network palette and drop it inside the
Complete Connection window. The Net
Messenger is very similar to the standard
mTropolis messenger. It can be used to
send any mTropolis message to another
mTropolis project over a TCP/IP network.

The Net Messenger icon

8 Double-click the Net Messenger icon to
display the Net Messenger dialog box.
Change the modifier's name to Respond
with Avatar

9 The Execute When default of Mouse Up
is fine, don’t make any changes to that
pop-up menu.

10 Use the Message/Command pop-up
menu (which currently reads None) to
choose Author Messages ~ New Author
Message. The New Author Message
dialog box appears. In this dialog box’s
Name field, enter Send Avatar . Your
New Author Message dialog box should
look like the one shown below. Click
OK to dismiss the New Author Message
dialog box.

New Author Message

Marne :
|Send Avatar

[ Cancel ] I[

o
-
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11 Use the With pop-up menu of the
Net Messenger dialog box to choose
MyAvatarCel from the cascading list
of variables shown off of the menu item
that contains the project’s name.

14 Your Complete Connection behavior

window should now look like the one
shown below. We’re through program-
ming this behavior, so close it by click-
ing its Close box.

12 Use the Destination pop-up menu to O === MyChat: Complete Connection =—HH
choose Active Scene as the destination [Eomptets Connection | K switehatte
for the Send Avatar message. Enable when: Bisable when:

IConnect | E INone | E

13 Use the Host pop-up menu to select <
FriendIP from the cascading list of vari- s P B
ables shown off of the menu item that T
contains the project’s name. Your Net M
Messenger dialog box should look like Respond with Avatar |
the one shown below. Click OK to dis- i D >

i

miss this dialog box.

Add the “Already Connected” Prompt

If the Select Avatar Scene receives the “Connect”
message from a remote project, it would be nice
to tell the end user that their friend is already
connected and waiting for him/her to choose

MNet Messenger

E IRespond with dwatar |
Execute When:

Povseve 1[=]

Message Specifications
Meszage /Command : “with an avatar
ISend Avatar | E IMg AvatarCel | E
Destination : Host:
ALY = 1 Select the Text tool from the Tool palette.
|P.ctwe Seene | E |Fr1endIP | E

The cursor changes to an I-beam cursor.
Drag on the scene to create a wide text ele-
ment above the Avatar Prompt and Avatar
Bear elements.

2 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text in the
element:

Your friend is already connected.
Please select an avatar and click
the Continue button.
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3 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If your text element is not big enough to
display the full text of the prompt, simply
resize it by dragging its borders with the
Selection tool.

4 Double-click the new text element to dis-
play its Element Info dialog box. Change
the element’s name to Already Con -
nected Prompt . We also want this ele-
ment to be hidden initially and show itself
only when told to, so click the Hidden
check box. Your Element Info dialog box
should look like the one shown below.
Click OK to dismiss the Element Info dia-
log box.

Element Info

H IMreadg Connected Prompt |
Source File Path

— Imitial State
E Hidden D Loop Wolurme :
D FPaused D Back and forth

— Dptions
|:|F‘1al,| every frame Rate: Layet:

E Cache bitrnap ID | fps |4 |

D [rirect to screen D Convert text to bitmap

5 We want this prompt to have the same
appearance as the Avatar Prompt. We can
reuse the Graphic modifier programming
that we used earlier. Hold down the Option
key while dragging the Graphic modifier
from the Avatar Prompt and dropping it on
the Already Connected Prompt. A copy of
the Graphic modifier is added to the Already
Connected Prompt.
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6 Let’s add the programming that will make
this element display itself when it receives
the Connect message. Drag a Messenger
modifier from the Logic palette and drop
it on the Already Connected Prompt.

The Messenger modifier icon

7 Double-click the Messenger modifier icon
to display its configuration dialog box.
Change its name to Show on Connect
Use the Execute When pop-up menu to
choose Author Messages >~ Connect. Use
the Message/Command pop-up menu to
choose Element > Show. Your Messenger
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

=———— Messenger=———

‘__1.',.5'11 IShow on Connect |
Execute When:

[=]
Message Specifications
Mezsage sCommand : With:
IShow | E INone | E
Destination:
(=]
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Your Layout window should look similar ﬂ
to the one shown below.

[5] hat: Layout

UntitdSaoten | Untted subesotion__~|_ostect avatar somme_<][e 2]

The Miniscript modifier icon

4 Double-click the Miniscript modifier icon
to display its configuration dialog box.
Change its name to React to Connect
Message . Use the Execute When pop-
up menu to choose Author Messages >
Connect. Enter the following statement
in the Script field:

mvam TE aiready tonnected
select an avatar and click the

Cantinue button

Aready Connected Prompt @)

T e Tirags 15
ot your avatar,

Avatar Prompt

[T

set FriendIP to NetService.
sourcelP

&
a5
|
I=]r-]
HH
<]
H e
ol

Select Avatar Soene o {v|
i’ >

This modifier listens for the Connect mes-
sage. Because this message arrives from
a machine at some remote location on
a network, the Net Messaging Service
modifier records the network address
from which the message originates. This
address is stored in the Net Messaging
Service modifier’s “sourcelP” attribute.
The Miniscript statement above reads
this attribute and stores its value in the
FriendIP global variable, which we cre-

Add the “React to Connect” Programming to
the Scene

There is one final piece of programming we
need to add to the Select Avatar Scene. This
programming will process a Connect message
if it is received.

1 Drag a Behavior modifier from the Logic
palette and drop it on the Select Avatar
Scene. Be careful to drop it on the scene

itself, not on any of the other elements
that we previously added to the scene. The
modifier attaches itself to the upper left
corner of the scene.

The Behavior modifier icon

2 Double-click the Behavior icon to display
the Behavior window. Change the behav-
ior's name to React to Connect

3 Drag a Miniscript modifier from the
Logic palette and drop it in the React
to Connect window.
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ated earlier.

Your Miniscript Modifier dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

= Miniscript Modifier
Execute “hen
=
— Seript
|zet FriendIP to NetService zourcelP -
LN § i3




5 Drag a Set modifier from the Logic
Modifier palette and drop it in the
React to Connect window.

The Set modifier icon

6 Double-click the Set modifier icon to
display its configuration dialog box.
Change its name to Set Friend Cel on
Connect . Use the Execute When pop-up
menu to choose Author Messages >
Connect. Use the Set pop-up menu to
choose FriendAvatarCel from the cas-
cading list of variables found off of the
project component’s name. Use the To
pop-up menu to choose Incoming Data.

Your Set Modifier dialog box should look
like the one shown below. Click OK to
dismiss the dialog box.

Set Modifier

H ISet Frriend Cel on Connect
Execute When:

[omect ][]

Specifications

Set:
Frensaverce (7]
To:
T

As mentioned before, when the Connect
message is sent, it will be sent with the
end user’s avatar cel selection as “With”
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data. This modifier reads that data (when
received, it is called “Incoming Data”)
and stores it in the FriendAvatarCel global
variable that we created earlier.

7 If it is not already visible, display the

Effects Modifier palette by choosing
Modifier Palettes > Effects from the
View menu. Drag a Sound Effect modifier
from the Effects palette and drop it in
the React to Connect window.

The Sound Effect modifier icon

8 Double-click the Sound Effect modifier

icon to display its configuration dialog
box. Change its name to Beep on

Connect . Use the Execute When pop-up
menu to choose Author Messages
Connect.

9 Use the Sound pop-up menu to choose

Link File. A standard file selection dialog
box appears. Choose the file Suction Dart.
AIF, found in the AIFFs folder, found inside
the Media subfolder of the Network Chat
folder. Click Link to link the sound to the
modifier.

G AIFFs | & scipio
Preview = ’
[] Suction DartAIF []
<)
= (e
4 Show Preview
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Your Sound Effect Modifier dialog box Use the Destination pop-up menu to
should look like the one shown below. choose Active Scene. Use the Host pop-
Click OK to dismiss the dialog box. up menu to choose FriendIP from the
Sound Effect Modin cascading list of variables. Your Net Mes-
ound =ect Modimer senger dialog box should look like the
IBeep on Connect | one shown below. Click OK to dismiss
Execute When: Terrminate When the dialog box.
IConnect | E INone | E &
Specifications =——— Net Messenger
Sound :
[Euction Dart.&IF ||3 [ Preview | E [Pleaze wait |
Execute When:
Err—]
Message Specifications
10 Drag a Net Messenger from the Net- g Bamman: At
ee s IP]ease wait | E |None | E
work palette and drop it in the React —— X
A Destination : Host:
to Connect window. I."'.ctive Scene | E |FriendIF" ||3

= =) )

The Net Messenger icon

12 Your React to Connect window should now

11 Double-click the Net Messenger icon look like the one shown below. We are fin-
to display its configuration dialog box. ished programming this behavior. Dismiss
Change its name to Please Wait . Use the window by clicking its Close button.
the Execute When pop-up menu to 0 ==—— myChat:React to Connect =——~——==HIE
choose Author Messages >~ Connect. Dlswionabte
Use the Message/Command pop-up Ii:j‘j:{‘g:::};d e Iz‘:"* en] =
menu to choose Author Messages ~— New — 5
Author Message. The New Author Mes- Plssse vt =
sage dialog box appears. In that dialog Blos
box’s name field, enter Please Wait , as Reast to Comect HMessage
shown below. Click OK to dismiss the Ho
New Author Message dialog box. et Frind Gl on Cannect

m(Z)
=— New Author Message == Brepon Bomest
Please Wait
Marne : 4 [l 07
P]ease wait |
ok |

[ Cancel ] I[
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The first scene of our project is now com-
plete. Your scene should look similar to
the one shown below. If you haven’t
saved your work in a while, now would
be a good time!

I ammnn———
United Seotion___~ ||_Untiled Subasotion ] |_Select Avatar Soene_~ ][ €][3]

pr— e
Hﬁ select an avatar and click the
Continue button

Pt @

g The rmage 1o
ot your avatar:

Avstar Prompt

2]

=
<
|
=

R EE s

Eﬁli\i
EAEE]
[l

Selest Avatar Scene o {+]

o[l [l

Complete the Connection Scene

Earlier in this tutorial, we created the second
scene in the tutorial and named it Connec-
tion Scene. This scene is the one in which
the end user can enter the network IP address
for his/her friend’s computer. This scene also
contains the logic that completes the network
connection between the two communicating
projects.

1 While the Layout window is still displaying
the Select Avatar Scene, select the React to
Connect behavior icon, in the upper left
corner of the scene.

2 Copy this behavior to the clipboard by
pressing 36 -C or choosing Copy from the
Edit menu.
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3 Click the Next Scene arrow at the top of
the Layout window to display the Con-
nection Scene as shown below.

Untitled Subsection vI Select Avatar Scene vIlE

4 Press 36-V to paste the behavior on the
Connection Scene. A copy of the behav-
ior appears in the upper left corner of
the scene.

5 We can reuse most of the programming in
this behavior, but need to make one change.
Double-click the behavior icon to display
the new React to Connect window.

6 Double-click the Please Wait Net Messen-
ger icon to display its configuration dia-
log box. Change its name from Please
Wait to Respond with Avatar . Use the
Message/Command pop-up menu to
choose Author Messages -~ Send Avatar.
Use the With pop-up menu to choose
MyAvatarCel from the cascading list of
variables. Use the Destination pop-up
menu to choose Scene. Use the Host
pop-up menu to choose FriendIP.

Your Net Messenger dialog box should
look like the one shown below. Click OK
to dismiss the dialog box.

Net Messenger
E I?espond with Avatar |
Execute When:
=l
HMessage Specifications
Meszage fCormmand : with:
|Send Awvatar | |Z| |Mg AvatarCel | E
Destination: Huost:
IScene | E |Fr1'endIP | E
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7 The edited React to Connect behavior
window should look like the one shown
below. This behavior processes an incoming
Connect message and sends the Send Avatar
message in response. Close the React to
Connect window by clicking its Close box.

0 ==———= MyChat:React to Connect =—c0"r———_RLI1 5
[Resct to Connect [ Switchable
Enable when Disable when
[Parent Enabied Ji=d Jrione |
e
Connect -
Send Avatar =
&l
React to Connect Meszage
= (2)
Set Friend Cel on Connest
m (=
Beep on Connect
E 4
Respond with Avatar ||
-
[} D2

Create the React to Send Avatar Behavior
Now we need to create the behavior that
processes an incoming Send Avatar message
and changes the scene to the Chat Scene.
Again, we’ll reuse some of the programming
that we did earlier.

1 Click the React to Connect behavior icon
to select it.

2 Duplicate the behavior by pressing & -D.
A copy of the behavior appears to the
right of the original.

3 Double-click the copy to display its
behavior window. Change its name to
React to Send Avatar

4 Delete the React to Connect Message Minis-
cript by selecting it and pressing Delete.
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5 Double-click the Set Friend Cel on
Connect Set modifier. Change its name
to Set Friend Cel on Response
Use the Execute When pop-up menu
to choose Author Messages > Send
Avatar. Your Set Modifier dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Set Modifier

H bet Friend Cel on Response

Execute wWhen:

Send Avatar E

Specifications

Set:
Franaavatarce =]
To:
-

6 Double click the Beep on Connect Sound
Effect modifier. Change its name to Beep on
Send Avatar . Use the Execute When pop-
up menu to choose Author Messages >
Send Avatar. Your Sound Effect Modifier
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Sound Effect Modifier

m IBeep on Send dvatar |
Execute 'when: Terminate %when :

ISend Ay atar | E INone | E
Specifications

Sound :

’;ction DartalF ||| [ Preview |




7 Double-click the Respond with Avatar Net

Messenger. Change its name to Send Go
to Chat Scene . Use the Execute When
pop-up menu to choose Send Avatar. Use
the Message/Command pop-up menu to
choose Author Messages -~ New Author
Message and create the author message
Go to Chat Scene
menu to choose None. Your Net Messen-
ger dialog box should look like the one
shown below. Click OK to dismiss the
dialog box.

=———= Npt Messenger ————

E ISend Go to Chat Scene |
Execute When:

(=]
HMessage Specifications
Mezsage /Command : With:
IGo to Chat Scene | E INone | E
Destination : Host:
|Scene | E |Fr1'endIP | E

8 Drag a Change Scene modifier from the
Logic palette and drop it in the React to
Send Avatar window.

The Change Scene modifier icon

. Use the With pop-up
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9 Double click the Change Scene modifier.
Change its name to Change Scene on Send
Avatar . Use the Execute When pop-up
menu to choose Author Messages > Send
Avatar. In the Specifications section of the
dialog box, click the Specify Scene button
and use the Scene pop-up menu to choose
Chat Scene. Your Change Scene Modifier
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Change Scene Modifier =

|:hange Seene on Send Avatar |

Execute When:

Send Avatar E

—  Specifications
Cl Mext scene in subzection
) Previous scene in subsection
(] Specify Scene:

Urtitled Section (=]
Urtitled Subsection | |7
Chat Scene E

D Add to destination scene
[ idd to return Tist
D “Wrap around
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10 The React to Send Avatar behavior is now
complete. Your React to Send Avatar behav-
ior window should look like the one shown
below. Dismiss this window by clicking its

Close box.
[0 =—————=My(hat: React to Send Avatar ————F[HI1B
Ensbls when __ Disable when: .
|Farent Enabled Jix 3 frone |zt
-
Send avatar T =
6o to Chat Geene l 3 =l
Ho
Set Friend Ce1 on Response
e
Beep on Send Avatar
< 28
Send Go to Chat Scene
@)
Change Seene on Send Avatar |
-
[l Dz

Add the Go to Chat Scene Modifier

The behavior we just created sends a mes-
sage called Go to Chat Scene. We need to add
the Change Scene modifier that listens for
this message and changes to the Chat Scene
in response.

1 Drag a Change Scene modifier from the
Logic palette and drop it on the Connec-
tion Scene.

The Change Scene modifier icon
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2 Double click the Change Scene modifier.
Change its name to Go to Chat Scene
Use the Execute When pop-up menu to
choose Author Messages -~ Go to Chat
Scene. In the Specifications section of the
dialog box, click the Specify Scene button
and use the Scene pop-up menu to choose
Chat Scene. Your Change Scene Modifier
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Change Scene Modifier =

ho to Chat Scene |

Execute wWhen:
[~
—  Specifications

O Mext scene in subzection

) Previous seene in subsection
(] Specify Scene:

Uintitled Section [~]
Untitled Subsection | |7
Chat Scene E

D Add to destination scene
[ Add ta return Tist
D wrap around

Add the IP Address Entry Field
Now we’ll add the components that let the end
user enter his/her friend’s IP address.

1 Select the Text tool from the Tool palette.
The cursor changes to an I-beam cursor.
Drag on the scene to create a wide text
element near the top of the scene.



Network Tutorial — Avatar Chat ®

5 Click and drag the Foreground Color
Swatch in the Tool palette to display a
palette of foreground colors as shown
below. Choose a light foreground color
that appeals to you (we used a bright yel-
low in the original version of the NetChat
title because it shows up well against the
black background).

Selecting the Text tool in the Tool palette

2 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text into
the element:

Fi—l

=
=
-

Enter your friend’s IP address:

3 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If your text element is not big enough to
display the full text of the prompt, simply
resize it by dragging its borders with the
Selection tool.

4 Click the text element to ensure that it is
selected. Use the Ink pop-up menu on the
Tool palette to choose Background Trans-
parent. A Graphic modifier appears on the
text element.
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6 The text changes color. Double-click the
text element to display its Element Info
dialog box. Change the element’s name to
Enter IP Prompt . Also click the Con-
vert Text to Bitmap check box. We'll be
changing the type style in this text ele-
ment and want to be sure it looks the
same on all platforms. Your Element Info
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Element Info

E |Enter IF Prompt |

Source File Path

— Initial State

D Hidden D Loop olurne :
4|
I:l Faused |:| Back and forth D
—  Options
DPhg every frame Rate: Layer:

[l cache bitnap o | @ fps |1 | @

D Direct to screen E Conwvert text to bitrap

7 Drag a Text Style modifier from the Effects
palette and drop it on the Enter IP Prompt
text element.

The Text Style modifier icon

8 Previously, we used the Format menu to
format text. In this case, we’ll use the Text
Style modifier. Differences between these
two ways of formatting text are described
in Chapter 3 of the mTropolis Reference
Guide, “Format Menu.”
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Double-click the Text Style modifier icon.
Choose a font, style, and size that appeals
to you. In the original NetChat title, we
used Helvetica, center aligned, 18 points.
Your dialog box should look similar to
the one shown below. Click OK to dis-
miss the dialog box and apply the text
style formatting.

Text S5tyle Modifier
[Text Style Madifier |
Apply When: Remnove When:
IParent Enabled | E INone | E
—S.pecificalinns — Gtyle —
Fant: E Eald
=l [ itatie
Alignrment : D UnderTine
=l Doste
Size: D Shadow
] | Ecoenses
D Extended

9 Select the Text tool from the Tool palette

once again. The cursor changes to an
I-beam cursor. Drag on the scene to create
a wide text element just below the Enter
IP Prompt text element. This is where
the end user will enter his/her friend’s IP
address.

10 When you release the mouse button, an

insertion point appears in the new text
element. We want this text element to be
empty by default, so just click outside the
text element to return to the Selection tool.



11 Double-click the new text element. Change
its name to IPEntry . Its Element Info
dialog box should look like the one shown
below. Click OK to dismiss the Element
Info dialog box.

Element Info

FeY [rentry |

Source File Path

— Imitial State

D Hidden D Loop Wolurme :
|
|:| Faused I:‘ Back and forth D
—  DOptions
Flay ewvery frame Rate: Layer:

[ cache bitrnap Jo | @ s f2 |
D Crirect to screen D Conwert text to bitmap

12 Drag a Miniscript modifier from the
Logic palette and drop it in the IPEntry
text element.

7

<

The Miniscript modifier icon

13 Double-click the Miniscript modifier
icon to display its configuration dialog
box. Change its name to Make Editable
Use the Execute When pop-up menu to
choose Parent > Parent Enabled. Enter
the following statement in the Script field:

set editable to true

When executed during run-time mode,
this statement makes the text element
editable by the end user. Clicking inside
the element puts an insertion point in
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the element. Clicking outside the element
ends text entry (and generates an Edit
Done message).

Your Miniscript Modifier dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Miniscript Modifier —————

Bl [ave eainare

Execute When

=
— Seript
|72t editable to trus

q

Elim D

14 Drag another Miniscript modifier from the

Logic palette and drop it into the IPEntry
text element.

j#!

The Miniscript modifier icon

15 Double-click the Miniscript modifier icon

to display its configuration dialog box.
Change its name to Get [P on Edit
Done. Use the Execute When pop-up
menu to choose Text - Edit Done. Enter
the following statement in the Script field:

set FriendIP to line[1]

Note that the character inside the square
brackets is the number one (1) not a low-
ercase letter “L”. This modifier listens for
the end user to finish entering text in the
element. It then reads the first line
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of text from the element (using the
“line” attribute) and stores it in the
global variable FriendIP.

Your Miniscript Modifier dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Miniscript Modifier

P —

Execute When :

—Seript
22t FriendIP to line[1]

ID

[

[l D

Add the Connect Button

Now let’s add a text element that can be used
as the Connect button. When the end user
clicks this element, mTropolis will attempt to
connect to the remote computer specified by
the end user in the IPEntry text element.

Since this button will be similar to the Con-
tinue button we created in the Select Avatar
Scene, let’s copy the Continue Button as a
starting point.

1 Use the Previous Scene arrow at the top
of the Layout window to navigate back
to the Select Avatar Scene. That scene is
displayed in the Layout window.

2 Click the Continue button element to
select it, then press §-C to copy it to
the clipboard.
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3 Use the Next Scene arrow at the top of
the Layout window to return to the Con-
nection Scene.

4 Press 36 -V to paste the Continue Button in
the Connection Scene.

5 Delete the two Behavior modifiers found
on the copy of the Continue Button.

6 Double-click the Continue Button to
display its Element Info dialog box.
Change its name to Connect Button

7 Select the Text tool from the Tool palette.
Click inside the Connect Button element
and highlight the text, which currently
reads “Continue!”. Change the text to
Connect! . Click outside the element to
end text editing.

8 Drag a Net Messenger from the Network
palette and drop it on the Connect Button
element.

The Net Messenger icon

9 Double-click the Net Messenger icon.
Change the modifier’s name to Send
Connect to Active Scene .Don't
change the default Execute When mes-
sage of Mouse Up. Use the Message/
Command pop-up menu to choose
Author Messages > Connect. Use the
With pop-up menu to choose the My
AvatarCel variable. Use the Destination
pop-up menu to choose Active Scene.
Use the Host pop-up menu to choose
FriendIP.



Your Net Messenger dialog box should
look like the one shown below. Click OK
to dismiss the dialog box.

Met hMessenger

E lSend Connect to Active Scenel
Execute When:

=]
Message Specifications
Meszage /Cornrnand : With:
|Connect | E |Ml,| dvvatarCel | E
Destination: Host:
|Active Seene | E |FriendIP | E

This modifier initiates the connection
process whenever the Connect Button
is clicked.

10 Your Layout window should now look
similar to the one shown below.

Oo=—————
Untitled Seotion ___~||_Unttled Subseotion__v|

MyChat:Layout——————— 0

Comestion Soene___~

ez your friend's TP address:]
| — w!

el
ey

Comsction Scens <]
Eiim § D2

Add Basic Error Checking

There are many things that can go wrong
when trying to establish a network connec-
tion. For example, a network connection may
not be available, the address of the remote
computer may have been entered incorrectly,
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etc. To detect some of these problems, we’ll
add some basic error checking and an infor-
mational prompt to the Connection Scene.

1 Select the Text tool from the Tool palette.
The cursor changes to an I-beam cursor.
Drag on the scene to create a wide text
element above the Connect Button.

2 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text into
the element:

Connection timed out: Your friend
is not yet running Avatar Chat or
there is another network problem.
Check the IP address, or wait and
try your connection again...

3 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If your text element is not big enough to
display the full text of the prompt, simply
resize it by dragging its borders with the
Selection tool.

4 Click the text element to ensure that it is
selected. Use the Ink pop-up menu on the
Tool palette to choose Background Trans-
parent. A Graphic modifier appears on the
text element.
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5 Click and drag the Foreground Color
Swatch in the Tool palette to display a
palette of foreground colors as shown
below. Choose a light foreground color
that appeals to you (we used a bright yel-
low in the original version of the NetChat
title because it shows up well against the
black background).

k(]
Allg
i
Ink F

6 The text changes color. Double-click the
text element to display its Element Info
dialog box. Change the element’s name
to Timeout Prompt . Also click the Hidden
check box. We don’t want this element to
be visible by default. Your Element Info
dialog box should look like the one
shown below.

Element Info

H IT'irneout Prompt |

Source File Path

— Initial State
E Hidden D Laop alurime :
D FPauzed D Black and forth El @
—  Options
DP1ag every frame Rate: Layer:
+*
E Cache bitmap I':' | @ fps I4 |
D Direct to screen D Convert text to bitrmap
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7 Drag a Messenger modifier from the Logic

palette and drop it on the Connect Button
element. We'll configure this messenger to
show the Timeout Prompt when it detects
a network timeout error.

The Messenger modifier icon

8 Double-click the Messenger modifier icon.

Change its name to Timeout Messenger
Use the Execute When pop-up menu to
choose Modifier Messages -~ Net Messag-
ing > Connection Timed Out. Use the
Message/Command pop-up menu to
choose Element -~ Show. Use the Desti-
nation pop-up menu to choose Element’s
Siblings > Timeout Prompt. Your Mes-
senger dialog box should look like the
one shown below. Click OK to dismiss
the dialog box.

Messenger

|T1'mec-ut Messenger |
Execute When:

Connection Tired Out E

HMessage Specifications

Meszage /Command : With
|Show | E INone | E
Destination :

imeout Prompt E

9 Drag a Sound Effect modifier from the
Effects palette and drop it on the Timeout
Prompt element. We'll configure this Sound
Effect to play a system beep when the Time-
out Prompt is shown.

-

The Sound Effect modifier icon



10 Double-click the Sound Effect modifier
icon. Change its name to Beep when
Shown. Use the Execute When pop-up
menu to choose Element -~ Shown. The
default system beep sound is fine, so you
don’t need to change the Sound pop-up
menu. Your Sound Effect Modifier dialog
box should look like the one shown below.
Click OK to dismiss the dialog box.

Sound Effect Modifier

[B=ep when Shown |
Execute When: Termminate When:

|Shown | E |Nnne | E

Specifications
Sound :
ISgstem Egep ||z‘ [ Preview ]

11 Your Connection Scene should now look
like the one shown below.

= MyChat: Layout oE|
e section < {|_Untied Sbseetion_~ eIl

Connection Scene

g your friend's 1P address:
S S—
ol

Pentry @

p tion timed out: Your friend is not yet

Avatar Chat or there is another network
problern. Check the IP address, or wait and try
your connection again

el
| e
|l B
|
=]
l=]i]
| !
|2
|&1/
==
=1

Timeaut Prompt @

1]
EI=|
| =
(=]
El=]
[i Il
(=1
o

Connection Scene @ I~

Rl § D7

Add the Please Wait Prompt

Recall that there is the possibility that the
remote end user may still be choosing his/her
avatar when a connection is attempted. In
that case, the remote project responds to the
“Send Avatar” message with a message called
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“Please Wait.” If this message is received by
the Connection Scene, we need to instruct
the end user to wait for his/her friend to select
an avatar. We also want to disable the IPEntry
text field and the Connect Button. These ele-
ments can be disabled by hiding them when
the “Please Wait” message is received.

1 Select the Text tool from the Tool palette.
The cursor changes to an I-beam cursor.
Drag on the Connection Scene to create a
wide text element between the Timeout
Prompt and the IPEntry text elements.

2 When you release the mouse button, an
insertion point appears in the new text
element. Type the following text into
the element:

Your friend is still selecting an
avatar, please wait...

3 Click outside the text element to end text
entry. The cursor becomes a pointer again.
If your text element is not big enough to
display the full text of the prompt, simply
resize it by dragging its borders with the
Selection tool.

4 Copy the Graphic modifier from the
previously-created Timeout Prompt by
holding the Option key while dragging
the Graphic modifier from the Timeout
Prompt and dropping it on the new text
element. The element inherits the same
color properties as the Timeout Prompt.

mTropolis Developer Guide_% 833



W Network Tutorial — Avatar Chat

5 Double-click the new text element to dis-
play its Element Info dialog box. Change
its name to Please Wait Prompt . Also
click its Hidden check box to make the
element invisible until explicitly told to
show during run-time. Your Element Info
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Element Info

E |Please Wait Prompt |
Source File Path

— Initial State

B Hidden D Loop olurne :
4|
I:l Faused |:| Back and forth D
—  Options
Play ewvery frame Rate: Layer:

[l cache bitnap o | @ fps |5 |
D Direct to screen D Conwvert text to bitrap

6 Drag a Messenger modifier from the Logic
palette and drop it on the Please Wait
Prompt text element. We'll configure this

messenger to show the Please Wait Prompt

when it receives the Please Wait message.

The Messenger madifier icon
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7 Double-click the Messenger modifier

icon. Change its name to Show on Wait
Use the Execute When pop-up menu to
choose Author Messages > Please Wait.
Use the Message/Command pop-up menu
to choose Element - Show. Your Messen-
ger dialog box should look like the one
shown below. Click OK to dismiss the dia-
log box.

Messenger

o on wait |

Execute wWhen:

Fleasze "W ait E

HMessage Specifications

Mezsage /Command : With
|Show | E INone | E
Destination :

E—

8 We need to add a similar Messenger to

all the other elements on the Connection
Scene. This Messenger, however should be
configured to hide the elements when the
Please Wait message is received.

Drag a Messenger modifier from the Logic
palette and drop it on the Enter IP Prompt
text element. We'll configure this messen-
ger to hide the element when it receives
the Please Wait message.

The Messenger modifier icon
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9 Double-click the Messenger modifier 11 Your Connection Scene is now complete.
icon. Change its name to Hide on Wait . It should look like the one shown below.
Use the Execute When pop-up menu to
choose Author Messages > Please Wait.
Use the Message/Command pop-up
menu to choose Element > Hide. Your
Messenger dialog box should look like
the one shown below. Click OK to dis-
miss the dialog box.

izggyour friend's 1P address:
& (1

i

Pentry @

EEEEERR
I 2

CIEEEEES I E

'\-n-venn &SI SETectiRg BH avatar, please Wait

Please Walt Prompt ©

0 i Timed outs Vour friend s not et
watar Chat or there is another network
problem. Check the IP address, or wait and try

Messenger =—"— your connection again

[Fide an wait |

Execute When:

Please Wait E

[ uesesssoss

Timeout Prompt @

jﬁ\ﬁ\i\ﬁ@ﬁﬁ\ﬂl

|
|

Eog
ERE

Message Specifications o
Mezsage /Command : With: ) D7
hide | E [rone | E
Destination:

__;;Z:tm =] Complete the Chat Scene

Now we’ll complete the final scene in the
project. The Chat Scene is the one in which

. . the two end users’ avatars appear. End users
10 We need to copy this new Messenger modi- can move their avatars around the scene

fier to all the other elements in the scene and enter chat text. We'll start by creating

except for the. Please Wait Prompt. HOld the avatars and their chat bubbles (the text

down the Option key and drag the Hide on entry fields used to enter chat text).

Wait Messenger from the Enter IP Prompt

element and drop it on the IPEntry text 1 Use the Next Scene arrow at the top of

element. the Layout window to navigate to the
Chat Scene. The Chat Scene is displayed
in the Layout window. You should see
the Party Room picture that we previ-
ously linked to this scene.

Repeat this step to copy the Hide on Wait
messenger to the Timeout Prompt and
Connect Button elements.

2 Display the Asset Palette by choosing
Asset Palette from the View menu. This
palette shows thumbnails of all the media
files that we have linked to the project.
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3 Drag the thumbnail of the Avatar
Bear.mToon asset thumbnail from the
Asset Palette and drop it somewhere
on the right side of the scene. A new
Avatar Bear.mToon element appears.
It is also selected.

4 Use the Ink pop-up menu on the Tool
palette to choose Background Matte as
shown below. A Graphic modifier appears
on the Avatar Bear.mToon element and
its background becomes transparent.

Ink k] Copy

Background Transparent
+ Background Matte .

Invisible

Ghost

Elend b
Charneleon Light
Charneleon Dark
Transparent

Reverse Copy

Reverze Ghost

Reverse Transparent
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5 Double-click the Avatar Bear.mToon ele-
ment to display its Element Info dialog
box. Change its name to Friend Avatar
Also click its Paused check box. Even
though this is an mToon, we don’t want
it to animate, we just want to display one
of its cels (the cel chosen by the end user
of the remote project). Your Element Info
dialog box should look like the one shown
below. Click OK to dismiss the dialog box.

Element Info

Friend avatar |

Source File Path
Scipio Keith's mFactory Docs Tutorials Netwaork
Chat Media mToons :Avatar Bear mToon

— Imitial State
D Hidden E Loop holurme :

B Pauzed |:| Eack and forth El
—  DOptions

D Maintain rate Rate: Layer:
[T cache bitrap s | @ fos |1 | @

D Direct to screen D Convert text to bitmap

6 Select the Text tool from the Tool palette.

The cursor changes to an I-beam cursor.
Drag on the Chat Scene to create a wide
text element centered just above the Friend
Avatar element. We want this text element
to be empty by default, so simply click out-
side the text element to end text entry.
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7 Double-click the new text element to dis- 9 Double-click the Graphic modifier. Use the
play its Element Info dialog box. Change Ink pop-up menu to choose Background
its name to Friend Chat Bubble. Your Transparent. Use the Foreground Color
Element Info dialog box should look like swatch to choose a light color to be used
the one shown below. Click OK to dismiss for the text. Click the open/close triangle
the dialog box. at the bottom of the dialog box to reveal

the More Specifications section. Enter 2

Element Info in the Border field and choose a light

Vi Friend chat Bubbie | color from the color swatch next to the
Source File Path border field. This will give the text ele-

ment a visible border. Your Graphic Mod-

 tial Stat ifier dialog box should look similar to the

[Hidden [ Loc T one shown below. Click the dialog box’s
[JPaused [ JBack and forth ] Close box to dismiss the dialog box.
—  Dptions i Graphic Modifier :
Flay ewvery frame Rate: Layer: i IGraphic Todifier |
E Cache bitmap ID | @ fp= I2 | @ Apply When : Rermove When :
D [Mirect to zoreen D Convert text to bitmap IParent Enabled | E |Nnne | E

E:Specificatinns
Prrwont =] L]

8 Drag a Graphic modifier from the Effects Shape ;
palette and drop it on the Friend Chat E W M M

Bubble text element.

—  HMore Specifications
Border Shadow

EI9 0 | FO9 m
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Your Layout window should look similar
to the one shown below.

O hat: Layout “'—‘:
««««««««««««««« [ _uniied subzeotin _~]|_ohats el=]

10 Click the Friend Chat Bubble element to

ensure that it is selected. Select the Parent/
Child tool from the Tool palette as shown
below.

Selecting the Parent/Child tool

11 Click inside the Friend Chat Bubble and

drag the cursor down over the Friend
Avatar element. A line appears connect-
ing the Friend Chat Bubble to the cursor.
Release the mouse button when the cur-
sor is over the Friend Avatar element.

The Friend Chat Bubble element has been

made a child of the Friend Avatar element.
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Now when the Friend Avatar element is
moved, the Friend Chat Bubble moves with it.

12 Click the Friend Avatar element to select
it. Press 38-D to duplicate this element. A
copy of the bear mToon appears. Note that
the chat bubble is also duplicated, because
it is a child of the element we duplicated.

13 Drag this copy of the element (the copy is
currently selected and appears in front of
the original) to the left side of the screen.
Your Layout window should now look
similar to the one shown below.

(5]

14 Double-click the copy of the Friend Avatar
element (that is, the bear on the left side
of the screen) to display its Element Info
dialog box. Change its name to My
Avatar . Click OK to dismiss the Element
Info dialog box.

15 Double-click the copy of the Friend Chat
Bubble text element (the chat bubble on
the left side of the screen) to display its
Element Info dialog box. Change its name
to My Chat Bubble . Click OK to dismiss
the Element Info dialog box.

16 Now would be good time to save your work!



Program the Chat Bubbles

Now that we have created the two avatars for
the chat scene, we can program them to send
and receive text messages. The My Chat Bub-
ble text element represents the chat bubble
that the end user can edit to enter chat text
they want to send to his/her friend. The Friend
Chat Bubble element is used to display text
received from his/her friend.

Program My Chat Bubble
We'll start with the My Chat Bubble text ele-
ment (the one on the left side of the screen).

1 Drag a Miniscript modifier from the Logic
palette and drop it in the My Chat Bubble
text element.

L
i
The Miniscript modifier icon

2 Double-click the Miniscript modifier icon
to display its configuration dialog box.
Change its name to Make Editable . Use
the Execute When pop-up menu to choose
Parent > Parent Enabled. Enter the fol-
lowing statement in the Script field:

set editable to true

When executed during run-time mode,
this statement makes the text element
editable by the end user. Clicking inside
the element puts an insertion point in
the element. Clicking outside the element
ends text entry (and generates an Edit
Done message).
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Your Miniscript
should look like

Modifier dialog box
the one shown below.

Click OK to dismiss the dialog box.

Miniscript Modifier

[ esitatne

[zet editable to rue

<[l

3 Drag a String Variable from the Logic

palette and drop

it on My Chat Bubble.

The String Variable icon

mTropolis Developer Guide_§ 8.39



W Network Tutorial — Avatar Chat

4 Double-click the String Variable icon.
Change the Variable’s name to Speech.
Leave the value field empty. Your String
Variable dialog box should look like the
one shown below. Click OK to dismiss
the dialog box.

String Yariahle

b ISpeech |

—  Yalue

[»

-

5 Drag a Messenger modifier from the Logic
palette and drop it on My Chat Bubble.

The Messenger icon
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6 Double-click the Messenger modifier icon.

Change its name to Get Speech . Use the
Execute When pop-up menu to choose
Text - Edit Done. Use the Message/
Command pop-up menu to choose Get
Attribute > Get Text. Use the With pop-
up menu to choose My Chat Bubble >
Speech. Your Messenger dialog box should
look like the one shown below. Click OK to
dismiss the dialog box.

Messenger
het Speech |
Execute wWhen:
[~
HMessage Specifications
Mezsage /Command : With
|Get text | E ISpeech | E

Destination :

E—

This modifier listens for when the end
user clicks outside the My Chat Bubble
element, which causes the Edit Done
message to be generated. In response, it
takes the current contents of the text
element and stores them in the Speech
String Variable.

7 Drag a Sound Effect modifier from the

Effects palette and drop it on My Chat
Bubble.

The Sound Effect modifier icon



8 Double-click the Sound Effect modifier.
Change its name to Beep on Edit
Done. Use the Execute When pop-up
menu to choose Text - Edit Done. Use
the Sound pop-up menu to choose Suc-
tion Dart.AIE. Your Sound Effect Modi-
fier dialog box should look like the one
shown below. Click OK to dismiss the
dialog box.

Sound Effect Modifier

IBeep on Edit Dane |
Execute When: Terminate When:

|Ed1’t Dane | E |Nnne | E

Specifications
Sound :
Eustion part.ar | [x] [[Freview |

9 Drag a Net Messenger from the Network
palette and drop it on My Chat Bubble.

The Net Messenger icon

Network Tutorial — Avatar Chat ®

10 Double-click the Net Messenger icon.

Change the Messenger’s name to Send
Speech on Edit Done . Use the Execute
When pop-up to select Text -~ Edit
Done. Use the Message/Command pop-
up menu to choose Author Messages >
New Author Message. The New Author
Message dialog box appears. Use it to
create a message called Incoming Chat
and click OK to dismiss the dialog box.
Use the With pop-up menu to choose
My Chat Bubble - Speech. Use the
Destination pop-up menu to choose
Scene. Use the Host pop-up menu to
choose FriendIP. Your Net Messenger
dialog box should look like the one
shown below.

Net Messenger

E bend Speech on Edit Done |
Execute When:

Eaitoore ][]

HMeszage Specifications
Mezzage /Command : “w'ith :

Ilncoming Chat | E |Speech | E

Destination : Host:

IScene | E |Fr1'endIP | E

This messenger listens for Edit Done, then
sends the Incoming Chat message to the
remote project with the contents of the
Speech Variable as accompanying data.

11 The My Chat Bubble programming is

now complete.
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Program Friend Chat Bubble 4 Double-click the Messenger modifier icon.
Now let’s turn our attention to the other chat Change its name to Set Text to Incom -
bubble (named Friend Chat Bubble) found on ing Chat . Use the Execute When pop-
the right side of the scene. up menu to choose Author Messages >
Incoming Chat. Use the Message/

1 Drag a Sound Effect modifier from the Command pop-up menu to choose Set
Effects palette and drop it on the Friend Attribute > Set text. Use the With pop-
Chat Bubble text element. up menu to choose Incoming Data. Your

Messenger dialog box should look like
Bl the one shown below. Click OK to dis-
The Sound Effect modifier icon miss the dialog box.

2 Double-click the Sound Effect modifier. Messenger
Change its name to Beep on Incoming Eet Text to Incoming Chat |
Chat . Use the Execute When pop-up Excecute When:
menu to choose Author Messages > E
Incoming Chat. Use the Sound pop-up MQ::;?C“:;:::: :'ﬁ“tw:':ith:
menu to choose Suction Dart.AIF. Your [eet teset | =] [ineeming bata =]
Sound Effect Modifier dialog box should Destination:
look like the one shown below. Click OK =i

to dismiss the dialog box.

This modifier listens for the Incoming Chat

Sound Effect Modifier

|Beep on Incorning Chat |

Execute 'hen: Terminate When : message. When that message is received, it
[Incarning Chat | [=] [Fione =] sets the text contained in the element to
oy cifications the text that arrives with the Incoming
ound ©
[Gustion Dart.AfF ||Z| (Freview | Chat message (the contents of the Speech

Variable sent by the remote project).

3 Drag a Messenger modifier from the Logic
palette and drop it on Friend Chat Bubble.

The Messenger icon
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5 The programming for the Friend Chat
Bubble element is now complete. Your
Chat Scene should look like the one
shown below.

\|:| MyChat: Layout EI=]
United Section___~ ||_Untitd Subsection _v]|_Ohat Soene ~Tel=»]

®

@

Friond Chat Eubb

,

Program My Avatar
Now let’s program the My Avatar element (the
bear on the left side of the screen).

1 Drag a Messenger modifier from the Logic
palette and drop it on My Avatar.

The Messenger icon

Network Tutorial — Avatar Chat ®

2 Double-click the Messenger modifier icon.
Change its name to Set Avatar Cel
Use the Execute When pop-up menu to
choose Scene > Scene Started. Use the
Message/Command pop-up menu to
select Set Attribute - Set cel. Use the
With pop-up menu to choose MyAvatarCel.
Your Messenger dialog box should look like
the one shown below. Click OK to dismiss
the dialog box.

= Messener FF—

|5et Avatar Cel |
Execute When:

Scene Started E

HMeszage Specifications

Mezzage /Command : “w'ith :

ISet el | E hg AwvatarCel | E
Destination

=]

This messenger sets the cel of the Avatar
Bear mToon to the same cel selected by
the end user in the Select Avatar scene.

3 Drag a Miniscript modifier from the
Logic palette and drop it in the My
Avatar element.

&

The Miniscript modifier icon

4 Double-click the Miniscript modifier icon to
display its configuration dialog box. Change
its name to Set Initial Position . Use
the Execute When pop-up menu to choose
Scene > Scene Started. Enter the following
statements in the Script field:
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set position to \ 6 Double-click the Drag Motion modifier.
(rnd(400)+100,rnd(100)+200) Click the Constrain to element’s parent
send "Mouse Up" check box. Your Drag Motion Modifier

dialog box should look like the one shown
When executed during run-time mode, this below. Click OK to dismiss the dialog box.
statement sets the position of the element
to a random location within the scene. The =——— Drag Motion Modifier
modifier then sends the Mouse Up message E [pr-2g Motion Modifier |
to the element. This message will trigger Enable hen: Dizable When:
other modifiers (that we’ll add in the fol- [Parent Enabled | =] [iore (=1
lowing steps) on the element and cause the ELSEACH e ==

Constrain to elerment's parent

element to move smoothly to the random

HMargin of Constraint ———
location. Top: Bottorn:  Left: Right:
lo

15 ) o = | o - |

Your Miniscript Modifier dialog box Directional Conetraint
should look like the one shown below. EN;:? ons 5":D:i:;:ta1 ) Yertical ‘

Click OK to dismiss the dialog box.

e — This modifier allows the avat.ar to be
B dragged around (but not outside of) the
set position to (:nd@ﬂﬂ)ﬂ 00 ndl 1 O0)+200) -

scene by the end user.

Miniscript Modifier

P r—

send "Mouse Lp

7 Drag a Point Variable from the Logic palette
and drop it on My Avatar.

The Point Variable icon

Ziim} v 8 Double-click the Point Variable. Change
its name to New Position . Your Point
Variable dialog box should look like the
one shown below. Click OK to dismiss the

E dialog box.

Point Yariable

l'\lew Position

Yalue
H:

'
|- | o |

5 Drag a Drag Motion modifier from the
Effects palette and drop it on My Avatar.

The Drag Motion modifier icon
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9 Drag a Messenger modifier from the Logic
palette and drop it on My Avatar.

The Messenger icon

10 Double-click the Messenger modifier icon.

Change its name to Get Position on
Mouse Up . Use the Message/Command
pop-up menu to choose Get Attribute >
Get position. Use the With pop-up menu
to choose My Avatar - New Position.
Your Messenger dialog box should look
like the one shown below. Click OK to
dismiss the dialog box.

1§ Messenger 1§

IGet Pozition on Mousze Up |
Execute When:

fowene ——1[=]

Message Specifications
Mezzage /Cornrmand : With:

IGet position | E |New Position | E
Destination:

—

This Messenger listens for the Mouse Up
message. Mouse Up will be generated when-
ever the end user drags his/her avatar and
then releases the mouse. In response, this
Messenger reads the current position of the
My Avatar element and stores it in the vari-
able New Position. Later, we'll create a Net
Messenger that sends this information to
the remote project.

11 Click the Get Position on Mouse Up mes-

senger (the one we just created) to select
it. Press 38 -D to duplicate this Messenger.
A copy of the Messenger appears to the
right of the original.

Network Tutorial — Avatar Chat ®

12 Double-click the new Messenger. Change its

name to Get Position when Dragged

Use the Execute When pop-up menu to
choose Author Messages -~ New Author
Message. In the New Author Message
dialog box that appears, enter Being
Dragged . Click OK to dismiss the New
Author Message dialog box. Your Messen-
ger Modifier dialog box should look like
the one shown below. Click OK to dismiss
the dialog box.

Messenger =cF—m

|Get Position when Dragged |

Execute When:

Eeing Dt agged E

HMeszage Specifications
Mezzage /Command : “w'ith :

IGet position | E |New Fosition | E
Destination :

T—

This messenger reads the current position
of the My Avatar element and stores it in
the variable New Position whenever the
Being Dragged message is received. Later,
we'll create a Timer Messenger that sends
the Being Dragged message repeatedly
whenever the end user is dragging the
avatar. We'll also create a Net Messenger
that sends this updated position informa-
tion to the remote project.

13 Drag a Timer Messenger from the Logic

palette and drop it on My Avatar.

The Timer Messenger icon
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14 Double-click the Timer Messenger. Change

its name to Loop while Being Dragged
Use the Execute When pop-up menu to

choose Motion > Motion Started. Use the

Terminate When pop-up menu to choose
Motion > Motion Ended. Enter 00:00.10
in the Delay For field. Click the Loop
Timer check box. Use the Message/
Command pop-up menu to choose
Author Messages >~ Being Dragged.
Your Timer Messenger dialog box should
look like the one shown below. Click OK
to dismiss the dialog box.

Timer Messenger

..onp while Being Dragged |
Execute When: Termminate ‘When:

[Fation Started | =] [Feotion Ended =]

— Delay For
00010 | Bl Leop timer

— Message
Message Cormmand : whith

IBeing Diragged | E INone | E

Destination :

Flement ]| =]

This messenger detects when the avatar
is being dragged by the end user (when
it starts and stops moving). While that
motion is happening, it sends the Being
Dragged message ten times per second.
The Being Dragged message causes the
element to update its New Position vari-
able and send that information to the
remote project. This information will be
used to simulate smooth drag motion of
the Friend Avatar element.

15 Drag a Net Messenger from the Network

palette and drop it on My Avatar.
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The Net Messenger icon

16 Double-click the Net Messenger icon.

Change the Messenger’s name to Send
Changed Position . Use the Message/
Command pop-up menu to choose
Author Messages >~ New Author Mes-
sage. The New Author Message dialog
box appears. Use it to create a message
called Changed Position and click OK to
dismiss the dialog box. Use the With pop-
up menu to choose My Avatar - New
Position. Use the Destination pop-up
menu to choose Scene. Use the Host pop-
up menu to choose FriendIP. Your Net
Messenger dialog box should look like
the one shown below.

Met Messenger

E lSend Changed Positon |

Execute When:

T —

Hessage Specifications

Message /Command : ‘whith
IChanged FPosition | E INew Fosition | E
Destination: Hozt:

IScene | E IFr'iendIF' | E

This Messenger sends the avatar’s new

position to the remote project whenever
the end user releases the mouse (when

the end user has dragged the avatar to

a new position).

17 Click the Send Changed Position Net

Messenger (the one we just created) to
select it. Press 38 -D to duplicate this
messenger. A copy of the Net Messenger
appears to the right of the original.
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18 Double-click the copy of the Net Messen- 19 The My Avatar element is now fully pro-
ger. Change its name to Send Changed grammed. Your Chat Scene should look
Position when Being Dragged . Use like the one shown below.
the Execute When pop-up menu to = T o]

Unfitled Section v || Untitied Subs: ][ chat seane ~el=]

choose Author Messages ~ Being
Dragged. Your Net Messenger dialog box
should look like the one shown below.
Click OK to dismiss the dialog box. .

Net Messenger "—— O @kl ale® t#rg

E lSend Changed Positon when Dr‘|
Execute When:

Eeing Dragged E

L

Friend Chat Bubble

Meszage Specifications ——— |

Message /Command : With : e mﬂ%

|I:hanged Pozition | E |New Pozition | E

Lreztination: Hazt: —

IScene | E IFriendIP | E KL 47

Program Friend Avatar
The final steps in this tutorial involve pro-

This Messenger sends the avatar’s new gramming the behavior of the Friend Avatar
position to the remote project whenever element (the bear on the right side of the
the element receives the Being Dragged scene). This element is not draggable by the
message. Recall that this message is gener- end user. Instead, it represents the avatar
ated 10 times per second by the Timer selected by the end user of the remote pro-
Messenger whenever the avatar is being ject. It moves whenever the remote end user
dragged by the end user. moves his/her avatar.

1 Drag a Messenger modifier from the
Logic palette and drop it on the Friend
Avatar element.

The Messenger icon
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2 Double-click the Messenger modifier icon.
Change its name to Set Avatar Cel
Use the Execute When pop-up menu to
choose Scene > Scene Started. Use the
Message/ Command pop-up menu to
choose Set Attribute > Set cel. Use the
With pop-up menu to choose Friend
AvatarCel Your Messenger dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Messenger

Eet Avatar cal |

Execute wWhen:

Scene Started E

HMessage Specifications

Meszage /Command : ith
|Set cel | |Fr1'end AvatarCel | E
Drestination:

E—

This Messenger sets the cel of the Avatar
Bear mToon to the cel selected by the end
user of the remote chat project.

3 If the Extras palette is not already visible,
display it by choosing Modifier Palettes >
Extras from the View menu.

4 Drag a Point Motion modifier from the

Extras palette and drop it on Friend Avatar.

The Point Motion modifier icon

mTropolis Developer Guide

5 Double-click the Point Motion modifier
icon. Change its name to PointMotion
(note that there are no spaces in that
name). Use the Execute When pop-up
menu to choose Author Messages >
Changed Position. In the Motion Options
section of the dialog box, enter 300 in the
Speed field. Enter 15 in the Update Rate
field. Your Point Motion Modifier dialog
box should look like the one shown below.
Click OK to dismiss the dialog box.

Point Motion Modifier
n PointMotion |

Execute ‘when: Terminate when:
|l:hanged Fasition

| E |None | E
— Specifications

—Deshnatmn Point Motion Effects —
ICI @ ICI @‘ ’EEase Out DEase In

—Hohon Options

Speed
— l;la'lﬂ:a'“ Update Rate :
- pee E @
15
O Duration: O Smoothness
D 0Z .00

The Point Motion modifier moves an ele-
ment in a straight line to a new position.
Note that we left the X and Y destination
values at zero. We’ll set the destination
values using a Miniscript modifier.

6 Drag a Miniscript modifier from the
Logic palette and drop it into the Friend
Avatar element.

&

The Miniscript modifier icon



7 Double-click the Miniscript modifier
icon to display its configuration dialog
box. Change its name to Update Point -
Motion Destination . Use the Execute
When pop-up menu to choose Author
Messages >~ Changed Position. Enter
the following statement in the Script field:

set PointMotion.destination to
incoming

When the Changed Position message is
received, this statement changes the desti-
nation value of the Point Motion modifier
(named PointMotion) to the value of the
incoming data. Recall that the Changed
Position message is sent with the New Posi-
tion point value. As a result, the Friend
Avatar element will move smoothly to its
new position whenever the Changed Posi-
tion message is received.

Your Miniscript Modifier dialog box
should look like the one shown below.
Click OK to dismiss the dialog box.

Miniscript Modifier

£ Erdste Fomtriation Destinatio

Execute When @

=
— Seript
|zet PaintMetion.destination to incoming -

4]

F1im ) D
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8 The Friend Avatar element programming
is complete. Your Chat Scene should now
look like the one shown below.

MyChat: Layout mE|
[ chatscene (]3]

O
Uniitlsd Ssction v ||_Untitled subss ~

Your avatar chat project is now complete! Save
your work by pressing &8 -S.

Build and Test the Finished Project

Your finished avatar chat project can be
tested in the same way that we test exam-
ined the NetChat.mfx title (described at the
beginning of this chapter). First, however,
we need to turn our completed project into
a mTropolis title file.

1 If you haven’t already saved your finished
project, save it now by pressing §-S.
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2 Choose Build Title from the File menu.
The Build Title dialog box appears as
shown below.

Build Title

Flatform:

| E hross—Phtform | E

indows

D Make Movies External @ QuickTime O

— Sound Resampling Options
® During Build
(] Curing Flayback

Asset Order :

|Elpt1'rn1'zed for Speed
— Wideo Options

Quality :

Bbit/izzkhz || 7]

— mToon Conversion Options
E QT Anirnation to mPactary Animation

E Unzompressed to mFactory dnimation

rtross—Platfﬂrm Color Mapping Dptions

D Re-rnap 8-Bit Images for mPire Plugin

3 The default options are fine for building
this project. The title file created will be a
cross-platform file, so it can run on both
Mac OS and Windows machines (with the
proper version of the mTropolis player).

4 Click the Build button to start the building
process. A standard folder selection dialog
box appears. Choose the folder in which
you want your built title file to be saved.

g My Chat Title %

=, Scipio
B

-
Cancel

Open

Set path for Startup Segment to:

[ “My ChatTitle” ) ]

5 A number of alerts appear. These alerts

show the progress of the Build Title process.
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6 When the Build Title process is finished,
your built title file can be found in the folder
you specified previously. Its name will be
the name of the project file, appended with
“.mfx”. For example, if you saved your pro-
ject as MyChat, the built title file will be
named MyChat.mfx.

Your built title file can be tested just like we
tested the the NetChat.mfx title.

1 We'll assume that one of the computers
is the one on which you’ve installed
mTropolis. The second computer must
also have the mTropolis player installed.
Use the mTropolis CD-ROM to install the
player on the second machine. Because
the avatar chat title is a cross-platform
title, it doesn’t matter if the second com-
puter is a Mac OS or Windows 95/NT
machine. Players can also be copied
directly from the mTropolis CD-ROM’s
mTropolis Players folder. Make sure to
copy both the player application and its
associated mPluglIns folder as described
in the Deploying mTropolis Players file
(also found in the mTropolis Players
folder).

2 Copy your built title file to the second
computer.

3 For both machines, start the avatar chat
title by dragging the the icon of your
built title file on the mTropolis Player
or mtplay32.exe icon (the icon that rep-
resents the mTropolis player application).
Alternatively, if you installed the file in
the same folder as the mTropolis player
application, you can simply double-click
the player icon and the title will auto-
matically play.
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4 Your avatar chat title should start play-
ing. It should behave similarly to the
NetChat.mfx title supplied by Quark
(described at the start of this tutorial).

5 Have fun playing with the avatar chat title!

6 If your title does not work properly, you
might want to open the Completed Net
Chat project file (found in the Network
Chat folder) and compare it to your own
avatar chat project file.
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mPacks

This chapter describes the “mPacks” included with
mTropolis. mPacks are sets of libraries that are
installed with mTropolis. These libraries contain
useful pre-fabricated elements and behaviors that

can be easily reused in your own mTropolis projects.



mPack Basics

mPacks are libraries of pre-fabricated mTropolis
components. These libraries are installed
automatically when you install mTropolis.

mPacks ®

Each mPack contains elements and behaviors
related to a specific authoring task. For exam-

ple, the Buttons mPack contains many types
of pre-programmed buttons that can be cus-
tomized for use in any your projects.

O

Untitled-1: Layout

EBE

[ Untitled Section

v|| Untitled Subsection v|| Untitled Scene vIEﬂ

Buttons mPack

i@z Sliders & Scrollbars-Mac r

] | (@ >

E About Buttons mPack ; EI About Sliders & Scrollbars mPack ;
= e version 1.0 =

E Mac0E Push Button E Iac0S Horizontal Walus Slider

EI Ytindews Push Button E MacOS Vertical Yalue Slider

E Generic Push Button E Mac0S Horizontal Range Slider

E Beveled Puzh Button | E MacdS Vertical Range Slider ]

H Text Push Button % H Mac0S Serolling Tesxt Field %

Untitled Scene

Motions mPack

i

EI About Motions mPack

y ¥ersion 1.0

.o\,’g Horizontal Bounce
"é‘J Wertical Bounce
.o\,’g Geometric Bounce
"é‘J Randor Motion

.-\;J Shaking Mation

MK

T 4]

H|O

B> x|

if

I~
Il
=
=

a
[

«Juf

i {w]
[rz

The Buttons mPack, Motions mPack, and Sliders & Scrollbars mPack
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W mPacks

Opening mPacks

mPacks are standard mTropolis library files —
they can be opened in the same way you would
open any other mTropolis project or library.

To open a specific mPack, choose File >
Open (36-0O). A standard file selection dialog
box appears. Use the dialog box to navigate to
the folder in which you installed mTropolis.
This is the folder that contains the mTropolis
editor and player icons. Inside this folder is a
folder named mPlugins. The mPlugins folder
contains a folder named mPacks. The mPacks
folder contains the individual mPack libraries.
Select the mPack you want to open and click
the Open button.

o Zakalwe
. Buttons mPack -
fit. Looping mPack =
. Motions mPack
[ mPacks Media P
ir, Object Lists mPack

fig. Object Watcher mPack

. Sliders & Scrollbars-Gen m..[~ Open “

Opening an mPack from the File > Open dialog box

The selected mPack opens as a new library
palette.

Closing mPacks

Like any other mTropolis library, mPacks can
be closed by clicking the close icon found in
the upper left corner of the mPack palette.

Using mPacks

Any object in an mPack can be used by sim-
ply dragging its icon from the mPack palette
and dropping it in a mTropolis editing win-
dow. Note that element objects can be dropped
on scenes, while behavior and modifier objects

94 %_mTropolis Developer Guide

can be dropped on scenes, elements, or other
behaviors. The documentation for each mPack
component describes how that component is
intended to be used.

Note: Many mPack components use
the same aliases. If multiple copies of
an mPack component (or two mPacks
that use the same aliases) are dropped
in a project, mTropolis displays the
following warning:

Some of these allases already existin this document. ¥ould you like
to replace with the ones you are adding or use existing?

I Don‘tWarn Again [ cancel | [ Replace | [[Use Bxisting ]|

mTropolis displays this warning when-
ever a copy of an existing alias is added
to a project. The alert will appear even
if the contents of the new alias are the
same as the existing one. Clicking either
Replace or the default, Use Existing,
will usually have the same effect (because
both the “new” and “existing” aliases are
exactly the same). However, if you have
customized any of the aliases used inside
an mPack that is already in your project,
click Use Existing to ensure that your
work is not overwritten.

Each mPack has a special section compo-
nent that contains documentation for each
of the objects that the mPack contains. The
use of this documentation component is
described below. The Tools menu also con-
tains a menu option that can be used to
view mPack documentation.

Viewing mPack Documentation

There are two ways to view documentation
for mPacks. The simplest is to choose mPack
Guide from the Tools menu. The mPack
Guide window appears. Like the other Tool
menu options, this tool is actually a mTropolis



title that runs in a window. The mPack
Guide contains interactive documentation
for each mPack.

Another, more flexible way to view mPack
documentation is to use the mPack documen-
tation section included with each mPack. This
documentation is useful because it is still in
“project” form and can be examined in edit
mode. You can examine (and reuse) all the pro-
gramming Quark used in creating the mPack
documentation and examples.

The section component that contains documen-
tation can be found at the top of each mPack
palette. For example, the Buttons mPack has

a component named “About Buttons mPack.”
These section components contain mTropolis
scenes that describe each component and show
an example of that component in action.

To use these sections:

1 Create a new mTropolis project by choos-
ing File >~ New - Project (38-N). A new
Layout window for that project appears.

2 Display that project’s Structure window
by choosing Structure Window from the
View menu (36-2). The project’s Structure
window appears.

3 Click the Untitled Section component
found in the Structure window and delete
it by pressing the Delete key, or by choosing
Clear from the Edit menu.

O === untitled-2: Structure == H B
<= I untities-2 =
> [ Puntit
4] [+ 7

Choosing the existing Untitled Section component so it
can be deleted

mPacks ®

4 Drag the “About” component from the
mPack palette and drop it on the project
component in the Structure window.

Buttons mPack [0 =— untitled-2: Structure — 15
m About Buttons mPack —
E Mac0S Push Button ﬂ
E sindows Push Button
E Generic Push Butten | [~]
nd | | v |Z
E Beveled Push Button | 7

The About Buttons mPack component has been dropped
on the project component of an untitled project

5 View the mPack documentation by running
the new project. Choose File >~ Run -
From Start (38-T). mTropolis enters run-
time mode and the mPack documentation
main menu appears. More information
about using the mPack documentation
can be found below.

mPacks Documentation Main Menu

All the mPacks documentation sections have
a similar interface. When the section is first
displayed, a main menu appears. This menu
lists all of the components in the mPack.

¢ Click a component name to display a scene
that contains text documentation for that
component and a working example.

¢ Click the “quit” button to quit the docu-
mentation and return to the mTropolis edit
mode. You can also quit the documentation
project by pressing 38-T.

¢ Click the “next” button to see documenta-
tion for the first component in the list.
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-

Buttons mPack
psmPack

&

Gemeral Usage

a2
tacOS Push Button
Tindoms Push Bubton
Feneric Fush Eutton
Beveled Push Button
Text Push Bubton
mToon Fush Eutton
Repeat Bubton Actions
tac05 Radic Bubton
Tindows Fadio Button
Generic Radio Button
tac05 Gheckbox
Tindows Checkbox
Generic Checkbox

| mext | | quit | demo

The main menu for the “About Buttons mPack” section. Click
a title in the list (Mac 0S Push Button) to see documenta-
tion and an example for that component

v
=7

mPacks Documentation Example Scenes

After clicking a component name in the main
menu, a new scene appears. This scene con-
tains a scrolling region on the left side of the
screen that describes the component. On the
right side of the screen is a working example
of the component in action.

¢ Click the scroll arrows beneath the text
region to view more text.

¢ Play with the working example on the right
side of the screen by clicking or dragging
the various interface elements. Some of the
examples for the Motions mPack also use
the keyboard.
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MacQS Push Button
S Push Button.

This mPack implements a standard Mac0S

ay

& push button. It can be enabled, disabled,
hidden and shown.
The name of the button element is used for
the button labe] ;o changs it, open the
Element Info dialog and set the name field
The butten height 15 fixed at runtime to be
20 pixels high.
The button is represented by a grey box in
editmade; all of 115 other components have
awidth and height of zera, At runtime,
these elements resize themselves to
produce the MacOS appearance. Note that
if you run your project with Flayer
Emulation off, you may find it difficult te
draq the BUttan to a new position
afterwards because its child elements will
have covered up the main element.

| -

o

ack | mext | nemw | quit | dews

Documentation scene for an individual mPack component. A
scrolling text element on the left side describes the compo-
nent. On the right side, a working example shows how the
component looks and works in a project

Mac0$ Button

disable | hide

¢ Click the “quit” button to quit the docu-
mentation and return to the mTropolis edit
mode. You can also quit the documentation
project by pressing &§-T.

¢ Click the “back” button (or press the left
arrow key) to see documentation for the
previous mPack component.

e Click the “next” button (or press the right
arrow key) to see documentation for the
next mPack component.

¢ Click the “menu” button (or press m) to
return to the main menu.

The text descriptions of each component
include a general introduction that describes
the mPack component, followed by more
detailed sections as described below:

e User Parameters: This section describes
any variables at the top level of the mPack
component whose values can be changed
to customize the behavior of the component.
To change the values of these variables,
double-click the variable’s icon to display its
configuration dialog box. Note that the icons



of some mPack components may appear
rather small in the layout view. Use the
Structure window to get a clearer view of
the elements and modifiers that make up
an mPack component.

* Messages Received: This section describes
any messages that can be sent to the compo-
nent (using a Messenger modifier or Mini-
script send statement) and the effects of those
messages. For example, many mPack compo-
nents support messages called “Enable” and
“Disable.” Sending the Disable message to the
component causes it to become inactive (dis-
abled button components become unavail-
able and do not respond to end user mouse
clicks). Sending the Enable message to the
component makes it responsive again.

* Messages Sent: This section describes any
messages that can be generated by the com-
ponent and the destinations for those mes-
sages. These messages can be used to trigger
various actions in your project.

e Internal Messages: This section lists any
messages used inside the component. Send-
ing these messages to a component may
produce unpredictable results.

e Example: This section describes the exam-
ple shown on the right side of the screen.

mPacks Descriptions

Brief descriptions of the mPacks included
with mTropolis are listed below.

Buttons mPack
The Buttons mPack contains elements that
simulate clickable buttons in a wide variety

mPacks ®

of styles. Components include a Mac OS Push
Button, Windows Push Button, Text Button,
mToon Button, Radio Buttons, and Check
boxes. It also contains behaviors that can be
added to buttons to enhance their functionality.

This mPack is useful for creating mTropolis
projects that look like standard Mac OS or
Windows programs.

Looping mPack

This mPack contains behaviors that can be
used to create “looping” (repeating) actions
in mTropolis. Components include a looping
behavior, timed looping behavior, and a loop-
ing behavior that makes multiple clones of
other mTropolis objects.

Motions mPack

This mPack contains sophisticated behaviors
that give elements different kinds of complex
motions. Components include behaviors that
enable various types of bouncing, orbital
motion, controlled ground motion (for creat-
ing elements that “drive” like cars), and con-
trolled space motion (for creating elements
that “fly through space” like a spaceship). It
also contains a behavior that detects arrow
key presses for use with the ground and space
motions, a behavior that makes an element’s
motion “wrap around” inside of its parent
element, and sample “cone” mToons that can
be used with the motion behaviors.

Object Lists mPack

This mPack contains behaviors that relate to
lists of mTropolis objects. These behaviors

help automate the rather tedious process of

creating lists of mTropolis objects. The auto

hide/show behavior can be dropped on an
element to cause all of that element’s children
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to automatically hide or show themselves
whenever the element is shown or hidden. The
“List Child Elements” behavior creates an
object list that contains all of an element’s chil-
dren, no matter how deeply they are nested.

Object Watcher mPack

This mPack is designed for use with the Object
Watcher tool (described in Chapter 6 of the
mTropolis Reference Guide. The ObjectWatcher
behavior can be used to make the Object
Watcher tool display information about an
object during run-time.

Sliders & Scrollbars mPacks

These mPacks contain elements that simulate
scrollbars and sliders in a wide variety of
styles. Examples include horizontal and verti-
cal Mac OS scrollbars, horizontal and vertical
Windows scrollbars, scrolling text fields, and
horizontal and vertical sliders. Each different
look (Mac OS, Windows, and a generic gray-
scale appearance) is stored in a separate
mPack library.

These mPacks are useful for creating mTropolis
projects that look like standard Mac OS or
Windows programs.

How mPacks are Installed

When mTropolis is installed, the mPacks are
copied to their own folder, named mPacks,

found inside the mPlugins subfolder of the

folder in which you installed mTropolis.

Enabling Automatic Opening of mPacks

If you use certain mPacks regularly, you may
want them to open automatically when you
launch mTropolis or begin working on a
specific project.
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To open mPacks automatically when
mTropolis is launched:

e Choose the desired mPacks in the finder.

e Choose Make Alias from the Finder’s File
menu (8-M).

e Move the new alias(es) into the Startup
subfolder of your mPlugins folder.

To open mPacks automatically with a
specific project:

¢ Open the project with which you want to
automatically open mPacks.

e Choose Edit > Preferences - Project.
¢ Choose Libraries in the Show popup menu.

¢ Click Add to choose each mPack that
should open automatically when the
project opens.

e Click OK.

e Save the Project.

Installing New mPacks

To install a new mPack, simply copy the new
mPack library file (and any media folders
that go with that mPack) into the mPacks
folder, found inside the mPlugins subfolder of
the folder in which you installed mTropolis.
To make the new mPack open automatically,
put an alias of that mPack inside the Startup
folder, as described in “Automatic Opening of
mPacks,” above.

Remember that mPacks are simply mTropolis
library files, so it’s easy to customize them or
make your own. For example, you might copy
all of the Mac OS-style buttons, sliders, and
scrollbars into a single mPack.



Simple mPack Tutorial

This brief tutorial shows how to use the
Buttons mPack to create clickable buttons
that hide and show another mTropolis ele-
ment. The instructions below assume that
you have some familiarity with the basic use
of mTropolis (you should have completed the
QuickStart Tutorial — A Simple Slideshow
described in Chapter 6).

mPacks W

Double click the button element (not the
modifiers found on that element) to dis-
play its Element Info dialog box. Change
the button’s name from the default Mac OS
Push Button  to Hide Element . Click OK
to dismiss the Element Info dialog box.

4 Press 6-T to run the project. Note that
the button has all the behavior you
would expect in a standard Mac OS but-

Start a New Project and Create a Graphic Element

1 Create a new mTropolis project by choos-
ing File >~ New - Project (§8-N). A new
Layout window for that project appears.

2 Use the Graphic tool to create a new ele-
ment of any size somewhere on the scene.
Double-click the element to display its Ele-
ment Info dialog box. Change the name
of the element to My Element . Click OK
to dismiss the Element Info dialog box.

3 Select the element and use the foreground
color swatch on the Tool palette to assign
a color other than black to the element.
We want to make sure we can see the
element during run-time mode! Alterna-
tively, you could link a PICT, mToon, or
QuickTime media file to the element.

Add a Button from the Buttons mPack to the Scene
1 Open the Buttons mPack.

2 Drag the icon labeled “Mac OS Push
Button” from the Buttons mPack and drop
it somewhere on the scene, preferably
somewhere below the graphic element we
created in the previous steps.

3 You'll see a gray box that represents our
new Mac OS-style button. As described in
the Button mPack’s documentation, this
button gets its label from the name of the
button element itself.

ton. It changes appearance when clicked
and registers a “click” only if the mouse is
released while the cursor is actually inside
the boundaries of the button. The button
causes a system beep when clicked, but
doesn’t do much else. Press 38 -T again to
return to edit mode.

Hide Element

A graphic element and the Hide Element Mac OS-style
push button

Add Functionality to the Button

Now let’s customize our Mac OS-style button
to actually make it hide the graphic element
when clicked.

1 As noted in the documentation for this
button, the push button receives a “But-
ton Activated” message when it is clicked.
We'll use a Messenger modifier to listen
for this message and send the Hide com-
mand to the graphic element in response.
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Drag a Messenger modifier from the Logic 5 Click OK to dismiss the Messenger modi-
palette and drop it on the button. Be care- fier’s configuration dialog box.
ful not to drop it inside of the behavior

. . 6 Press 36-T to run the project. Now when
icon that is already present on the button. % P1oj

the Hide Element button is clicked, the

2 Double click the Messenger modifier icon graphic element should become hidden,
to display its configuration dialog box. disappearing from the scene. Press §-T to
Use the Execute When pop-up menu to return to edit mode.
choose Author Messages > Button >
Button Activated. Note that the Button Add a Show Button
menu found in the Author Messages selec- It would be nice to be able to show our ele-
tion was added to our project automati- ment again. We'll duplicate our existing Hide
cally when we added the Mac OS-style Flement Button and change it slightly to turn
push button to the project. it into a Show Element button.

Mew Author Message.

Button ¥ Button Activated,
General Button Lip
Button Down

——— Messenger

[Messenger

Execute When:

rouse

Elernent

)
rettag oot | 174 4
il Play Gortral »

rione.
- Matian 4
Destination: 4
»
b
b
b
»
»

1 In edit mode, click the gray Hide Element
button to select it. Make sure you click
in the gray area of the button element
itself and not on the modifiers found on
the button.

Author Me.

Transition

Element
Object

= | Parent
Seene

Shared Scene
Project

2 Duplicate the button by pressing & -D.

A copy of the button appears. Move this
Selecting the Button Activated message new button somewhere below the Hide
Element button.

Responses /Errors

3 Use the Message/Command pop-up

Double click th 1
ment to choose Element - Hide. 3 Double click the new button element (not

the modifiers found on that element) to dis-

4 Use the Destination pop-up menu to play its Element Info dialog box. Change
choose Element’s Siblings -~ My Ele- the button’s name from Hide Element  to
ment. Your Messenger modifier dialog Show Element . Click OK to dismiss the
box should look like the one shown Element Info dialog box.
below. 4 Double click the Messenger modifier icon

= Messenger——— found on the Show Element button. The
Messenger modifier configuration dialog
= box appears. This Messenger is currently
Message Specifications ———————————————— COnﬁgured to Send the Hide Command. Use
Meszage /Cornrnand : Ywith :
[rias | =] [one = the Message/Command pop-up menu to
_Dest""a““": choose Element -~ Show instead. The dia-
— = log box should now look like the following
example.

Messenger configured to send Hide to My Element in
response to the Button Activated Message
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Execute When

Button Activated |||

Message Specifications
Message /Cormmand : “with:

|Show | E |None | E

Destination:

My Elernent E

Messenger configured to send Show to My Element in
response to the Button Activated Message

5 Click OK to dismiss the Messenger modifier
dialog box.

6 Press 36-T to run the project. When the
Hide Element button is clicked, the
graphic element should become hidden.
When the Show Element button is
clicked, the graphic element should
appear on the scene once again. Alter-
nately click the Hide Element  and Show
Element buttons until the novelty wears
off. Press 3 -T to return to edit mode.

7 That concludes the simple mPack tutorial!
Take a break and think of other fun things
to do with mPacks.

mPacks ®
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Learning mTropolis
Project

This chapter describes the “Learning mTropolis”
project which includes many examples of using
mTropolis to create both basic and advanced inter-
active multimedia. Examining the programming
used to create the scenes of this project is a good

way to continue your exploration of mTropolis.



Using the Learning mTropolis Project

This project can be found in the Docu-
mentation/Examples subfolder of your
mTropolis installation.

Running and Examining the Project

To examine this project, launch mTropolis
then choose File >~ Open. A standard file
selection dialog box appears. Use this dialog
box to choose the Learning mTropolis pro-
ject found in the Documentation/Examples
subfolder of the folder in which mTropolis is
installed. Click Open. The Learning mTropolis
project’s Layout window appears.

To run the project from its beginning, press
& -T to enter run-time mode. The project
begins playing from its first scene. Click any-
where to display the main menu.

—

[ Learning mTropolis

The Learning mTropolis startup screen

To examine the programming for any of the
scenes in the Learning mTropolis project,
press 38 -. (Command-period). mTropolis

Learning mTropolis Project m

switches to edit mode with the current
scene displayed in the Layout window.

After you have examined a scene in edit mode,
you can continue viewing the project from that
scene. To run the project from the scene cur-
rently displayed in the Layout window, press
38-Y to enter run-time mode.

Learning mTropolis

- preferences

t Authoring Demonstrations i: Multimedi
Modifier Examples Authoring Examples.

The Learning mTropolis Main Menu. Click one of the four
choices at the bottom of the screen

The Main Menu

The Learning mTropolis Main Menu shows
four options at the bottom of the screen.

Click an option to go to that section of the
project. These sections are described below.

Authoring Demonstrations

The “Authoring Demonstrations” section of
the project presents two QuickTime movies
that show examples of authoring in mTropolis.
A slider at the bottom of the screen can be
used to jump forward or backward through the
selected movie. There are two demonstrations:
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e mPuzzle Demonstration: This demonstra-
tion shows the creation of an animated
puzzle, very similar to the mPuzzle tutorial
found in Chapter 7.

* Goldfish Demonstration: This demonstra-
tion shows the creation of a simple project
in which a goldfish swims back and forth
across the screen while a baby fish circles
around it. It shows how to create interactive
behaviors, mToons and simple scripts in
mTropolis.

Modifier Examples

The “Modifier Examples” section shows each
of the mTropolis modifier palettes. Click any
of the modifiers to see at least one example of
using that modifier. Clicking a modifier takes
you to a different scene that illustrates the
use of that modifier. Each example scene con-
tains an About this Modifier button, About
this Example button, and a picture of the
modifier’s icon. Click each button for more
information about the example.

While viewing any of the modifier examples,
you can press 36-. (Command-period) to enter
edit mode and see the programming for that
example. Press 38-Y to return to run-time mode
where you left off.
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Track Control Modifier —

What's playing on RoachTV? Find out in the Track Control
modifier example

Multimedia Basics

The scenes in this section illustrate how com-
mon multimedia features can be programmed
in mTropolis. Click any of the example names
(such as “Button Gallery”) to see the basic
example scenes.

Many of the objects in these scenes can be used
as “clip programming” in your own mTropolis
projects. For example, buttons from the “But-
ton Gallery” scenes can be cut and pasted in
your own projects.

While viewing any of the multimedia basics
examples, you can press 3 -. (Command-
period) to enter edit mode and see the pro-
gramming for that example. Press 36-Y to
return to run-time mode where you left off.

Examples in this section include:

e Button Gallery: Shows different types of
button behaviors.



* Calculated Fields: Shows fields that display
time and date, plus a simple slider.

* Changing Cursors: Demonstrates changing
the cursor as it passes over different parts of
the screen.

* Communicating: Illustrates using mTropolis
messages to simulate real world conditions.
Two lightbulbs and three switches in an
electrical circuit are modeled.

¢ Controlling Audio: Demonstrates playing,
mixing, and changing the volumes of sounds.

¢ Controlling mToons: Demonstrates chang-
ing the ranges and rates of mToons.

e Linear Navigation: Shows navigation
between scenes.

* Revealing Objects: Demonstrates hiding and
showing objects.

e Scene Navigation: Uses scene changes to
simulate navigating a 3D space.

e Scene Transitions: Illustrates the different
transitions that can be applied during scene
changes.

¢ String Functions: Demonstrates the use of
many mTropolis string (text) manipulation
functions.

Authoring Examples

The scenes in the Authoring Examples section
contain more elaborate examples of mTropolis
programming as described below.

e Autonomous Behaviors: This example shows
how mTropolis programming is independent
of the media used in an object. Clicking the
“brain” icon in the upper right corner of the

Learning mTropolis Project m

scene causes the behaviors of the bug and
butterfly to be switched.

¢ Character Interaction: This example uses a
collision detection modifier to detect when
the end user-controlled frog contacts a but-
terfly. The frog “eats” the butterflies when
they are hit. Keyboard Messengers are used
to detect the end user keypresses that control
the frog.

e Multi-node QTVR: This example shows a
multi-node QuickTime VR panorama movie
that can be navigated with either the standard
QuickTime VR mouse motions (by dragging
the mouse over the movie to pan and pressing
control/option to zoom in/out), or by clicking
on the “node map” shown below the movie.
mTropolis sound elements have been used to
add more life the QuickTime VR movie. The
“balance” attribute is used to pan the sounds
as the end user pans around each node.

¢ QTVR Obijects: Click this button to display
a project that uses QuickTime VR object
movies to show the items available in an
interactive catalog.

¢ CBT Module: Click this button to display a
“computer-based training” project. Scenes
show the end user how to assemble an electri-
cal motor then test the end user’s proficiency.

emPuzzle: This is a finished version of
the puzzle tutorial described in Chapter 7,
“In-Depth Tutorial — mPuzzle.”

e Throw Guy: Pick up mToons and “throw”
them off the screen, with surprising results.
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Look out below, it's Throw Guy

While viewing any of the authoring examples,
you can press ¢6-. (Command-period) to enter
edit mode and see the programming for that
example. Press 8-Y to return to run-time mode
where you left off.
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Wizard Authoring
Example

This chapter describes the “Gallery Wizard” project.
A “wizard” is a special type of mTropolis project
that can be used to automate the creation of new
mTropolis projects. Wizard projects use some of
the features described in Chapter 6 of the mTropolis
Reference Guide, “Tools Menu.” The Gallery Wizard
is a fairly sophisticated example of the types of pro-

jects that can be created.



Using the Gallery Wizard Project

This project can be found in the Wizard
Authoring Example folder found inside

the Documentation/Examples folder of
your mTropolis installation.

Running and Examining the Project

To run the wizard project, choose Gallery
Wizard from the Tool Menu. The figure below
will appear. To examine this project, launch
mTropolis then choose File > Open. A stan-
dard file selection dialog box appears. Use this
dialog box to choose the Gallery Wizard pro-
ject. The Gallery Wizard project’s Layout
window appears.

Press 38-T to run the Gallery Wizard. This pro-
ject uses the Window Prefs modifier to run
inside of a window. The project begins playing
(see figure below), but the mTropolis interface
continues to be visible.

Media Gallery
Wizard

Click "Next to Start
creating your
 own Gallery

The Gallery Wizard main menu

Wizard Authoring Example  ®

A wizard is a “helper” application that guides
an end user through a series of steps to cre-
ate a customized project or portion of a pro-
ject. The Gallery Wizard creates multimedia
“photo album” projects that can contain
images, movies, and text annotations.

Follow the instructions below to use the Gallery
Wizard to create your own gallery project.

Starting a New Gallery
Click the Next button on the Gallery Wizard's
first screen to start creating a new gallery.

After clicking the Next button, a new scene
appears (see figure below). This scene has con-
trols that allow you to enter a name for your
gallery, select background music to be played
while browsing the gallery, and set the volume
level for the background music.

~ Enter the name of your gallery:

; [ My Gallery!

 Specify ambient music:
: ) Rock

@ lazz

() Ethereal

() New Age

Volume

The Gallery Wizard name selection scene

[ Back ][ Next | [ Finish |
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When you are through entering a name and
selecting a music type, click the Next button.
The Gallery Wizard’s theme selection scene
(see figure below) appears.

The theme selection scene contains buttons
that allow you to select one of two different
gallery styles (“Scrapbook” or “Modern”). Both
gallery types are functionally identical. They
differ only in their appearance. The Scrap-
book theme creates a gallery that looks like a
traditional photo album. The Modern theme
creates a more contemporary- looking gallery.

~ Choose atheme for your gallery:

@ Scrapbook
) Modern

The Gallery Wizard theme selection scene

[(Back | [ Next | [ finish |

Once you have selected a theme for your
scrapbook, click the Next button. The
Gallery Wizard creates a new mTropolis
project (that appears behind the Wizard)
in which gallery elements will be placed.
The Gallery Wizard displays its page layout
scene (see figure next page). This scene is
used to create a new page in the gallery.

Creating Gallery Pages

The Gallery Wizard's page layout scene (see
figure on next page) is used to select the
images, movies, and text that will be dis-
played on each page.
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Each gallery page can display up to four ele-
ments. These four elements are represented
by the four quadrants shown in the upper
right corner of the page layout scene.

By default, these elements are graphic elements,
but they can also display text or QuickTime
movies. To change the type of an element,
drag one of the three circular icons (that rep-
resent graphic, text, or QuickTime movie) that
appear below the page and drop it on one of
the quadrants. The background of that quad-
rant changes to reflect the new media type.

When you have chosen the type of media
for each quadrant, media can be linked to
that quadrant by clicking that quadrant’s m
button. If the quadrant is a graphic element
or QuickTime element, a file selection dialog
box appears. Use the file selection dialog box
to select a picture or movie from the Sample
Media folder, found inside the Wizard
Authoring Example folder. If the quadrant
is a text element, a text entry field appears.
Use it to enter a witty description.

In addition, each graphic element displayed on
the page can have a caption. Click the A button
in a quadrant to display a text entry field. Use it
to enter the caption for that element.



2Lo) @@

Drag and Drop the media icon to the
frame to change your page Tayout.
Click Next d a page, or click
Finish w are done.
(park J [t ] (rmsh

Creating a new gallery page

When you are finished designing your page,
click the Next button. The Gallery Wizard
creates the new gallery page and adds it to
the gallery project that it created earlier. The
figure below shows one of these pages. The
Gallery Wizard displays a new page layout
scene that can be used to create more pages
in the gallery project. If you want to create
more pages, use the page layout controls to
add more pictures, movies, and text.

] Untitled-2: Layout =]

Untitiad Section

ST T ~l«]=]

mi

[@nce T started using
mTropolis, [ have become
fabulously wealthy. Here
are just a few of my

"toys ...

Framens o) |

Fage 1 ©
[l ID

Kl

A scene from a project created by the Gallery Wizard

Wizard Authoring Example ®

When you are finished adding pages to your
gallery project, click the Gallery Wizard’s Fin-
ish button. The Gallery Wizard closes, leaving
mTropolis in edit mode with your new gallery
project ready to run.

Running the Completed Gallery Project

After you have clicked the Gallery Wizard’s
Finish button, your new gallery project is
ready to run. Click the gallery project’s Lay-
out window to make it the current project,
then press 3 -T to run the project from the
beginning. mTropolis enters run-time mode
and displays your gallery project.

The completed gallery project has an opening
scene (see figure below) that displays the title
of your gallery. Click the Next button to dis-
play the individual pages in your gallery.

The opening scene of a completed gallery project
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The figure below shows a sample gallery page.

If there are more pages in your gallery, there
will be a Next button to click to display the
next gallery page. Each page also has a Back
button to return to the previous gallery page.

Since [ started using
mTropolis, I have become
fabulously wealthy. Here
are just a few of my

Browsing through a completed gallery project

When you are finished examining your gallery

project, press #8-T again to return to edit mode.

You can save your gallery project by selecting
File - Save or by pressing §6-S, just as you
would with any other mTropolis project.

Examining the Gallery Wizard Programming

If you want to examine the programming
that makes the Gallery Wizard work, simply
open the Gallery Wizard project (found in
the Wizard Authoring Example folder found
inside the Documentation subfolder of the
folder in which mTropolis is installed) once
again and use the different mTropolis edit-
ing views to examine the project instead of
running it.
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Authoring Your Own Wizard Projects

The Gallery Wizard Authoring example is
provided as a source example to use as a
model for the creation of your own wizards.
The process of creating a wizard project is
similar to the creation of mTropolis tools. See
Chapter 6 of the mTropolis Reference Guide,
“Tools Menu” for a list of features that are
useful in the creation of tools and wizards.

In brief, the following mTropolis features are
useful when creating wizard projects:

¢ The Window Prefs modifier, which allows
mTropolis projects to run inside of a window.

e The “Asset” attribute, which allows you to
dynamically link media to a project in
edit mode.

e mPacks (described in Chapter 9) which
contain pre-built mTropolis components
such as buttons and sliders.

The following sections describe some of the
basic techniques used to create wizard projects.

Wizard Project Creation

Wizard projects are created entirely within
mTropolis, just like any other project. Before
starting a wizard project, do some basic design
work. A quick storyboard of your project will
help you determine the window size for your
wizard. You generally do not want to change
the dimensions of this window during the
authoring process. Make sure you factor in the
amount of information you need to display in
each scene of the project and the screen size
of the target platform.



Create a new project, then choose Edit >
Preferences > Project and set the Draw
Area Size to your wizard window size. Note
that title bars are drawn outside of this area.
It’s convenient to set the draw area size at this
early stage in the project, because each new
scene you create will be this size.

The Window Prefs modifier enables projects
to be run within a window. Using the Struc-
ture window, drag this modifier from the
Extras and drop it on the project compo-
nent. Open the Window Prefs modifier’s
configuration dialog box, set the window
size to the same dimensions you previously
entered as the draw area size. Also select an
appropriate window style (palette is usually
the best option) so that your wizard window
will “float” above your other windows.

Project Structure

A wizard project is split into two parts — the
wizard interface and the wizard template. The
interface presents the appropriate information
to the end user, and that gathered information
is used to configure the template portion. The
configured template (or parts of that template)
can then be copied (via cloning) into a new
mTropolis project (created by the wizard using
the “newProject” attribute).

The interface portion of a wizard project is
authored like any other mTropolis project. In
the case of the Gallery Wizard example, all
navigation controls are located on the shared
scene of a single section. Author messages
have been set up to send appropriate mes-
sages to the Active Scene destination. A mini-
mum of two behaviors are found in each
scene of the Gallery Wizard interface. One

Wizard Authoring Example ®

behavior sets the state of each navigation
button, while the other receives the naviga-
tion control messages. Since the end user
may alter their option settings on a particular
scene many times, no action (such as cloning,
linking media, or renaming elements) is taken
until the navigation message is received.

The template section of a wizard project is
manipulated via attributes. For example,

if the end user is given the ability to adjust
the volume of an object, the object’s volume
attribute can be accessed directly. See Chapter
15 of the mTropolis Reference Guide, “ Attributes,”
for documentation of each attribute.

In the Gallery Wizard project, a good example
of template manipulation and cloning can be
found in the “Foundation Creation” behavior
on the scene named “Create Gallery Founda-
tion” in the wizard section.

Cloning

After you have manipulated objects in your
template section you can clone them into a
new project. For example, the “Foundation
Creation” behavior mentioned above, uses
a Miniscript modifier with the following
script to create a new project and set its
basic appearance:

-- Create a new, empty project:
set system.newProject to true

-- Get the index number of the new
-- project:

set newProjectindex to \
system.projectCount
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-- Store an object reference to the
- project:

set oDestination to \
system.project[newProjectindex]

The variable oDestination is an Object Ref-
erence Variable that stores a reference to the
new project. This Object Reference is then
used in all subsequent authoring as the
cloning destination.

Using the new structure attributes (which let
you “walk” the structure hierarchy without
having to know the names of objects in the
project), the wizard project can access any
objects in the new project. See Chapter 15 of
the mTropolis Reference Guide, “Attributes,” for
a table of structure attributes and complete
descriptions.

For a good example of object manipulation
and cloning, examine the “Foundation Cre-
ation” behavior in the scene named “Create
Gallery Foundation” in the wizard section of
Gallery Wizard example.

Asset Linking

Another mTropolis feature that is useful in
the creation of wizard projects is the Asset
attribute. This attribute can be used to link
an element to an external media file, just
as if the end user had selected File - Link
Media. Using the Asset attribute in this
way only works on projects running in the
mTropolis editor (it does not work in the
mTropolis player). For example, the Miniscript
statement:
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set myelement.asset to \
"My HD:My Media Folder:Image.pict"

would link the element myelement to the
PICT image Image.pict ~ found in the folder
My Media Folder  on the drive My HD.

Setting the Asset attribute to "" (an empty
string) causes a file selection dialog box to
be displayed. This feature lets the end user
specify any media. This use of the asset
attribute is demonstrated in the “link” scene
of the wizard interface section of the Gallery
Wizard example.

n Note: The element type (PICT, QuickTime,

mToon, or sound) must match the type
of the file when an asset is linked in this
manner. For example, to set the Asset
attribute to an mToon, the element
must have already been linked to an
mToon asset.
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Alias palette, 4.7
Aliases, 4.7

Gradient modifier, 4.6-4.7
Graphic elements, 4.3, 3.4

Assetpalette, 1.4

At First Cel message, 5.9 H
Author messages, 5.9 Hierarchy, 3.8-3.12
B I
Basics of mTropolis, 3.3-3.12 Inheritance, 2.5, 3.9
Behaviors, 3.10, 4.7 Interface overview, 1.3-1.7
switchability, 4.7, 5.8
........................................................................... L
(¥
Layer order, 4.5-4.6
Children, 3.9 Layers view, 1.5
Close Project command, 5.10 Layout view, 1.5
Collision detection, 3.7 positioning elements, 4.3
Commands, 5.10 Layout window, 1.3
Components, 4.3-4.6 Learning mTropolis project, 10.3-10.6
Containment hierarchy, 3.9-3.12, 4.3-4.5 Libraries, 1.6
Conversation, 3.6
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D .
Media and elements, 4.3
Data sending with messages, 5.9 Media objects, 3.4
Debugging support, 1.6 creating, 3.4

Destination pop-up menu, 5.5-5.6 customizing, 3.5-3.6
Message Log window, 1.7

........................................................................... Message/command pop_up menu, 54_56

Dragging and dropping, 3.3

E Messages, 2.3
Edit mode, 3.4 Author, 5.9
Editing view, 1.5 broadcasting, 3.11
Element Info dialog box, 3.4 environment, 5.9-5.10
Elements, 3.3-3.5, 4.3-4.5 flow, of 3.7-3.8
activating, 5.3 sending, 3.7-3.8
and Containment Hierarchy, 4.3-4.5 sending data with, 5.9
components, 4.3, 4.5 targeting, 3.12
configuring, 3.4 types, of 5.9-5.10
external media, 4.3 Messaging, 2.3, 3.6-3.7, 5.3-5.10
graphic, 3.4, 4.3 and objects, 2.3-2.6
layer order of, 4.5-4.6 and the containment hierarchy, 3.10-3.12
sound, 4.3 as conversation, 3.6
text, 4.3 basics, 3.6-3.7
Encapsulation, 2.5 benefits, of 3.7-3.8

Environment messages, 5.9-5.10 defined, 2.3-2.4, 3.6-3.8
scripting model, 3.6

Messengers, 5.3

Extending the mTropolis environment, 2.6
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using to build logic, 5.3
mFactory Object Model (MOM), 2.6
Modifiers, 3.3, 3.5, 4.6-4.8

activating, 5.3

configuring, 3.5
Modifier palette, 1.4
Motion Started message, 5.10
Mouse Down message, 5.9
mPacks, 9.3-9.12
mPuzzle Tutorial, 7.3-7.39
mTropolis

authoring, 3.3

basics, 3.3

interface, 1.3-1.7

project, 10.3-10.6

structure, 3.8-3.12

Object manipulation, 1.3-1.4
Object-oriented design, 2.3-2.6
Objects
capabilities of, 2.3
components, 2.5
defined, 2.3-2.6
elements, 3.3, 3.4
encapsulation, 2.5
inheritance, 2.5
manipulating, 1.3-1.4
media, 3.3, 3.4
modifiers, 3.3-3.4, 3.5-3.6
overview, 3.3
properties, of 2.3
publishing, 2.5
versus procedures, 2.4

Palettes, 1.4

Parents, 3.9

Play command, 5.9, 5.10
Procedural model, 2.4
Programming visual, 3.3

Index

Projects
components, 4.3
defined, 1.3
Properties, 2.3
Prototyping, 3.8
Puzzle tutorial, 7.3-7.39

Real-world systems, 3.6
Relative message targeting, 5.6
Reusability, 2.5

Run-time mode, 3.4

Scene components, 4.4-4.5
Scene Ended message, 5.10
Section component, 4.4
Shared scene components, 4.4
Siblings, 3.9

Slideshow, 6.16

Software objects, 2.3-2.4, 3.3
Sound elements, 4.3
Stand-alone title, 3.3

Stop command, 5.10
Structure in mTropolis, 3.8-3.12
Structure view, 1.5

Subsection components, 4.4
Switchable behaviors, 4.7, 5.8

Targets of messages, 3.12
Text elements, 4.3
Timer Messenger, 5.4
Title stand-alone, 3.3
Tool palettes, 1.4
Tutorial
In-Depth, 7.3-7.39
mPacks, 9.3-9.11
Network, 8.3-8.51
QuickStart, 6.3-6.17
Types of messages, 5.9-5.10
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Variables, 3.5

Vector motion, 3.5
Views, 1.5

Visual programming, 3.3

What pop-up menu, 5.4-5.5

When pop-up menu, 5.4, 5.5

Where pop-up menu, 5.4, 5.5-5.6
With pop-up menu, 5.4

Wizard Authoring Example, 11.3-11.8
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